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About the Release Notes
The Release Notes are a comprehensive user guide for the latest release of Salesforce. Unlike a traditional release notes document
that includes only a simple list of enhancements, the Salesforce Release Notes give you everything you need to get up and
running with the new features and enhancements in the latest release.

What's Included in the Release Notes
For every new major enhancement, the Release Notes provide:

• A brief, high-level description of the functionality
• Implementation tips to help you get started with setup and administration
• Best practice tips to help you maximize the benefit of the functionality
• Complete end-to-end instructions on how to set up and use the functionality

Beyond the major new features, the Additional Enhancements sections include a list and brief description of every other
enhancement or functional change included in the latest release—everything from email enhancements, to new report types,
to security and packaging enhancements.

Let the Release Notes be your guide to success with the latest release from salesforce.com!

Your Feedback Matters
We know how important the Release Notes, online help, and documentation are to your company's success with Salesforce.
To continually improve the content we deliver to you, we want to know what works and what doesn't. Let us know!

• Feedback forms—Every HTML documentation page, both in the online help and in our developer guides at Developer
Force, includes a feedback form for you to submit your suggestions, corrections, and feedback about the documentation.
Let us know what you think!

• IdeaExchange—We're listening to your ideas too. Spring '12 includes some of your top ideas. Visit IdeaExchange for a
complete list of ideas coming in Spring '12.

Want to be notified whenever we publish new documentation or make significant updates to existing documentation? Follow
us on Twitter: @salesforcedocs.
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Release Notes Changes
You asked for it, we listened. In Spring ’12, we’re introducing the Release Notes Change Log. No more wondering what’s
changed with each new iteration of the release notes. No more sifting through the sand to find the gold nuggets. It’s all right
here, with the newest updates at the top.

DescriptionWhat’s NewDate

Updated information about joined reports, cross filters, and data
bucketing to clarify that they are included automatically in

Joined Reports—Generally Available,
Cross Filters—Generally Available,

February 1, 2012

Enterprise and Unlimited editions, and to provide information
about their release schedules.

and Data Bucketing—Generally
Available

Added an entry announcing that Streaming API is now generally
available.

Streaming API—Generally AvailableJanuary 31, 2012

Added entry announcing that Salesforce Mobile for Android Phones
is now generally available.

Salesforce Mobile for Android
Phones—Generally Available

January 31, 2012

Added an entry describing a change in the required permissions
for flow administrators to run flows.

Flow Administrator Permission
Change

January 27, 2012

Added a description on how to enable the IsPrmSuperUser field.New and Changed ObjectsJanuary 26, 2012

Added a sentence to clarify that posts with file attachments can’t
be shared.

Re-Posting Chatter Updates on page
21

January 26, 2012

Added Help and Training Enhancements section.Help and Training EnhancementsJanuary 24, 2012

Added that the mobile dashboards app for iPad will be available
within 24 hours after the Spring ‘12 release. The entry is in the

Mobile Dashboards App for the iPad
Widely Available

January 20, 2012

Mobile and Analytics tables in the Summary of Spring ‘12 Features
and Impact on Salesforce Users. Also moved the checkmark in the
Mobile and Analytics tables for visibility.

Added entry to the Visualforce section about JavaScript Remoting
response compression.

Visualforce JavaScript Remoting
Response Compression

January 20, 2012

Added entry announcing that Chatter 2.0 for iPad is available in
the App Store.

Chatter for iPad v2.0 Generally
Available

January 20, 2012

Added a description of new feature, which enables an Apex script
to be run automatically on package installation.

Running a Post-Installation Apex
Script—Pilot

January 20, 2012

Added the editions that support the mobile dashboards app for the
iPad under Additional Analytics Enhancements. Also included

Mobile Dashboards App for the iPad
Widely Available

January 19, 2012

entries for the app in the Mobile and Analytics tables in the
Summary of Spring ‘12 Features and Impact on Salesforce Users.

Updated the User object entry to include the IsPrmSuperUser
field that enables you to turn on super user access for a partner user.

New and Changed ObjectsJanuary 19, 2012
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DescriptionWhat’s NewDate

Added information about the new page Navigation Name
property in Siteforce, which lets you include spaces and special
characters in the names of menu items.

New Navigation Name PropertyJanuary 16, 2012

Added entry to the Visual Workflow Enhancements section
announcing that Visual Workflow is going to be enabled for all
Enterprise and Unlimited Editions.

Visual Workflow To Be Enabled for
All Enterprise and Unlimited
Editions

January 12. 2012

Because Live Agent requires separate feature licenses, the table at
the beginning of the Service Enhancements section of the Summary

Clarification of setup requirements
for Live Agent

January 11, 2012

of Spring ‘12 Features and Impact on Salesforce Users table now
indicates that administrators need to contact salesforce.com to
enable this feature.

Chatter Messenger will now be available by the end of February.Chatter EnhancementsJanuary 10, 2012

ValidationStatus added to the list of available
fieldsKnowledgeArticleVersion API object.

New and Changed ObjectsJanuary 9, 2012

Changed title from “Unlimited Invitations for Customer Groups”
to “Free Licenses for Customer Groups.” Changed dates of free
license availability.

Free Licenses for Customer GroupsJanuary 5, 2012

New feature to track updates and changes to the release notes.Release Notes Change LogJanuary 4, 2012
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Summary of Spring '12 Features and Impact on Salesforce
Users

Spring '12 has features that immediately impact all users after the release. You might want to communicate these changes to
your users beforehand so they are prepared. Other features require direct action by an administrator before users can benefit
from the new functionality.

The following table summarizes the Spring '12 features and their impact on users. Review the feature details for the applicable
Salesforce Editions.

Chatter Enhancements

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Chatter Messenger (available by the end
of February)

Chatter Bookmarks

Re-Posting Chatter Updates

Attach Files in Comments

Change File Sharing Settings

2 GB File Upload Size Limit

Improved File List Views

See Other Files That People Also
Viewed (available within 24 hours after
the Spring ’12 release)

Smart Search

Videos in Search Results

File Recommendations

Improved People Recommendations on
Profiles

Chatter Quick Start

More Relevant Recommendations
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Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Chatter for Android Tablets Generally
Available

Chatter REST API Enhancements

Customer Invitations Enabled (available
within 24 hours after the Spring ’12
release)

Free Licenses for Customer Groups

Likes on Comments Counted in Likes
Received Number

Chatter Influence on Profiles

Improved Mentions

Delete Chatter Messages via the SOAP
API

Send Chatter Invitations to 200 Domains

Chatter Invitations Link Now Available
on the Chatter Settings Page

Additional YouTube™ Video Support

Improved Chatter Email Settings Page

Control Chatter Email Settings Using
the API

Chatter Favorites

Newsfeed for Visualforce
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Sales Enhancements

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Configurable Forecast Date Range for
End Users

Updated Links in Forecasts

Creating Cases Directly from Microsoft®

Outlook®

Controlling Items You Don’t Want to
Sync

Better Control for Managing Email

Social Accounts and
Contacts—Generally Available

Change a Salesforce CRM Content
Document’s Managing Library Using
the ContentDocument API Object

Archive and Unarchive Salesforce CRM
Content Documents Using the
ContentDocument API Object

Apex Triggers Enabled on the
ContentDocument Object

New Email to Salesforce Features

Salesforce for Google AdWords Not
Available to New Organizations
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Service Enhancements

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Chatter Answers

Case Feed (available within 24 hours
after the Spring ’12 release)

Live Agent

Console Push Notifications

Sharing Service Cloud Console Links

Custom–Branded Console

Visualforce Console Components

New Methods for the Service Cloud
Console Integration Toolkit

Custom API Fields for Answers
(Questions and Replies)

Custom Lookup Fields for Replies

New Field and New Requirement on
Email-to-Case Auto-Response Rule
Entries Page

Validation Status Field

Article Versioning (available within 24
hours after the Spring ’12 release)

Agent-Authored Knowledge

English-Only Spell Correction for
Knowledge Search (Beta)

Improved Navigation

Knowledge Actions (Pilot)

Article HTML Editor

Self-Service Portal Not Available to New
Organizations
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Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Creating Cases Directly from Microsoft®

Outlook®

Analytics Enhancements

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Joined Reports—Generally Available

(Available on February 7 in preview
sandbox and on February 12 in
production and sandbox. See Joined
Reports Release Schedule.)

Cross Filters—Generally Available

(Available on February 7 in preview
sandbox and on February 12 in
production and sandbox. See Cross
Filters Release Schedule.)

Data Bucketing—Generally Available

(Available on February 7 in preview
sandbox and on February 12 in
production and sandbox. See Data
Bucketing Release Schedule.)

Mobile Dashboards App for the iPad
Widely Available (available within 24
hours after the Spring ’12 release)

Dashboard Enhancements

All Items Search in the Reports Tab

Custom View in the Reports Tab

Deleting Report Filters with Filter Logic
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Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Increased Report Filter Limits

Drag-and-Drop Report Filters

Mobile Enhancements

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Chatter for Android Tablets Generally
Available

Salesforce Mobile SDK

Mobile Dashboards App for the iPad
Widely Available (available within 24
hours after the Spring ’12 release)

Chatter for iPad v2.0 Generally Available

Salesforce Mobile for Android
Phones—Generally Available

Data.com Enhancements

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Data.com Corporate
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Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Purchase Data.com Licenses and record
additions from the Licenses & Limits
page

Additional Account Fields Now Enabled
for Data.com Data

Associate or create an account when you
add Data.com contacts from the
Data.com tab

Get company overview information and
additional data on the enhanced account
card

Additional prospecting enhancements

Data.com Clean—Beta

Force.com Enhancements

Visual Workflow

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Visual Workflow To Be Enabled for All
Enterprise and Unlimited Editions
(available within 24 hours after the
Spring ’12 release)*

Cloud Flow Designer—Generally
Available

Flows in the Metadata API

Flow Version Limit Increased

Flow Administrator Permission Change

Record Delete Element
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Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Decision Element No Longer Boolean

Flows in Change Sets and Packages

Choices as Flow Resources

Label Fields Now Rich Text

Global Constants

* Administrators can create flows within 24 hours after the Spring ’12 release; however it may take until February 20th before
users are able to run the newly-created flows.

Workflow and Approvals

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Field Updates for Encrypted Custom
Fields

Workflow Field Updates Can Retrigger
Workflow Rules

Cross-Object Workflow

Global Search

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Smart Search

Improved Search Results Relevancy
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Visualforce

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Visualforce Components for Chatter
Answers

Visualforce Components for Live Agent

Visualforce Component for Chatter

Visualforce Component for Social
Accounts and Contacts

Dynamic Visualforce Components

Dynamic References to Global Variables

Single View State

PDF Optimizations and Limits

Referential Integrity Validation
Improvements

Visualforce JavaScript Remoting
Response Compression

Other Optimizations

Platform Development Tools—Developer Console

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Raw Debug Log Viewer

Visualforce Pages and Components

Visualforce Syntax Highlighting and
Auto-Complete

Packages Support

Heap Search

General Development Improvements
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General Enhancements

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Force.com System Overview

Configuring Force.com System Overview
Messages

Tab Bar Organizer

App Quick Start Enhancements

Custom Tab Detail

Force.com Quick Access Menu
Enhancements

ISVforce Enhancements

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Enhanced Trialforce
Branding—Generally Available

Subscriber Support Console—Generally
Available

Package Installation Improvements

Modifying Custom Fields in Packages

New Apex Methods and Class for
Package Versions

Running a Post-Installation Apex
Script—Pilot
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Siteforce Enhancements

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Repeaters and Repeater
Elements—Generally Available

Data Tables

Data Functions

Repeater and Data Table Pagination
(Pilot)

Web-to-Object Forms

Data Access Permissions

Selective Publishing

Folder Manager

URL Redirects

Custom HTML Attributes

HTML5

Import, Export, and Duplicate Sites

Reorganized Overview Tab

New Navigation Name Property

Database.com Enhancements

Contact salesforce.com
to enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators.
No setup
required.

Automatically
visible to all

users. No setup
required.

Feature

Schema Builder Enhancements—Beta

Sandbox Retention Policy
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Security Enhancements

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Single Sign-On Changes

Increased Maximum Timeout Value

New Password Complexity Option

Requiring a Secure Connection
(HTTPS) Is Permanent

Increased Service Provider Selection
Availability

Encrypted Fields Available in Full-Copy
Sandbox

Social Sign-On (available within 24
hours after the Spring ’12 release)

Network Access Column Changes

Sharing Enhancements

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Criteria-Based Sharing Rules Enabled
for Leads and Campaigns

Name Fields for Groups, Queues, Roles,
and Territories

Name Fields for Sharing Rules

Partner Super User Access

Sharing Rule Components for Change
Sets
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Apex Code Enhancements

Contactsalesforce.com
to enable this

feature.

Not automatically
visible. Feature is
available requires

some setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Apex REST API

Higher Limit for Concurrently
Scheduled Apex Classes

Apex Triggers Enabled on the
ContentDocument Object

Isolation of Test Data in Unit Tests

New IsTest(SeeAllData=true)
Annotation

Running Tests on Package Installation

New Package Version Methods and
Class

New isPermissionable Method for the
Describe Field Result

Single Sign-On when Using
Authentication Providers

API Enhancements

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

API Enhancements

Paging Using the OFFSET Clause
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Chatter Messenger — Pilot
Allow people in your organization to chat securely with people they follow in Chatter without using external chat clients.

Note:  Chat is currently available through a pilot program. For information about enabling chat for your organization,
contact salesforce.com.

Enabling and Disabling Chat
Chat may be enabled for organizations with Chatter enabled, including those with Chatter Plus and Chatter Free licenses. If
chat is enabled for your organization, administrators with the “Customize Application” permission can enable and disable chat
by following these steps.

1. Click Your Name > Setup > Customize > Chatter > Chat Settings.
2. Click Edit.
3. Under Chat Settings, select Enable Chat. Deselect to disable chat.
4. Click Save.

Enabling and Disabling Chat for Visualforce Pages
Add a chat widget to your custom Visualforce pages. If Chat is enabled for your organization, administrators with the “Customize
Application” permission can enable Chat for Visualforce pages by following these steps.

1. Click Your Name > Setup > Customize > Chatter > Chat Settings.
2. Click Edit.
3. Under Visualforce Settings, select Allow. Deselect to disable chat for custom Visualforce pages.
4. Click Save.

To prevent the chat widget from displaying on a specific Visualforce page, do any of the following:

• Turn off the Salesforce tab header on your page by setting <apex:page showHeader=”false”>.
• Set the page contentType to something other than text/html, for example, <apex:page

contentType="text/plain">.

Chatter Bookmarks
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

 You asked for it! Spring '12 addresses this idea on IdeaExchange.

CHATTER
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Starting in Spring ‘12, you can save posts by bookmarking individual posts in your Chatter feed. Click Bookmarks on the
left sidebar to see your saved posts in your Chatter feed. When someone comments on a post you bookmarked, you receive
an email notification. Email notifications for bookmarks are enabled by default. To change your email notifications, click Your
Name > Setup > My Chatter Settings > Chatter Email Settings.

Bookmarks are private and other users can’t see which posts you bookmark. When you are no longer interested in a post you

saved, you can remove the bookmark. The post no longer appears in your saved posts when you click Bookmarks.

Bookmarking a Chatter Post
1. Hover over the post you want to bookmark in your Chatter feed.

2. Click  at the top right corner of the post.

The icon changes ( ) to indicate that you successfully marked the post.

After you bookmark one or more posts, click Bookmarks on the Chatter sidebar to see all of your saved posts in your
Chatter feed.

Removing a Bookmark

1. Click Bookmarks on the sidebar to see your saved posts in your Chatter feed.
2. Find the saved post in your Chatter feed.

3. Click  at the top right corner of the post to remove the bookmark.

The icon changes ( ) to indicate that you successfully removed the post from your bookmarks.

Re-Posting Chatter Updates
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

 You asked for it! Spring '12 addresses this idea on IdeaExchange.

Starting in Spring ‘12, you can share public Chatter posts that contain text or a link to your profile or to a group directly from
the Chatter feed.

To share a post, click Share in the footer of the post and select one of the options from the drop-down list:

• To my profile to share the post on your profile.

• With a group to share the post with a group.

• Link to post to include the link to the post in an email or instant message.

When you share a post, keep in mind:

• You can share a post to your own profile, but not to another person’s profile.

• Only the original post is shared. Comments and likes on the original post are not shared.
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• You can comment on the shared post, but you can’t edit a shared post.

• You can’t share a post that has a file attached. You can share the file itself by using the Share File option.

• You can’t share feed tracked items and custom feed items, such as approvals, dashboard snapshots, or case interactions.

• You can only share posts with a group you’re a member of.

• You can’t share a post from a private group.

• You can share a post in a group that allows customers. However, a customer can’t share posts because customers are only
allowed in private groups.

• Only Chatter users inside your company can see a post that you shared using a link in an email or instant message.

When someone shares your post, you receive an email notification. To change your email notifications, click Your Name >
Setup > My Chatter Settings > Chatter Email Settings.

Chatter Files Enhancements
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Attach Files in Comments

 You asked for it! Spring '12 addresses this idea on IdeaExchange.

Starting with Spring ‘12, you can attach a file to a comment in Chatter. Now more than ever, it’s easy to keep collaboration
going by attaching files to specific Chatter comments. Click in the text box on a comment and optionally add a comment,
then click Attach File and choose a file from Salesforce or your computer. Click Comment to post your file and comment if
you added one.

Two new fields have been added to the FeedComment object so you can attach files to comments via the API:

• CommentType is the type of comment. File attachments are of type ContentComment.
• RelatedRecordId is the ID of the ContentVersion object associated with a ContentComment.

Note: Prior to API version 24.0, a text entry was required on a comment. As of version 24.0, a text entry is optional
if the CommentType is ContentComment—an uploaded file on a comment. If you have any Apex triggers associated
with the FeedComment object, keep in mind that this change may affect the behavior of existing triggers.

Change File Sharing Settings
File owners and collaborators can now control how a file is shared with their company by choosing one of these file permissions
on the Sharing Settings dialog box, next to Any Chatter user in your company:

• No Access—No one in your company can find or view the file unless it’s specifically shared with them or a private group
they’re a member of.

• Viewer—Anyone in your company can view, download, and share the file.
• Collaborator—Anyone in your company can view, download, share, change permission, edit the file, and upload new

versions.

A file is automatically shared with your company by posting it to a feed on the Home page, Chatter page, a profile, a record,
or a public group. All Chatter users in your company are given viewer permission by default.
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2 GB File Upload Size Limit
We’ve raised the size limit for uploading Chatter files from 100 MB to 2 GB in Salesforce CRM organizations with Chatter
enabled. All file types are supported, including everything from Microsoft® PowerPoint presentations and Excel spreadsheets,
to Adobe® PDFs, image files, audio files, and video files. Attach a file to a Chatter feed or upload a file from any of these
locations:

• On the Files page, the Files Shared with list on a group, or the Files Owned by list on a profile—Click Upload a file.
• On the Home page—Click Create New > File.
• On the Files Shared with list on a group—Click Upload a file.
• On the Files Owned by list on a profile—Click Upload a file.

Improved File List Views
Spring ‘12 includes the following file list view improvements:

• File Search Results

◊ Now offer file actions in list views. The file actions drop-down list in the Actions column lets you perform actions like
download and share, for example, depending on your permissions.

◊ Moved the ability to follow or stop following a file from the Following column to the Actions column.
◊ No longer have the Type column. File type is indicated visually by the icon next to the file name in the Name column

and by hovering over the icon.

• Select from Salesforce

◊ No longer have the Type column. File type is indicated visually by the icon next to the file name in the Name column
and by hovering over the icon.

See Other Files That People Also Viewed
Spring ‘12 makes it easier to discover interesting files. The file detail page now includes a People Also Viewed list of files that
viewers of this file also viewed. If no other files have been viewed by the same people, the People Also Viewed section doesn't
appear on the file detail page.

Chatter Search Enhancements
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Smart Search
With Spring ‘12, global search keeps track of which objects you use and how often you use them, and arranges the search
results accordingly. Search results for the objects you use most frequently appear at the top of the list. You can also pin important
objects to the top of your search results. For more information, see Global Search Enhancements.

Videos in Search Results
With Spring ‘12, YouTube™ videos posted in Chatter feeds are included in search results. After searching for the title of a
YouTube™ video, click Search Chatter Updates to see matches in your Chatter Updates search results.
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Chatter Recommendations Enhancements
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

File Recommendations
Chatter recommends files that you might want to follow based on the popularity of the file, determined by the number of
people who have viewed or downloaded the file. To see an expanded list of your recommendations, click More in the
Recommendations section. If no recommendations appear, then you already viewed all the recommended files.

Improved People Recommendations on Profiles
Chatter recommends people in your organization that you might want to follow based on similar interests. With Spring ‘12,
you can see a new type of recommendation immediately after following someone on a profile page. This recommendation
appears if many people who follow that person also follow someone else. For example, if you follow Madison Rigsby on her
profile page, you immediately get a recommendation for Suzanne Powell if many people who follow Madison also follow
Suzanne.

Chatter Quick Start
Recommendations on the Chatter page now include a mix of people, group, file, and record recommendations with no section
dividers. Click More to display the Recommendations page where you can use the side filters to narrow your recommendations
to people, files, records, or groups.

With Spring ‘12, we’ve restyled the What To Do Next section that appears above your recommendations. This section is now
included with the recommendations and shows one recommended action at a time. You can complete or skip a recommended
action to see the next one. If you skip a recommended action, you don’t see that recommendation again. If you previously
dismissed the What To Do Next section, you don’t see the updated user interface.

More Relevant Recommendations
With spring ‘12, Chatter provides more relevant recommendations based on some of your user information, such as how long
you’ve been using Chatter and how frequently you post and comment in Chatter. For example, if you’re new to Chatter, we
prioritize recommendations for popular groups and people to help you get started. If you’ve been using Chatter for a while,
we prioritize recommendations for files, records, and new groups to enhance your Chatter experience.
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Chatter for Android Tablets Generally Available
Available in: All Editions except Database.com

Now you can collaborate in Chatter from your Android tablet! Chatter for Android Tablets keeps you connected to the people
and records that matter most, whether you’re in the office or on the road. Use it to:

• View updates about the people, groups, and records you follow

• Create posts (with photos) and add comments

• View documents and links shared by others

• Find and follow people in your organization

• Find and join groups in your organization

• View coworkers' profiles, and email, call, or text them directly

For more information, see Chatter for Android Tablets Generally Available.

Chatter REST API Enhancements
Available in: All editions except Personal Edition

Spring ‘12 (Chatter API version 24.0) improvements:

• Pilot Resources and Response Bodies

• New and Changed Resources

• New and Changed Response Bodies

• New and Changed Request Bodies

Attention:  Resources, parameters, and response bodies change from release to release. We strongly recommend that
you test your application in a test environment before deploying it to production.

Pilot Resources and Response Bodies
Note:  All Files resources are currently available through a pilot program. For information about enabling Chatter
API Files for your organization, contact salesforce.com.

• The Files resource is new and provides information about specific files.
• The Groups resource now contains a Files resource that returns information about files posted to the group.
• The Users resource now contains the following new resources for files:

◊ files—Returns information about files that a user has posted.
◊ files/filter/groups—Returns information about files posted to groups that the logged-in user is a member of.
◊ files/filter/sharedwithme—Returns information about files that have been shared with the logged-in user.

• File, File Details, and File Page are all new resources that return information about files.
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• File Shares Page, Library, and Shares are all new resources that return information about file shares.

New and Changed Resources
• Bookmarks is a new resource that provides information about the logged-in user’s bookmarks saved in Chatter.
• Chatter Influence is a new feature that provides information about a user’s influence rank, relative to other users in the

organization. The Influence resource is new and provides access to the percentile thresholds used to categorize the
organization’s users by influence.

• Chatter is a new resource that returns URLs to the resources available for this organization, such as Feeds, Groups and
Users.

•

 You asked for it! This enhancement is from an idea on the IdeaExchange.
The Comments resource now returns information about the likes for a specific comment. It also can be used to add a like
to a comment.

• The Company Feed resource no longer requires the “View All Data” permission.
•

 You asked for it! This enhancement is from an idea on the IdeaExchange.
Favorites is a new resource that provides information about the logged-in user’s favorites saved in Chatter.

• The POST request parameters for Feed Item Comments have been updated to enable posting files on comments. The
new request parameters are:

◊ contentDocumentId

◊ desc

◊ feedItemFileUpload

◊ title

• Organization is a new resource that provides information about the logged-in user’s permissions in the organization.

Note:  This resource is under the base URL of /services/data/v24.0/connect, not
/services/data/v24.0/chatter.

• The Users resource now returns a mixture of all your user, group, file, and record recommendations. It can also be used to
return and delete specific recommendations.

• The Users resource now supports the q query parameter for the following resources:

◊ conversations—Searches across all private conversations.
◊ conversations/conversationId—Searches within a specific private conversation.
◊ messages—Searches across all messages in private conversations.

• The number of items you can specify for the pageSize request parameter has increased for the following resources:

◊ Number of groups (/chatter/groups/): from 100 to 250
◊ Number of group members (/chatter/groups/groupId/members): from 100 to 1000
◊ Number of groups the logged-in user is a member of (/chatter/users/me/groups): from 100 to 250
◊ Number of followers has increased from 100 to 1000 for the following resources:

- /chatter/records/recordId/followers

- /chatter/users/me/followers

- /chatter/users/me/following
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• Request parameters for all resources that can be used to POST feed items have changed as follows:

◊ originalFeedItemId is a new request parameter for sharing (re-posting) feed items.

Note:  The originalFeedItemId parameter takes precedence over all other parameters. For example, if you
share a post and also try to upload a file, the generated feed item only contains the shared post. You must either
share a post or upload a file, not both in the same feed item.

◊ title is a new request parameter for adding the title to a file being uploaded.
◊ fileName should no longer be used as of version 24.0. Use title instead. If a value is specified for both title and

fileName, the value for title is used.

New and Changed Response Bodies
• The Chatter Activity response body now includes the total number of likes on both posts and comments received by the

user, not just likes on posts. Any likes on comments received before Chatter API version 24.0 aren’t included in the response
body parameter likeReceivedCount.

• Chatter Directory is a new resource that returns URLs to the general resources for this organization, such as Groups,
Feeds, and Users.

• The Comments response body now includes the following:

◊ attachment—information about an attachment supplied with a comment, may be null
◊ type—information about the type of comment

• Explanation Details is a new response body that contains detailed information about a user’s recommendation explanation.
• Explanation Summary response body now includes the following:

◊ detailsUrl—URL for Explanation Details or null
◊ type—type of recommendation explanation, such as followingSameUsers

• Favorites Page and Favorite are new response bodies that contain information about a user’s favorites.
• The Feeds Directory resource now includes a link to the collection of favorites saved by the logged-in user.
• The Feed Item response body now includes the following:

◊ isBookmarkedByCurrentUser—specifies whether the current user has bookmarked this feed item
◊ originalFeedItemId—if this feed item is a shared feed item, specifies a Reference response body that contains information

about the original feed item
◊ originalFeedItemActor—if this feed item is a shared feed item, specifies more information about the original feed item

The Feed Item attachment field has the following changes:

◊ If an attachment is part of a feed item, the value returned is a ContentPost
◊ If an attachment is part of a comment, the value returned is a ContentComment
◊ The new value CaseCommentPost returns the response body Feed Item Attachment: Case Comment, which is new

and contains information about a case comment
◊ The new values DashboardComponentSnapshot and DashboardAlert return the response body Feed Item

Attachment: Dashboard, which is new and contains information about a dashboard

• The Group response body now includes the following:

◊ fileCount—number of files posted to this group
◊ lastFeedDatePosted—date of the most recent post
◊ owner—information about the owner of the group
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• Influence Thresholds is a new response body that contains information about the percentile thresholds used to define users’
influence within the organization.

• Organization is a new response body that contains information about the user’s timeout limits, the organization ID, as
well as two new lower-level response bodies:

◊ features—information about the features available in the organization
◊ userSettings—information about the organization permissions for the user

• The Photo response body now contains a photoVersionId that can be used to compare versions of a photo.
• The Recommendations response body is changed:

◊ object now includes files
◊ type is no longer included

• Unauthenticated User is a new response body that contains information about a user who is not a Salesforce user.
• The User Detail response body now includes the username.
• The User Page response body now returns a collection of User Detail response bodies, instead of User Summary.
• The mySubscription field for all response bodies now returns the Id of the subscription, not the user.
• The following general updates to likes and subscriptions have been made:

◊ myLike on the Like Page response body is no longer available as of version 24.0.
◊ The Comment response body now includes myLike, which returns a reference to the like or null
◊ On the Feed Item response body, the currentUserLike field is no longer available as of version 24.0. Use the new

myLike field instead.
◊ mySubscription on the Followers Page response body is no longer available as of version 24.0.
◊ The Record Summary response body now includes mySubscription

New and Changed Request Bodies
• Attachment File: New File Upload now includes the field title to hold the title of the file
• Comment now includes the field attachment to hold attachments for comments
• Feed Item now includes the following:

◊ isBookmarked

◊ originalFeedItem

• The following new request bodies have been added:

◊ Feed Favorite Input
◊ File Input
◊ User Message Recipient Input
◊ User Message Recipient List Input
◊ User Stream (Conversation) Input
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Additional Chatter Enhancements
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Customer Invitations Enabled
Starting in Spring ‘12, customer invitations are enabled for organizations that haven’t opted out and haven’t enabled them.
Customer invitations allow users who manage or own private Chatter groups that allow customers to invite customers to those
groups. Customers are users outside of your company's email domains. They have very limited Chatter access and can only
see groups they're invited to and interact with members of those groups.

To disable customer invitations:

1. Click Your Name > Setup > Customize > Chatter > Settings.
2. Click Edit.
3. Deselect Allow Customer Invitations.

Note:  Turning off customer invitations won't delete existing customers or groups that allow customers. Additionally,
administrators can still create customer users in Name > Setup > Manage Users > Users.

4. Click Save.

Free Licenses for Customer Groups
From now until September 17, 2012, you can use as many Chatter External licenses for Chatter customer groups as you need,
for free. After September 17, 2012, the number of free Chatter External licenses will be limited, but you keep the free licenses
that you have used.

Likes on Comments Counted in Likes Received Number
Starting with Spring ‘12, likes on comments count toward the likes received number in a person’s Chatter activity statistics.
Any likes on comments received before Spring ‘12 aren’t included.

Chatter Influence on Profiles
Spring ‘12 introduces Chatter influence, a quick way to see who’s driving collaboration with their contributions in Chatter.
Together with the existing Chatter activity statistics—which show how many posts and comments someone’s made, and how
many comments and likes they’ve received—Chatter influence shows what these numbers mean for a person’s overall influence.
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Go to people’s profiles or person hovers to see the Chatter influence indicator. Top Influencers are leading collaboration efforts
by regularly sharing essential content, Active Influencers are encouraging others to get involved and share knowledge, and

Observers are quiet participants or just getting started in Chatter. When viewing someone’s profile, hover over  under the
profile photo for details about how that person is uniquely influential.

Note:  If your organization has Chatter Free users, they don’t see influence information on their own profiles or anyone
else’s.

Chatter influence data is available through the Chatter REST API. See New and Changed Resources on page 26.

Improved Mentions

 You asked for it! Spring '12 addresses this idea on IdeaExchange.

With Spring ‘12, you can select from one single list of matches when you mention someone in a post or comment. Just type
@ followed by the first few letters of the person’s name. The list now includes all matches, people you follow and people you
don’t follow, with the best matches at the top of the list.
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Delete Chatter Messages via the SOAP API

Available in: Enterprise, Unlimited, and Developer Editions for users with a Salesforce license, and Database.com Edition
for users with a Database.com Admin license

User Permissions Needed

“Manage Users”To control other administrators' access to Chatter messages:

“Manage Chatter Messages”

AND

“API Enabled”

To view and delete Chatter messages via the SOAP API:

Administrators with the “Manage Chatter Messages” permission can now delete any user’s Chatter messages via the SOAP
API; for example, for compliance purposes. The ChatterMessage object now supports the delete() call.

When deleting Chatter messages, consider these guidelines:

• Messages are hard deleted. They aren’t sent to the Recycle Bin.
• Deleted messages aren’t included in message search results.
• If all messages in a conversation are deleted, the conversation isn’t shown in My Messages and can’t be retrieved via the

Chatter REST API.
• If replies via email are enabled, when a user replies to a deleted message, Chatter returns an error notification and doesn’t

process the reply message.

Send Chatter Invitations to 200 Domains

 You asked for it! Spring '12 addresses this idea on IdeaExchange.

You can now add up to 200 email domains to define who can join Chatter for your organization. Once you add an email
domain to the list, users in your company can send invitations to people with email addresses in that domain.

To add domains:

1. Click Your Name > Setup > Customize > Chatter > Settings.
2. Click Edit.
3. Ensure that Allow Coworker Invitations is selected.
4. Enter the email domains. If all rows are full, click Add More below the list of domains.
5. Click Save.

Chatter Invitations Link Now Available on the Chatter Settings Page
The Chatter settings page now contains a link that allows you to send Chatter invitations from your own email account.

1. Click Your Name > Setup > Customize > Chatter > Settings.
2. Click Send invitations from your email account.
3. If you have a default email client set, an email containing an invitation link opens in your mail program. Otherwise, you

see an invitation link that you can copy and paste into an email.

You can also still send invitations from the Chatter home page, People page, or from within a group.

31

Chatter Additional Chatter Enhancements

http://success.salesforce.com/ideaView?c=09a30000000D9xt&id=08730000000Xw0jAAC


Additional YouTube™ Video Support
Starting in Spring ‘12, you can add your own video title when you post a video from the YouTube™ community. Click Link,
enter the YouTube™ video URL and a title for the video, and click Share. The video player displays a thumbnail preview and
the video title in the Chatter feed update. If you don’t enter a title, the video player uses the title provided by the YouTube™

community.

Improved Chatter Email Settings Page
For Spring ‘12, we improved the layout of the Chatter Email Settings page. Your email options are now grouped by feature
to make them easier to find and to help you select the email settings you want. To access your email options, click Your Name
> Setup > My Chatter Settings > Chatter Email Settings.

Control Chatter Email Settings Using the API

Available in: Enterprise, Unlimited, and Developer editions

User Permissions Needed

“API Enabled”To use the API:

Spring ‘12 makes it easier to change users’ Chatter email settings. Using the Web Services API, you can now control whether
users receive email notifications when someone mentions them, follows them, likes their post or comment, and so on. See the
new settings available on the User object in Changed Objects on page 171.

Chatter Favorites
Starting in Spring ‘12, you can add a list view as a Chatter favorite to monitor key business processes directly from your Chatter
tab.

To add a list view as a Chatter favorite:

1. Open an existing list view or create a list view for a set of records, like for example accounts, opportunities, or leads.

2. Click Chatter in the top-right corner to see the Chatter updates for the list items.
3. Click Add to Chatter Favorites in the right sidebar.

The favorite name on the Chatter tab is the same as the list view name.

Newsfeed for Visualforce
Starting in Spring ‘12, Salesforce provides the <chatter:newsfeed/> Visualforce component, which displays the feed
updates on the Chatter tab of the user viewing the Apex page that contains the embedded <chatter:newsfeed/> component.

The <chatter:newsfeed/> component offers different functionality than the <chatter:feed/> component. The
<chatter:feed/> component displays only the Chatter updates on a user’s profile page or a record’s detail page.
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Forecasts Enhancements and Updates
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Allow Forecasting”To use Forecasts:

Note:  This information only applies to the Forecasts product beginning with the Winter ’12 release and not
Customizable Forecasting or Forecasts (Classic).

Configurable Forecast Date Range for End Users
For Spring ’12, we made further enhancements to our latest forecasting product! You can now select your own date range
display for forecasts. The range you select is relative to the current month. For example, in January you might select January
as your beginning month and April as the ending month. In February, the date range displayed becomes February to May
and so forth. Your date range selection will remain until you choose another one. To change your forecast date range display:

1. Click the Forecasts tab.
2. Click Change, located next to the total number of months.
3. In Forecast Month Range, use the drop-down lists to select a beginning month and ending month.

4. Click Save.

Updated Links in Forecasts
We updated the View Forecast As link in Spring ’12. View a subordinate's forecast detail by hovering over the row and clicking
Details >>. Previously you clicked on View Forecasts >> to see this information. Additionally, the date range previously
contained month and year information. The date range now displays the number of months selected for the range.

SALES CLOUD

33



Salesforce for Outlook Enhancements
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

Spring ’12 and Salesforce for Outlook include a new feature for creating cases directly from Microsoft® Outlook® emails. In
addition, this release introduces helpful options for controlling items your users don’t want to sync, as well as improvements
for managing the email they add to Salesforce.

Creating Cases Directly from Microsoft® Outlook®

 You asked for it! This enhancement is from an idea on the IdeaExchange.

The Create Case feature in Salesforce for Outlook lets users create cases in Salesforce from emails in Microsoft® Outlook®.
As an administrator, you can create Email-to-Case destinations that appear in the drop-down list button Create Cases in
Outlook. For each destination, you choose the assignee, which can be either individual users or queues. You can add up to 10
destinations for each Outlook configuration. When users create cases, they can add up to 10 emails simultaneously for each
destination.

Before Salesforce for Outlook users can create cases from Outlook emails, you’ll need to perform the following procedures.

1. If you haven’t already enabled the On-Demand Service for Email-to-Case, complete the procedure “Enabling On-Demand
Email-to-Case” in the online help.

2. If you haven’t already defined Email-to-Case destinations (also known as email routing addresses), complete the procedure
“Defining and Verifying Email Routing Addresses” in the online help.

3. Enable Create Case in your configurations. The topic “Enabling Create Case” in the online help provides details for editing
configurations to include the drop-down list button Create Cases in Outlook.

Salesforce for Outlook assigns a category to the emails that Salesforce for Outlook users add as cases to Salesforce. This
category, Added to Salesforce as a case, makes it easy for users to search for emails they added as cases to Salesforce.

Controlling Items You Don’t Want to Sync

 You asked for it! This enhancement is from an idea on the IdeaExchange.

Your users now have more control over the items they don’t want to sync.

• In Salesforce for Outlook Settings, users can now choose whether to sync Microsoft Outlook contacts, events, and tasks
they mark as Private.

• In Microsoft Outlook, users can now indicate any items they don’t want to sync with Salesforce, regardless of whether
they mark them as Private, by assigning them to the new category Don’t Sync with Salesforce. For example, this can be
helpful when users want to prevent specific contacts, events, and tasks from syncing with Salesforce. For details on using
categories in Outlook, refer to your Outlook documentation.

Better Control for Managing Email
We’ve made a number of improvements to help your users better control the management of emails they add to Salesforce.

• For emails users add to Salesforce, Salesforce for Outlook now adds a row to My Unresolved Items for each unresolved
email address. While this may result in additional rows, your users now have the opportunity to assign emails to all of the
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contacts and leads in the email. In addition, My Unresolved Items now includes an Email Address column so that users
know which email addresses weren’t resolved.

• In My Email to Salesforce, users can now specify email domains they want to exclude from automatic association when
they use Salesforce for Outlook to add emails to Salesforce. For example, your users can exclude their own email domain
so that Salesforce for Outlook won’t associate emails to contacts with their email domain. This can be especially helpful
for organizations that create contacts for internal users, and don’t want emails associated with those users.

• Salesforce for Outlook now assigns a category to emails your users add to Salesforce. This new category, Added to Salesforce,
makes it easy to search for emails you added to Salesforce.

• Salesforce for Outlook now stores the original date of the email in the Due Date field of the email task. Previously, Salesforce
for Outlook stored the date when the email was added.

Social Accounts and Contacts—Generally Available

Business accounts available in: All Editions except Database.com

Person accounts available in: Enterprise, Unlimited, and Developer Editions

Contacts available in: All Editions except Database.com

Leads available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

Visualforce available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

 You asked for it! Spring '12 addresses this idea on IdeaExchange.

In Spring ‘12, an enhanced version of Social Contacts—now called Social Accounts and Contacts—is generally available.
With Social Accounts and Contacts, Salesforce users can see social information for accounts (both business and person
accounts), contacts, and leads directly in Salesforce. Easy access to this information provides your sales users with social sales
intelligence that they can use to better meet existing and potential customers’ needs.

The Social Accounts and Contacts feature includes these enhancements.

• Facebook® profiles are now available for accounts and leads, as well as contacts. Facebook gives you a more personal view
of your existing and potential customers and helps you find common interests. For contacts, leads, and person accounts,
you can see profiles, status updates, and the number of mutual friends you share. For business accounts, you can view your
customers’ corporate social media presence, including their company profile and wall posts.

• LinkedIn® profiles are now available for leads and person accounts, as well as contacts. LinkedIn is useful for staying up
to date on your existing and potential customers’ professional personas. You can see profile photos, current titles and
companies, and locations.

• Twitter™ profiles are now available for accounts and leads, as well as contacts. Twitter is a great way to see the public
personas of your existing and potential customers and to find out what’s on their minds. You can see bios, recent tweets,
and the people who are following and being followed by your accounts, contacts, and leads.

• Two new social networks are available.

◊ Klout™ is a third-party service that analyzes people's influence across social networks, including Twitter, Facebook,
and LinkedIn. Use Klout to see your accounts', contacts', and leads' influence on social media, who they influence, who
influences them, and the topics they talk about.

◊ YouTube™ helps you find and view videos related to your accounts, contacts, and leads.
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• A new Visualforce component—called Visualforce for Social Accounts and Contacts—is available, so you can easily add
the Social Accounts and Contacts viewer to your custom account, contact, and lead detail pages. You don’t need to use
this component for standard account, contact, or lead pages.

The viewer displays the record name, a profile picture for the account, contact, or lead, the social network icons that allow
users to sign in to their accounts from Salesforce, and the popup that displays social data directly in Salesforce See
social_profileViewer in the Visualforce Developer’s Guide for more information.

Important:  The Social Accounts and Contacts feature uses Facebook, Klout, LinkedIn, Twitter, and YouTube public
APIs to display social information in Salesforce. Because these social networks have the option of modifying or
terminating access to their APIs at any time, salesforce.com can’t guarantee the future availability of this feature or
any of its functionality, including access to the data that is currently provided or to any particular social network as a
whole.

Security and Privacy When Using Social Accounts and Contacts
Social Accounts and Contacts is secure and private. Here's an overview of its security and privacy features:

• Salesforce uses the trusted OAuth protocol when you sign in to your Facebook, LinkedIn, or Twitter accounts, so your
login credentials aren't exposed to Salesforce.

• Salesforce doesn't import or store social information. Each time you select a contact's social profile or YouTube video,
Salesforce retrieves the information directly from the corresponding social network and simply displays it. The information
that you see is read-only and can't be modified.

• You can't import or store social data in Salesforce records. This ensures that you always see current details when viewing
your accounts', contacts', and leads' social information.

• The details that are visible to you when you view a Facebook, LinkedIn, or Twitter profile are determined by the connection
that you have with the account, contact, or lead, as well as privacy settings. Typically you see the same information as you
would when viewing the profile while logged in directly to the social network. Some of your customers, however, may have
privacy settings that restrict the visibility of some or all of their profile details outside the network. In those cases, you see
very few, if any, profile details in Salesforce.

• Your view of a Facebook, LinkedIn, or Twitter profile is not shared with anyone else in your organization. Other Salesforce
users must sign in to their own social network accounts to use Social Accounts and Contacts and the profile details that
are visible depend on each user's connection level with the account, contact, or lead, as well as their privacy settings.

• None of your Facebook, LinkedIn, or Twitter profile information is stored in Salesforce, nor does Salesforce post anything
about you or your activities to your social network accounts.

• Accounts, contacts, and leads aren't notified when you view their social network profiles using the Social Accounts and
Contacts feature.

Enabling and Configuring Social Accounts and Contacts

User Permissions Needed

“Customize Application”To enable, configure, or disable Social Accounts and Contacts:

The Social Accounts and Contacts feature is enabled by default for organizations created after the Spring ‘12 release. For
existing organizations, the administrator must enable Social Accounts and Contacts..

Note:  Social Accounts and Contacts won’t be enabled if the Social Contacts feature in the Winter ‘12 release was
turned off. If your organization has been using Social Contacts since the Winter ‘12 release, you automatically get the
new support for accounts and leads, and the YouTube and Klout services are enabled by default.

To enable Social Accounts and Contacts for your organization:
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• Click Your Name > Setup > Customize > Social Accounts and Contacts > Settings.
• Click Change your organization's Social Accounts and Contacts settings.
• Select Enable Social Accounts and Contacts. To disable Social Accounts and Contacts for everyone, deselect this checkbox.
• Select the social networks that your organization may use. Deselect any of the services that you want to turn off for your

organization. By default, all social networks are turned on.
• Click Save.

Users can turn off the social networks that they personally don’t want to use, or they can turn off the entire feature for themselves.
To do this, users click Your Name > Setup, then in the Personal Setup section, click My Social Accounts and Contacts >
Settings.

Implementation Tips
• You can select the social networks that your organization may use. By default, all of the supported services are turned on.
• Users must sign in to their social network accounts from any Salesforce account, contact, or lead detail page before they

can link or view any Facebook, LinkedIn, and Twitter profiles. Users don’t need Klout or YouTube accounts to see
information from these sites.

• The Klout service requires that Twitter is enabled for your organization. Before users can see Klout information for an
account, contact, or lead, they must be signed in to their Twitter accounts and a Twitter profile must already be associated
with the record.

• Users need these object permissions.

On Business Account detail pages: “Read” on accountsTo sign in to social network accounts...

On Contact detail pages: “Read” on contacts

On Lead detail pages: “Read” on leads

On Person Account detail pages: “Read” on accounts and contacts

On Business Account detail pages: “Edit” on accountsTo link social network profiles to Salesforce records...

On Contact detail pages: “Edit” on contacts

On Lead detail pages: “Edit” on leads

On Person Account detail pages: “Edit” on accounts and contacts

On Business Account detail pages: “Read” on accountsTo view social network profiles that are linked to
Salesforce records... On Contact detail pages: “Read” on contacts
To view Klout information... On Lead detail pages: “Read” on leads
To search for and watch YouTube videos... On Person Account detail pages: “Read” on accounts

• Additional social networks may be available in future updates.

Getting Started with Social Accounts and Contacts
Social Accounts and Contacts is easy to use. Simply click any of the social network icons in the header on account, contact,
and lead detail pages to display the Social Accounts and Contacts viewer. Users can:
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• Sign in to their Facebook, LinkedIn, and Twitter accounts from any account, contact, or lead detail page. This creates
private connections between Salesforce and the social network accounts, which allows users to see external social profiles
in Salesforce. (Users don’t need to sign in to YouTube or Klout accounts to see information from these services.)

• Link Facebook, LinkedIn, and Twitter profiles to their account, contact, and lead records then view these profiles whenever
desired. Once a profile is linked to a record, others in your organization can also view the information without logging in
to other sites. The social profile details that Salesforce displays are always current.

• View Klout information about customers. Salesforce automatically displays this information if a Twitter profile is associated
with the account, contact, or lead record.

• Watch YouTube videos. Each time a user selects the YouTube service, a current list of videos related to the account,
contact, or lead is displayed.

Salesforce CRM Content Enhancements
Change a Salesforce CRM Content Document’s Managing Library Using the ContentDocument
API Object

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

The ContentDocument object is updateable in Spring ‘12 and includes a new ParentId field which can be used to query
and update a document’s managing library. The ParentId field is set automatically when a ContentVersion is inserted via
the API for the first time.

Archive and Unarchive Salesforce CRM Content Documents Using the ContentDocument API
Object

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

The IsArchived field on the ContentDocument object is updateable in Spring ‘12 and can be used to archive or unarchive
a document.

• When IsArchived is set to true, the document is archived. Starting in Spring ‘12, archived documents are returned by
the queryAll() call.

• When IsArchived is set to false, the document is not archived.

Apex Triggers Enabled on the ContentDocument Object
You can now associate Apex triggers with the ContentDocument object. You can create Apex triggers for the ContentDocument
object only through the Metadata API. Alternatively, you can create the triggers using the Force.com IDE or the Force.com
Migration Tool, which make use of the Metadata API. For more information, see the:

• Metadata API Developer's Guide
• Using the Force.com IDE to Deploy Apex topic in the Force.com Apex Code Developer's Guide
• Force.com Migration Tool Guide
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Additional Sales Cloud Enhancements
New Email to Salesforce Features

Available in: All Editions except Database.com

Spring ‘12 includes the following enhancements to Email to Salesforce:

• For emails you add to Salesforce, My Unresolved Items now displays a row for each unresolved email address. While this
may result in additional rows, you now have the opportunity to assign emails to all of the contacts and leads in the email.
In addition, My Unresolved Items now includes an Email Address column so that you know which email addresses weren’t
resolved.

• In My Email to Salesforce, you can now specify email domains you want to exclude from automatic association when you
add emails to Salesforce. For example, you can exclude your own email domain so that Salesforce won’t associate emails
to contacts with your email domain. This can be especially helpful for organizations that create contacts for internal users,
and don’t want emails associated with those users.

Salesforce for Google AdWords Not Available to New Organizations
Starting in Spring ‘12, Salesforce for Google AdWords isn’t available for new organizations. Existing organizations that have
already set up Salesforce for Google AdWords continue to have access.
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Chatter Answers
Available in: Enterprise and Unlimited Editions

Answering your customers’ questions is critical to maintaining your brand’s reputation. A lot of customers, and potential
customers, look to the Web to quickly find answers for your products or services, or to connect with others who can help them
find the information they need. Have you wanted to strengthen your brand and increase your service and support presence
online? With Chatter Answers, you can.

Chatter Answers integrates Cases, Answers, Force.com Sites, Customer Portal, and Salesforce Knowledge to provide you
with a Web community for your customers. It lets your customers:

• Post, browse, and reply to questions.

• Delete their own questions and replies.

• Flag questions and replies as spam, hateful, or inappropriate.

• Receive emails when their questions are answered or when best answers are chosen for questions they’re following.

• Collaborate publicly or privately with support agents to resolve issues.

• Search and review articles from Salesforce Knowledge.

• Vote on the usefulness of knowledge articles and answers.

• Upload photos of themselves to their user profiles.

• View other users’ total number of posts and number of replies marked as best answers by others.

1. Search. Customers can search for existing questions before they post their own.
2. Question. Customers can post a question to the community for help.
3. Comment. Community members and support agents can comment on the question, and the customer can select a comment

as the best answer.
4. Filter. Community members and support agents can view questions and comments by specific topics.

Chatter Answers lets service organizations and support agents:

SERVICE CLOUD
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• Create multiple Web communities.

• Brand and customize communities.

• Respond to customers publicly or privately.

• Automate the creation of cases from questions via an Apex trigger and workflow rules.

• Deflect customer inquiries through community participation.

• Encourage community participation by publicly displaying user statistics.

• Moderate questions and answers from a Questions tab in Salesforce (or from the Service Cloud console).

A customer’s question is typically answered on Chatter Answers using one of these processes:

Question Answered by a
Knowledge Article

Question Answered by a
Support Agent

Question Answered by the
Community

Question Answered by a
Similar Question with a Best
Answer

1. A customer types a
question or keyword into

1. A customer types a
question or keyword into

1. A customer types a
question or keyword into

1. A customer types a
question or keyword into
Chatter Answers and
clicks Ask.

Chatter Answers and
clicks Ask.

Chatter Answers and
clicks Ask.

Chatter Answers and
clicks Ask.

2. 2.2.2.A similar question with an
answer displays in search
results.

A similar knowledge
article with an answer
displays in search results.

No similar questions
display in search results.

No similar questions
display in search results.

3. 3.The customer signs in to
Chatter Answers to post a
public question.

The customer signs in
Chatter Answers to post a
private question.

4.4. The private question is
converted to a case.

A community member or
support agent reads the
question and adds a 5. A support agent reads the

case and adds a privatecomment, which answers
the customer’s question. comment, which answers

the customer’s question.

Limitations
• Chatter Answers doesn’t support Internet Explorer® 6.
• Users can't escalate a question to a case, but support agents can escalate questions from the Answers or Questions tabs.
• Users can't unfollow questions.
• Each question can receive up to 500 replies from users.
• Administrators can't customize or brand Chatter Answers email notifications.
• There are no standard reports for Chatter Answers, but you can create custom report types for questions.
• Administrators can’t customize the FAQ (Frequently Asked Questions) available to customers when they click Need help?.

Implementation Tips
• We recommend that advanced Salesforce administrators and developers set up and maintain Chatter Answers, as it involves

several Salesforce features.
• Before administrators can set up Chatter Answers, their organizations must have implemented Data Categories. If you

want knowledge articles to display in your Web community, then administrators need to implement Salesforce Knowledge.
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• You can customize fields, Apex triggers, and validation rules for questions and replies for Chatter Answers by clicking
Your Name > Setup > Customize > Chatter Answers and choosing the appropriate setting.

• After you enable Chatter Answers, several items are automatically added to your organization for use with setting up
communities:

◊ Questions on user profiles so that you can grant users permissions to questions and replies.
◊ Visualforce pages that you add to a Force.com site so that users can register, sign in, and view feed items on a community.
◊ An Apex trigger for questions named chatter_answers_question_escalation_to_case_trigger so that

questions with specified attributes are automatically escalated to cases.
◊ A workflow field update named chatter_answers_num_subscriptions_above_ so that when a question is

escalated to a case, Priority on questions is updated.
◊ Two workflow rules, chatter_answers_no_best_reply_within_time_limit_wf and

chatter_answers_num_subscriptions_above_limit_wf, which you can customize and activate so that
questions without best replies or questions with a specified number of followers are automatically escalated to cases.

• Chatter Answers is designed to support one user language for each Web community you create. When you enable Chatter
Answers, the Visualforce pages automatically added to your organization inherit your organization’s default language.
However, you can change the language attribute on each Visualforce page. Users who self-register for your community
inherit your organization’s default language. Guest users view your community in the language specified in the Visualforce
pages, no matter the language chosen for their browsers.

• You can rename Customer Support on your communities’ user interface. For example, you can change “Customer
Support” to “Acme Support.” Just edit the Customer Support label on the Question object. See “Renaming Tab and Field
Labels” in the online help.

• Questions escalated to cases display a Chatter-like feed on case detail pages. The case detail page also includes a Customer
View section that lets support agents reply publicly or privately to the thread posted to the community.

• Case comments marked Public display as private messages from customer support in Chatter Answers; they don't display
to the entire community. For example, if a support agent adds a public case comment, it only displays to the case's contact
when he or she logs in to Chatter Answers to review private messages. Support agents can read all private and public case
comments. See “Creating and Editing Case Comments” in the online help.

• Chatter Answers sends emails to users when they:

◊ Sign up for an account.
◊ Follow a question (answers or comments).
◊ Receive an answer or comment to their question.
◊ Receive a private reply to their question from customer support.

• Internet Explorer 8 users receive a security warning if you customize Chatter Answers with URLs that don't include
https://.

• Before you make a Web community public, add at least 20 frequently asked questions, answers, or articles. This content
will generate conversations.

• Create knowledge articles that contain:

◊ Your support organization's phone number so that customers can contact your support agents directly.
◊ Terms and conditions for community members, such as when support agents might delete customers' questions and

comments.

• Chatter Answers uses the following API objects:

◊ Case
◊ Community
◊ Question
◊ QuestionReportAbuse
◊ QuestionSubscription
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◊ Reply
◊ ReplyReportAbuse

See the Web Services API Developer's Guide.

Best Practices
• We recommend that you tell support agents that:

◊ The Case Origin field lists Chatter Answers on any case converted from a question.
◊ If they answer a question privately, they can't convert it to a public answer.

• We recommend that you assign a support agent to review public questions from the Questions tab. Agents can’t click Flag
next to questions or replies that are spam, hateful, or inappropriate, but they can delete questions or replies from a Web
community via the Questions tab if they have the “Delete” permission on questions.

• To moderate many questions quickly, we recommend that support agents review questions from pinned lists on the Service
Cloud console (this requires adding the Questions tab to the console’s Navigation tab; see “Creating a Service Cloud
Console App” in the online help).

• To see a list of cases converted from questions, we recommend that administrators or support agents create a case view
where Case Origin equals Chatter Answers. See “Creating Custom List Views” in the online help.

• Because photos added to profiles display externally on Chatter Answers, we recommend that support agents choose photos
that match their company's policies and branding. See “Uploading Chatter Group and Profile Photos” in the online help.

Chatter Answers Terminology

Available in: Enterprise and Unlimited Editions

The following terms are used when describing Chatter Answers features and functionality.

Answers

Answers is a feature of the Community application that enables users to ask questions and have community members
post replies. Community members can then vote on the helpfulness of each reply, and the person who asked the question
can mark one reply as the best answer.

Article

Articles capture information about your company's products and services that you want to make available in your knowledge
base.

Best Answer

When a member of an answers community asks a question and other community members post a reply, the asker can
mark one of the replies as the best answer. The best answer then appears directly under the question (above the other
replies). Identifying the best answer helps other community members with the same question quickly find the most
relevant, useful information.

Flag

An icon that users can click on a question or reply to report it as spam, hateful, or inappropriate.
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Follow

A subscription to a question that lets you receive emails when someone answers or comments on a specific question.
You can only follow questions that don’t have best answers.

Like

To show support for a customer’s question.

Popular

Each question's popularity is based on the number of users who mark it as Useful within a certain amount of time.

Question

An issue posted to an answers community. When a community member asks a question, other community members
post replies to help resolve the question.

Question, Private

An issue posted to an answers community, but marked Private so that only support agents can view and respond to it.

Reply

The response to a question in an answers community. When community members reply to a question, the person who
asked the question can mark one of the replies as the best answer to resolve and close the question.

Topics

The sidebar that lists data categories from which your customers can browse questions and replies. For example, if you
have a community for hardware products, your topics may include laptops, desktops, and printers.

Useful

Anyone signed in to Chatter Answers can mark a question with a best answer or Knowledge article as Useful to help
determine its popularity.

Vote, Reply

In an answers community, a vote means you either like or dislike a reply to a question.

Chatter Answers Users Overview

Available in: Enterprise and Unlimited Editions

Because Chatter Answers integrates several features with the Customer Portal, managing Chatter Answers users is similar to
managing Customer Portal users. Use the following to manage the data and functions that are accessible to Chatter Answers
users:

• Profiles, permissions, and access settings determine a user’s permission to perform different functions, such as adding
comments to a case.

• User licenses define which profiles and permission sets are available to a user, such as the High Volume Customer Portal
(Service Cloud Portal User) or Customer Portal Manager Custom license.

• Feature licenses entitle a user to additional Salesforce features, such as Chatter Answers.

• Field-level security defines which fields users can access, such as fields on Salesforce Knowledge articles.
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• Sharing sets let you selectively grant record access to defined groups of high-volume portal users.

Chatter Answers excludes some features typically available to Customer Portal users, such as:

• Ideas

• Groups

• Teams

• Reports

• Content

• Page layouts

• Custom objects

• Delegated portal user administration

• Customer Portal role hierarchy (available, but not used)

• Customer Portal sharing rules, except for high-volume portal users

Chatter Answers users can only access the following records from your Web community:

• Cases

• Questions

• Replies (answers)

• Salesforce Knowledge articles

Chatter Answers is designed to support one user language for each Web community you create. When you enable Chatter
Answers, the Visualforce pages automatically added to your organization inherit your organization’s default language. However,
you can change the language attribute on each Visualforce page. Users who self-register for your community inherit your
organization’s default language. Guest users view your community in the language specified in the Visualforce pages, no matter
the language chosen for their browsers.

Note:

• Chatter Answers isn’t supported for partner portal users.

• Chatter Answers users can’t change their language, timezone, or locale settings.

• Portal users must have the Chatter Answers User feature license to use Chatter Answers. This feature license is
automatically assigned to high-volume portal users who self-register for Chatter Answers. You can manually assign
the license to users who don’t self-register by editing a user and clicking Chatter Answers User.

Chatter Answers Implementation Overview

Available in: Enterprise and Unlimited Editions

Note: We recommend that advanced Salesforce administrators and developers set up and maintain Chatter Answers,
as it involves several Salesforce features.

Chatter Answers integrates Cases, Answers, Force.com Sites, Customer Portal, and Salesforce Knowledge to provide you
with a Web community for your customers. Before administrators can set up Chatter Answers, their organizations must have
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implemented Data Categories. If you want knowledge articles to display in your Web community, then administrators need
to implement Salesforce Knowledge.

Unlike other Salesforce features, Chatter Answers spans across several areas of setup. There isn’t one location in Salesforce
where you can update and configure all of the settings related to Chatter Answers. For example, configuring Chatter Answers
might require you to update Customer Portal settings by clicking Your Name > Setup > Customize > Customer Portal >
Settings, as well as Force.com Site settings by clicking Your Name > Setup > Develop > Sites.

Setting up Chatter Answers also includes customizing or maintaining:

• Cases

• Case assignment rules

• Workflow rules on cases or questions

• Apex triggers on questions

• Visualforce pages

• Customer Portal users

• Organization-wide sharing defaults

• Feature licenses

Customizing the appearance of your Chatter Answers community to match your company’s branding involves creating or
updating Visualforce pages and adding them to the Force.com Site used to host your community.

Setting Up Chatter Answers

Available in: Enterprise and Unlimited Editions

User Permissions Needed

“Customize Application”

AND

“Manage Users”

AND

“Edit Self-Service Users”

To set up Chatter Answers:

Note: The steps below are general guidelines for setting up Chatter Answers. Chatter Answers integrates several
Salesforce features, including features administrators may have implemented already, so each Chatter Answers
implementation may be different. Contact salesforce.com for specifics on your implementation.

Before administrators can set up Chatter Answers, their organizations must have implemented Data Categories. If you want
knowledge articles to display in your Web community, then administrators need to implement Salesforce Knowledge.

Before you set up Chatter Answers, you must purchase an adequate number of the following licenses:

• Chatter Answers User
• Knowledge User, if you plan to use knowledge articles
• Customer Portal user licenses, we recommend High Volume Customer Portal

1. Enable Chatter Answers.
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2. Configure email notification settings.
3. Implement a Customer Portal (if one doesn’t already exist for your organization).
4. Configure your organization’s Customer Portal for Chatter Answers.
5. Configure high-volume portal users for self-registration.
6. Implement a Force.com site (if one doesn’t already exist for your organization).
7. Configure your organization’s Force.com site for Chatter Answers.
8. Configure cases for Chatter Answers.
9. Set Questions tab visibility.
10. Optionally:

• Assign data categories to Chatter Answers.
• Configure Salesforce Knowledge for Chatter Answers.

11. Configure one or more Chatter Answers communities.

Important: After you set up Chatter Answers, it may not work properly if you change any of the configurations in
the features mentioned above. If certain configuration issues are detected, Salesforce sends email notifications to the
Site Contact user.

Tip:

• You can add custom fields to questions or replies for API integration purposes only. For example, add a custom
text field to questions and use the API to populate that text field with the name of the country from which each
question is posted. Any custom fields you create for questions or replies can’t display in the Salesforce user interface.

• You can customize fields, Apex triggers, and validation rules for questions and replies for Chatter Answers by
clicking Your Name > Setup > Customize > Chatter Answers and choosing the appropriate setting.

• You can rename Customer Support on your communities’ user interface. For example, you can change
“Customer Support” to “Acme Support.” Just edit the Customer Support label on the Question object. See “Renaming
Tab and Field Labels” in the online help.

Enabling Chatter Answers

Available in: Enterprise and Unlimited Editions

User Permissions Needed

“Customize Application”To enable Chatter Answers:

Enable Chatter Answers to set up Chatter Answers communities.

1. Click Your Name > Setup > Customize > Chatter Answers > Settings.
2. Click Edit.
3. Select Enable.
4. Click Save.

After you enable Chatter Answers, several items are automatically added to your organization for use with setting up
communities:

• Questions on user profiles so that you can grant users permissions to questions and replies.
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• Visualforce pages that you add to a Force.com site so that users can register, sign in, and view feed items on a community.
• An Apex trigger for questions named chatter_answers_question_escalation_to_case_trigger so that

questions with specified attributes are automatically escalated to cases.
• A workflow field update named chatter_answers_num_subscriptions_above_ so that when a question is escalated

to a case, Priority on questions is updated.
• Two workflow rules, chatter_answers_no_best_reply_within_time_limit_wf and

chatter_answers_num_subscriptions_above_limit_wf, which you can customize and activate so that questions
without best replies or questions with a specified number of followers are automatically escalated to cases.

Visualforce Pages for Chatter Answers

Available in: Enterprise and Unlimited Editions

After you enable Chatter Answers, the Visualforce pages below are automatically added to your organization. You can use
these pages to set up and configure Chatter Answers communities.

DescriptionVisualforce page

The page that includes the question, reply, and Knowledge
article feeds for your community. This page is also used to

Community Name_main

(Home Page) determine the community from which email notifications are
sent to users.

This page is automatically generated when you save a new
community without choosing Visualforce Page That
Hosts Your Community’s Feeds. The generated page
includes your community’s ID so that topics, questions, and
replies are associated with your specific community and can
display on it. The page is named after your community with
a suffix of “_main,” for example, CommunityName_main.
The page also includes a language attribute that matches your
organization’s default language.

The Visualforce component that displays questions on case
detail pages when questions are converted to cases. This

ChatterAnswersAgentView

component is optional and offers an alternative to the case
detail page.

The page where users can change their passwords to your
community.

ChatterAnswersChangePassword

The forgot password page for your community.ChatterAnswersForgotPassword

The forgot password confirmation page for your community.ChatterAnswersForgotPasswordConfirm

The online help page displayed to users when they click Need
Help?.

ChatterAnswersHelp

The login page for your community.ChatterAnswersLogin

The page where users can self-register for access to your
community.

ChatterAnswersRegistration
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Configuring Email Notifications for Chatter Answers

Available in: Enterprise and Unlimited Editions

User Permissions Needed

“Customize Application”To configure email notifications for your Chatter Answers
communities:

Determine when emails are sent to users by configuring the notification settings that apply to all of your Web communities.
Each email includes a link to a specific community so that users can easily return to it.

1. Click Your Name > Setup > Customize > Chatter Answers > Email Notification Settings.
2. Click Edit.
3. Choose from the following settings:

DescriptionOption

Notify customers when other users reply to their questions.Replies to a question they own

Notify customers when other users reply to questions they’re following.Replies to a question they follow

Notify customers when a best answer is selected for a question they’re
following.

Selects a best answer on a question they
follow

Notify customers when customer support responds to their questions
privately.

Sends a private reply to their question
(Customer Support)

4. Click Save.

Configuring Portal Users for Self-Registration to Chatter Answers

Available in: Enterprise and Unlimited Editions

User Permissions Needed

“Customize Application”To set up and update the Customer Portal:

“Edit Self-Service Users”To manage Customer Portal users:

Configure Customer Portal users for self-registration to your Chatter Answers community.

1. Clone the High Volume Customer Portal profile so that you can customize it:

a. Click Your Name > Setup > Manage Users > Profiles.
b. Click Clone next to High Volume Customer Portal.
c. Type a name for the new profile.
d. Click Save.

2. Customize the cloned profile to include permissions to the standard objects on your community:
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a. Click Your Name > Setup > Manage Users > Profiles.
b. Click the name of the cloned profile.
c. Click Edit.
d. In Standard Object Permissions, click on the following permissions to these objects:

PermissionsObject

Read, CreateCases

ReadContacts

Read, CreateQuestions

e. Click Save.

Configuring a Customer Portal for Chatter Answers

Available in: Enterprise and Unlimited Editions

User Permissions Needed

“Customize Application”To set up and update the Customer Portal:

Configure a Customer Portal for Chatter Answers to authenticate users who sign in to your Chatter Answers community.

1. Click Your Name > Setup > Customize > Customer Portal > Settings.
2. Click Edit next to the Customer Portal you want to configure for Chatter Answers.
3. Click Login Enabled to let customers sign in to Chatter Answers.
4. In From Email Address, type the address from which all email communications from your Chatter Answers community

are sent. For example, support@acme.com.
5. In From Email Address Name, type the name associated with the From Email Address. For example, Acme

Customer Support.
6. Click Self-Registration Enabled to let customers register themselves for access to Chatter Answers.
7. In Default New User License, choose the portal user license that’s automatically assigned to customers who

self-register. We recommend you choose the High Volume Customer Portal license.
8. In Default New User Profile, choose the profile that’s automatically assigned to customers who self-register. We

recommend you choose the profile you cloned and customized for self-registration.
9. Click Save.
10. Assign the profile you selected as the Default New User Profile to your Customer Portal so that users can sign in

to your community:

a. Click Your Name > Setup > Customize > Customer Portal > Settings.
b. Select your portal’s name.
c. In the Assigned Profiles section, click Edit Profiles.
d. Click Active next to the profile you selected as the Default New User Profile.
e. Click Save.
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Configuring a Force.com Site for Chatter Answers

Available in: Enterprise and Unlimited Editions

User Permissions Needed

“Customize Application”To create and edit Force.com sites:

Configure a Force.com site for Chatter Answers to host a domain and publicly display some of your Salesforce data, such as
questions, replies, and knowledge articles.

1. Click Your Name > Setup > Develop > Sites.
2. Click Edit next to the name of the site you want to configure for Chatter Answers.
3. Click Active to activate the site.

You can activate the site after you’ve finished setting up Chatter Answers.

4. In Active Site Home Page, choose a Visualforce page as the home page for your Chatter Answers community.
5. Click Save.
6. Click Edit on the Site Visualforce Pages related list.

a. Use the Add and Remove buttons to enable the following Visualforce pages for your site:

• ChatterAnswersAgentView

• ChatterAnswersChangePassword

• ChatterAnswersForgotPassword

• ChatterAnswersForgotPasswordConfirm

• ChatterAnswersHelp

• ChatterAnswersLogin

• ChatterAnswersRegistration

b. Click Save.

7. Click Public Access Settings to grant guest users (unauthenticated, non-Customer Portal users) access to cases, questions,
and Salesforce Knowledge articles.

a. Click Edit on the profile for Chatter Answers users.
b. In Standard Object Permissions, click Read on Cases and Questions.
c. Optionally, if you want articles to display in your Chatter Answers community, click Read on articles types in Article

Type Permissions.
d. Click Save.

8. Click Edit next to a category group in the Category Group Visibility Settings related list to grant users access to the
categories so that they can browse questions, replies, and knowledge articles.

a. Next to Visibility, click All Categories.
b. Click Save.

9. Return to the site and select its name by clicking Your Name > Setup > Develop > Sites.
10. Click Login Settings to enable user authentication for the site.

a. Click Edit.
b. In Enable Login For, choose the Customer Portal you created for Chatter Answers.
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c. Click Save.

After you configure your Force.com site for Chatter Answers, you can replace the standard Visualforce pages that make up
your community with customized ones. The Visualforce pages are automatically set to your site’s URL so that portal users can
navigate to them.

1. Click Your Name > Setup > Customize > Chatter Answers > Sites Settings.
2. Click Edit next to a site.
3. Choose the pages to replace. If you replace the Change Password Page, the Change Password Page for your site

is automatically updated too.
4. Click Save.

Note: Internet Explorer 8 users receive a security warning if you customize Chatter Answers with URLs that don't
include https://.

Configuring Cases for Chatter Answers

Available in: Enterprise and Unlimited Editions

User Permissions Needed

“Manage Users”

AND

“Customize Application”

To set organization-wide sharing defaults:

“Customize Application”To set field-level security:

“Customize Application”To customize fields:

To create assignment rules:

To grant high-volume portal users access to cases:

Configure case features for Chatter Answers so that cases are created, escalated, and accessed by the appropriate users of your
Chatter Answers communities.

1. Set your organization-wide sharing defaults to Private on Account, Controlled by Parent on Contact, and Private on Case
to prevent users from accessing each others’ information.

2. Set field-level security on Question on cases to Visible for profiles assigned to your Customer Portal so that users can
access their private questions.

3. Update Origin on cases with the value in the Question trigger so that support agents can see which cases originated from
Chatter Answers.

4. Create a case assignment rule where Case Origin equals the value of Chatter Answers so that cases created from private
questions are assigned to support agents.

5. Grant high-volume portal users access to cases so that they can access their private questions on Chatter Answers.

Setting Questions Tab Visibility
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Available in: Enterprise and Unlimited Editions

User Permissions Needed

“Manage Users”To set Questions tab visibility:

Set the visibility of the Questions tab to Default On so that support agents can view, search, filter, and moderate questions
posted to your Chatter Answers community.

1. Click Your Name > Setup > Manage Users > Profiles.
2. Select a support agent profile.
3. Depending on which user interface you're using, do one of the following:

• Enhanced profile user interface—In the Find Settings... box, enter the name of the tab you want and select it from
the list, then click Edit.

• Original profile user interface—Click Edit, then scroll to the Tab Settings section.

4. Specify the visibility of the Questions tab to Default On.
5. (Original profile user interface only) To reset users’ tab customizations to the tab visibility settings that you specify, select

Overwrite users' personal tab customizations.
6. Click Save.

Assigning Data Categories to Chatter Answers

Available in: Enterprise and Unlimited Editions

User Permissions Needed

“Customize Application”To assign data categories to Chatter Answers:

Assign a data category group to Chatter Answers so that it’s available to all of your Chatter Answers communities. You
configure each community with a top-level data category (topic) in which customers and support agents can categorize and
filter questions and knowledge articles.

1. Click Your Name > Setup > Customize > Chatter Answers > Data Category Assignments.
2. Click Edit.
3. Select a category group.
4. Click Save.

Configuring Salesforce Knowledge for Chatter Answers
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Available in: Enterprise and Unlimited Editions

User Permissions Needed

“Manage Users”To create or edit users:

“Customize Application”

AND

“Manage Salesforce Knowledge”

To create article types and article actions:

“Manage Synonyms”To manage synonyms:

“Manage Data Categories”To create data categories:

To display knowledge articles in your Chatter Answers communities, you must:

1. Implement Data Categories (if you haven’t done so already).
2. Implement Salesforce Knowledge (if you haven’t done so already).
3. Configure both for Chatter Answers.

You configure each community with a top-level data category (topic) in which customers and support agents can categorize
and filter questions and knowledge articles.

1. Set the Default Data Category Visibility to All Categories so that customers not included in your organization’s role
hierarchy, such as high-volume portal users, can access categories that include questions and knowledge articles.

2. Create one category group for all of your communities so that you’re less likely to reach the limit of three active data
categories. Then add a child category for each community; and add child categories to those categories to provide topics.

3. Activate the category group you want available to Chatter Answers so that users can access it.
4. Grant “Read” permissions to specific article types on the profiles of Chatter Answers users so that they can access articles

from your communities.

Configuring a Chatter Answers Community

Available in: Enterprise and Unlimited Editions

User Permissions Needed

“Customize Application”To configure a Chatter Answers community:

Configure a Chatter Answers community to integrate the user authentication features of the Customer Portal with the domain
and public data features of a Force.com site.

1. Click Your Name > Setup > Customize > Chatter Answers > Communities.
2. Select an existing community, or click New to create a new community.
3. Type a name and description for your community.
4. Click Active to activate the community for ideas, answers, or Chatter Answers.
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5. Click Enable This Community for Chatter Answers to associate the community with Chatter Answers.
6. Click Enable Private Questions to let customers post their questions privately to customer support (create cases). If you

don’t select this setting, support agents can still initiate private communications with customers.
7. In Data Category for Top-Level Topics, choose the top-level topic in which customers and support agents can

categorize and filter questions and knowledge articles.

8. In Site That Hosts Your Community, click  and choose the Force.com site on which you want to host the
community.

9. In Visualforce Page That Hosts Your Community’s Feeds, click  and choose the Visualforce page on
which questions, replies, and knowledge articles display.

The page you choose must include the chatteranswers:allfeeds component so that the community is linked to
your Force.com site correctly. If you don’t choose a Visualforce page, one is automatically generated when you save your
community. The generated page includes your community’s ID so that topics, questions, and replies are associated with
your specific community and can display on it. The page is named after your community with a suffix of “_main,” for
example, CommunityName_main. The page also includes a language attribute that matches your organization’s default
language.

10. In Portal, choose the Customer Portal in which to authenticate community members.
11. Click Save.

Note: You can create a community for each product you want to support. If you create multiple communities, your
portal users have access to all of them. Each question a user creates is associated with the community in which it’s
posted, and the community name is added to each question so that users and support agents can see where it originated.
Users can view all of the questions they’ve posted to your communities by clicking My Questions from any community.
You only need one Force.com site and one Customer Portal to support multiple communities.

Using Chatter Answers

Available in: Enterprise and Unlimited Editions

User Permissions Needed

“Read” on questionsTo view questions:

“Create” on questionsTo ask and reply to questions:

“Read” on caseTo view cases:

“Edit” on caseTo change cases:

“Edit Self-Service Users”To manage Chatter Answers (Customer Portal) users:

Chatter Answers lets you work with questions and cases that originate from customers in a Web community. Once a customer
posts a question to the community, you or other customers may reply. Questions are converted to cases when they’re marked
Private, or after a time specified by your administrator.

With Chatter Answers, you can:

• Reply to questions converted to cases.
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• Create custom views for cases converted from questions by filtering on Case Origin.

• Upload a photo to your profile so that customers can see who you are.

• Work with Chatter Answers users, who are essentially Customer Portal users.

• Assign the Chatter Answers User feature license to portal users who don’t self-register so that they can access your
community.

• Use the Questions tab to moderate questions and to:

◊ Review lists of questions.

◊ Answer questions or add replies to questions.

◊ Manually escalate a question to a case.

◊ Delete questions or replies.

◊ Select best answers for questions.

Note: We recommend that you assign a support agent to review public questions from the Questions tab. Agents
can’t click Flag next to questions or replies that are spam, hateful, or inappropriate, but they can delete questions or
replies from a Web community via the Questions tab if they have the “Delete” permission on questions.

Tip: To moderate many questions quickly, we recommend that support agents review questions from pinned lists on
the Service Cloud console (this requires adding the Questions tab to the console’s Navigation tab; see “Creating a
Service Cloud Console App” in the online help).

Questions Home

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on questionsTo view the Questions tab:

"Create” on questionsTo ask and reply to questions:

“Delete” on questionsTo delete questions and replies:

“Create” on casesTo escalate a question to a case:

The Questions tab lets you view, search, filter, and moderate questions from lists.

• Search for questions by typing two or more letters of a question in the Search All Questions box. As you type, questions
that match your search terms appear.

• Select predefined list views from the View drop-down list. Some predefined lists from which you can filter questions
include:

◊ Questions with Best Replies

◊ Questions without Best Replies

• Click Create New View to define your own custom list view. To edit or delete any view you created, select it from the
View drop-down list and click Edit. If your organization has multiple communities, we recommend you add Community
to your views so that you can see the name of the community associated with each question.
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• Click  to refresh a list that’s been updated.

• After you select a question from the list:

◊ Type an answer or comment and click Answer Customer & Community to reply to customers.

◊
Click  to delete a reply on the question.

◊
Click  and choose:

- Delete to delete the question from the community.

- Escalate to Case to create a case from the question.

Note:  The Questions tab is intended for Chatter Answers, but you can also use it to view questions from the answers
feature.

Live Agent
Available in: Enterprise, Unlimited, and Developer Editions

Need to spice up your customer experience and increase customer satisfaction? Live Agent lets you add real-time Web chat
to your existing customer service channels. Place chat buttons on your website, public knowledge base, or Customer Portal
and allow your customers to contact your support agents instantly. Live Agent features:

• A dedicated console that lets agents easily manage chat sessions, view incoming chat requests, and transfer chats to other
agents

• Quick Text, which allows agents to create standard chat messages, such as greetings and reusable troubleshooting steps

• Seamless integration with Salesforce records and Salesforce Knowledge articles in the chat console, giving agents easy
access to customer information and knowledge articles

• Six chatlets, mini applications that run within the Live Agent console to extend its functionality

• Visitor and chat transcript records, which let agents and supervisors view and monitor information about customers and
their issues

• The ability to customize your chat buttons and windows to include your company’s logo, specify the language users see,
control how chats are distributed to agents, and associate each button with a specific agent skill set

• Customizable agent configurations that let you create different chat experiences for agents and customers

Setting Up Live Agent
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Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To set up Live Agent:

“Manage Users”To create user profiles or permission sets:

To set up Live Agent:

1. Enable Live Agent for your organization.
2. Create user profiles or permission sets to determine which users can access chat transcripts and visitor records.
3. Create Live Agent users.
4. Assign users a configuration to give them access to the Live Agent console.
5. Identify a set of skills to help route incoming chats to the right agents.
6. Create skills and assign users to them.
7. Determine the number and type of deployments that your organization requires.
8. If you want to brand the chat windows your visitors see (for example, to display your company's logo), create one or more

Force.com sites to host the images.
9. Upload the images as static resources.
10. Create deployments, and add the deployment code to each Web page that will have a chat button.
11. Create chat buttons.

Optionally:

• Customize the Live Chat Transcript page.

• Customize the Live Chat Visitor page.

• Add a custom Chat Answer field to Salesforce Knowledge article types to let agents copy information from an article into
a chat.

• Create Quick Text messages to help agents chat with customers more efficiently.

Setup Tips
• We recommend that advanced Salesforce administrators and developers set up and maintain Live Agent, as the process

involves multiple steps and significant customization.
• Live Agent requires feature licenses, which you can purchase by contacting salesforce.com. Each Live Agent user needs

his or her own feature license.
• We recommend that you review the following questions before setting up Live Agent:

◊ How many deployments do you need? Deployments control the look and feel of your chat windows. If your customer
service departments supports multiple products or websites, you may want to create several different deployments.

◊ How do you want to divide and define agent skill sets? Each chat button you create is associated with a particular skill,
such as technical support, billing, or general inquiries. Before you can create chat buttons, you need to create skills and
assign them to users or user profiles.

◊ How many agent configurations do you need? Configurations determine agents’ chat capacity, or how many active
chats they can participate in at a time, as well as the chatlets they have access to. You may want to create one configuration
for junior agents, for example, with a low chat capacity and access to only the basic chatlets, and another for supervisors,
with a higher chat capacity and access to all chatlets.

58

Service Cloud Live Agent



◊ What Quick Text categories and subcategories do you need? Defining and creating an effective categorization system
for your Quick Text messages will make it easier for agents to find the ones they need when chatting with customers.

◊ Do you want your users to see customized pre-chat forms or post-chat pages? You might want to create a pre-chat
form that collects information such as a user’s name and a short description of their question or issue, for example, or
a post-chat page with a link to a survey about the customer’s experience with your support team.

Creating pre-chat forms and post-chat pages requires knowledge of HTML, Javascript, and Visualforce.

• If you choose to use a Force.com site to customize your chat buttons or deployments, you need to create the site and upload
images to it as static resources before creating buttons or deployments.

Enabling Live Agent

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To enable Live Agent:

To enable Live Agent for your organization:

1. Click Your Name > Setup > Customize > Live Agent > Settings.
2. Select Enable Live Agent.
3. Click Save.

Assigning Live Agent Permissions

Available in: Enterprise, Unlimited, and Developer Editions

Access to and interactions with certain types of Live Agent records, such as chat transcripts, visitor records, and Quick Text
messages, are controlled by object permissions. When you create profiles or permission sets for Live Agent users, you’ll grant
“Create,” “Read,” “Edit,” or “Delete” permissions on objects depending on the functionality your users need. For example:

• Agents need at least the “Read” permission on Live Chat Visitors and Live Chat Transcripts to review visitor and transcript
records.

• In addition, you might need to give users in supervisory or compliance roles “Create,” Edit,” and “Delete” permissions on
these objects. For example, supervisors may need to flag some records for follow up for training purposes, or they may need
to add additional comments or update other information in the records. For compliance purposes, some users might need
to delete records if they contain sensitive information.

• Other users who want to see transcripts and visitor records will need “Read” permission on these objects.

• To create Quick Text messages, users need “Create,” “Read,” “Edit,” and “Delete” permissions on the Quick Text object.

• To access the Quick Text sidebar in the Live Agent console, agents need at least “Read” permission on Quick Text.

Note: Salesforce automatically creates visitor and transcript records for each chat regardless of which permissions an
agent has on Live Chat Visitor and Live Chat Transcript.
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Creating Live Agent Users

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To create or edit users:

1. Click Your Name > Setup > Manage Users > Users.
2. Click Edit next to a user's name.
3. Select Live Agent User. If you don’t see this checkbox, make sure your organization has purchased enough Live Agent

feature licenses.
4. Make sure the user has the correct profile based on the permissions required.
5. Click Save.

After creating users, make sure that you assign them a Live Agent configuration and associate them with the appropriate skills.

Agent Configuration Overview

Available in: Enterprise, Unlimited, and Developer Editions

Agent configurations control the functionality of the Live Agent console. Configurations control:

• Which “chatlets” in the online help are enabled.

• Chat capacity, which is the number of simultaneous chat sessions an agent can participate in.

• Whether or not a sound plays when a new chat is available or when the agent is disconnected from a chat session.

• Whether or not sneak peek is enabled. Sneak peek lets agents see what visitors are typing before visitors send messages.

• The greeting message that appears automatically to visitors when a chat begins.

You give Live Agent users access to the Live Agent console by assigning them a configuration either through a profile or at
the user level. If a user is assigned a configuration at both the profile and user level, the user-level configuration overrides the
profile one.

Users that aren’t associated with a configuration get the default configuration:

• All chatlets enabled

• Unlimited chat capacity

• Sneak peek enabled

• Request sound and disconnect sounds disabled

• Auto greeting disabled

Configurations let you make sure that agents get the Live Agent console functionality that makes sense for their skill levels
and job requirements. For example, you might want to create different configurations for new and experienced agents. The
configurations can contain the same chatlets and visitor greeting, but specify different chat capacities: new agents are assigned
a capacity of two chats, while experienced users are assigned a capacity of five chats. Then, depending on what makes sense
for your organization, you can assign configurations by:
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• Creating separate profiles for new and experienced agents, and then associating the new agent profile with the new agent
configuration, and the advanced agent profile with the advanced configuration.

• Creating a single profile, assigning it to the new agent configuration, and then assigning the individual experienced agents
the advanced configuration at the user level.

Depending on the size of your organization, you may have few or many configurations. For example, in a small organization,
you might have three configurations: one for new agents, one for experienced agents, and a third for supervisors. In a global
enterprise, you could have dozens of configurations. We recommend that you assess your organization’s configuration
requirements as part of your implementation planning.

Skills Overview

Available in: Enterprise, Unlimited, and Developer Editions

Skills identify the capabilities of agents, and are used to route requests to the right set of agents. For example, if your support
center handles both technical and end-user issues, you’d create separate “Technical” and “End User” skills, and assign agents
accordingly. Then, when a query comes in that requires technical expertise, Salesforce routes the request to those agents in
the “Technical” skill set only.

You can assign skills to both profiles and individual users, and you can associate both users and profiles with multiple skills.
For example, if your organization supports laptop, desktop, and tablet computers, you'd assign all three computer skills to
agents qualified to provide support on each type of computer, while you'd assign just the “desktop” skill to agents only trained
on desktop computers.

During implementation planning, we recommend that you identify the skills that you’ll assign to agents. If your organization’s
agents can handle any chat request, then you need to create only one skill. However, it’s more likely that your agents are
specialized, and you’ll need to create skills to make sure that they receive the appropriate requests.

Creating Skills

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create skills:

To create a skill and assign it to users:

1. Click Your Name > Setup > Customize > Live Agent > Skills.
2. Click New.
3. Enter a name for the skill.
4. In the Assign Users area, select the users you want to associate with the skill.
5. In the Assign Profiles area, select the profiles you want to associate with the skill.
6. Click Save.
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Live Agent Deployment Overview

Available in: Enterprise, Unlimited, and Developer Editions

A deployment is a place on your company's website that's enabled for Live Agent. Deployments let you:

• Create the code that you add to Web pages to enable them for Live Agent.

• Control the appearance of the Chat window that visitors access from the Web page. You do this by adding images (for
example, your company's logo) to a deployment to brand it.

• Enhance security and minimize the number of illegitimate chat requests you receive by specifying the domains allowed to
host chat buttons.

• Segment your visitor traffic to better understand the different types of visitors using chat for service or sales support. Chat
agents can see deployment information for each visitor, and the deployment is saved as part of the chat transcript.

A deployment consists of a few lines of JavaScript that you add to a Web page. Your organization can have a single Live Agent
deployment or multiple deployments. For example, if you have a single service center that supports multiple websites, creating
a separate deployment for each site lets you present different Chat windows to your visitors.

Creating Deployments

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create deployments:

If you plan to customize the Chat window (for example, brand the window with your company's logo), you need to upload
images as static resources and then create one or more Force.com sites to host the images. Note that when you create a
Force.com site for use with Live Agent, you need to provide only the following information:

• A site label and a site name
• A site contact
• The active site's home page
• A site template

To create a deployment:

1. Click Your Name > Setup > Customize > Live Agent > Deployments.
2. Click New.
3. Enter a name for the deployment. This name, or a version of it, automatically becomes the Developer Name.
4. Enter a title for the Chat window.

This is the title that visitors see.

5. Select Allow Visitors to Save Transcripts to let visitors download a copy of the chat session when it ends.
6. Select the site that you'll associate with the deployment.

Visitors see this URL in the Chat window.
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7. In Chat Window Branding Image, select the graphic that will appear in the Chat window.
8. In Mobile Chat Window Branding Image, select the graphic that visitors using mobile devices will see in the Chat

window.
9. Click Save.

Salesforce generates the deployment code.
10. Copy the deployment code and paste it on each Web page where you want to deploy Live Agent. For best performance,

paste the code right before the closing body tag (that is, </body>).

After creating deployments, you need to create the buttons that visitors click to initiate chat sessions, and then add that code
to web pages as well. See Creating Chat Buttons.

Creating Chat Buttons

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create and customize chat buttons:

Before you create chat buttons, you need to:

• Create skills. Each chat button is associated with a particular skill so that chats initiated from the button are routed to the
right agents.

• Create a Force.com site if you’ll be using it to host the images for the online and offline versions of your button. If you
don’t have a Force.com site, you can specify online and offline button images or text by modifying the code that’s generated
when you create a button.

• Decide how you want chat requests that come in through the button to be routed to agents.

To create a button:

1. Click Your Name > Setup > Customize > Live Agent > Chat Buttons.
2. Click New.
3. Type a name for the button.
4. Select a skill to associate with the button.
5. Select a routing option for chats initiated through the button.
6. Optionally, if you select the Least Active or Most Available routing option, specify how long agents have to answer incoming

chat requests before they’re re-routed.
7. Optionally, enable queueing for incoming chat requests, and specify the maximum number of requests that can be in the

queue.
8. Customize your chat button using one of these options:

StepsPrerequisitesOption

Create a Force.com site that has the
following information:

Use a Force.com site
a. In Site for Resources, select

the site that hosts your chat button
images.• A site label and a site name

• A site contact
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StepsPrerequisitesOption

b. In Online Image, select the
button image that visitors will see

• The active site's home page
• A site template

when agents with the associated skill
are available to chat.

c. In Offline Image, select the
button image that visitors will see
when no agents are available.

d. Optionally, in Custom Chat
Page, select the page you want to
use instead of the standard chat
window.

e. Click Save. Salesforce generates the
button code.

You’ll need access to a text or HTML
editor in order to change the button

Use custom code
a. Click Save. (You don’t need to enter

anything in the Chat Buttoncode. You may want to have a developer
do this customization. Customization fields.) Salesforce

generates the button code.
b. Copy and paste the Chat Button

Code into a text or HTML editor.
c. Replace the <!-- Online Chat

Content --> and <!-- Offline
Chat Content --> comments
with code for the chat button images
or text you want to use.

9. Optionally, choose the Visualforce page, or type the URL of the external Web page, that hosts the pre-chat form and
post-chat page for the button.

10. Copy the button code and paste it on each Web page where you've deployed Live Agent. Make sure to paste the code in
the area on the page where you want the button to appear.

Tip:  Remember to copy and paste the code each time you update the button, as the code changes with each
modification.

Setting Up Live Chat Transcripts
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Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To set up Live Chat Transcripts:

The Live Chat Transcripts tab contains the transcripts of completed chat sessions. Depending on your organization's
requirements, you may want to customize the Live Chat Transcripts tab to display or hide standard fields, manage security,
add custom fields, add buttons or links, or more.

To set up the tab:

1. Customize Live Chat Transcript fields.
This lets users add additional information to Live Chat Transcript records.

2. Customize Live Chat Transcript page layouts.
This lets you specify which fields display to users.

3. Set field-level security on Live Chat Transcript fields.
This lets you choose which fields users can access.

4. Add the Live Chat Transcript tab to an app
This lets users view the tab from a specific app.

5. Optionally, set up validation rules to prevent users from saving incorrect data.

Setting Up Live Chat Visitors

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To set up Live Chat Visitors:

The Live Chat Visitor tab contains information about visitors that have participated in chat sessions. Depending on your
organization's requirements, you may want to customize the Live Chat Visitor tab to display or hide standard fields, manage
security, add custom fields, add buttons or links, or more.

To set up the tab:

1. Customize Live Chat Visitor fields.
This lets users add additional information to Live Chat Visitor records.

2. Customize Live Chat Visitor page layouts.
This lets you specify which fields display to users.

3. Set field-level security on Live Chat Visitor fields.
This lets you choose which fields users can access.

4. Add the Live Chat Visitor tab to an app
This lets users view the tab from a specific app.

65

Service Cloud Live Agent



5. Optionally, set up validation rules to prevent users from saving incorrect data.

Setting Up Quick Text

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To set up Quick Text:

Quick Text lets Live Agent users create standard messages, such as greetings and answers to common questions, which agents
can easily insert into chat sessions.

To set up Quick Text:

1. Optionally, customize Quick Text settings.
2. Grant permissions to users so that they can create Quick Text messages.
3. Create Quick Text messages.
4. Give agents access to the Quick Text sidebar in the Live Agent console.

Customizing Quick Text Settings

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To customize Quick Text:

Quick Text lets Live Agent users create standard messages, such as greetings and answers to common questions, which agents
can easily insert into chat sessions.

By customizing Quick Text, you make it more useful to your Live Chat agents, and can add fields, categories, triggers, and
rules that support your business’ needs. You can do any of the following to customize Quick Text:

• “Customize standard fields” in the online help, create custom fields (such as categories and subcategories relevant to your
company’s Quick Text messages), and define field dependencies to associate categories and subcategories.

• Create validation rules.
• Define Apex triggers.
• Customize, create, and assign page layouts.
• Customize search layouts.
• Customize buttons and links.
• Create record types.

Creating Quick Text Messages
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Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create,” “Read,” “Edit,” and “Delete” on Quick TextTo create Quick Text messages:

1. Click the Quick Text tab.
2. Click New.
3. If you have more than one Quick Text record type, select a record type for the new message and then click Continue.
4. Type a message name.
5. Type the message. It can include line breaks, lists, and special characters, and can be up to 4096 characters long.
6. Select a category.
7. Optionally, select a subcategory.
8. Click Save.

Giving Agents Access to the Quick Text Sidebar in the Live Agent Console

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To set up Quick Text:

The Quick Text sidebar in the Live Agent console lets agents choose standard messages to include in their chats with customers.
To allow agents to use the sidebar:

• Give them “Read” permission on Quick Text
• Do one of the following:

StepsOption

Give agents ownership of at least one Quick Text message ◊ “Transfer ownership of existing Quick Text messages to
the agents” in the online help, or

◊ Have them create new messages

Change your organization-wide default sharing setting for
Quick Text 1. Click Your Name > Setup > Security Controls >

Sharing Settings.
2. In Organization-Wide Defaults, click Edit.
3. Select Public Read Only or Public Read-Write in the

Default Access dropdown list forQuick Text.
4. Click Save.

If you don’t want to change your organization-wide default
sharing settings, create sharing rules to specify which groups

Use sharing rules
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StepsOption

of users should have at least Read Only access to Quick Text
messages.

Case Feed
The future of case management is here! Case Feed introduces a new way of creating, reviewing, and updating cases, and is
designed for agents in fast-paced environments who interact with customers via multiple channels, including phone, email,
and portals.

Case Feed includes:

1. A customizable highlights panel that keeps the most important information about a case at the top of each page
2. A Chatter feed optimized for case management that lists updates made to a case
3. Publishers that let agents communicate with customers, log calls, write internal notes, and view details about cases, all from

within the feed
4. An Articles tool that makes it easy for agents to search for Salesforce Knowledge articles and attach them to cases or email

them to customers
5. The ability to filter case activities by type for a one-click view, such as a view of all emails associated with a case or all calls

logged on it
6. A list of case followers for an at-a-glance overview of other agents who are involved in resolving a customer’s issue

Implementation Tips
• Before you can enable Case Feed, you must enable Chatter and Chatter tracking on cases.
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• Once you’ve enabled Case Feed, you can assign it to users through permission sets or custom profiles.

Best Practices
• To boost support agent productivity, we recommend that you implement Case Feed along with other Service Cloud

features, such as the Service Cloud console and Salesforce Knowledge. Case Feed is designed to integrate easily with these
features to help your agents close cases quickly.

• We recommend that you customize many of the features in Case Feed to meet your company’s needs. For example, you
can create different feed and highlights panel layouts for agents and supervisors to show case information that’s important
for users in those roles.

Console Push Notifications
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Customize Application”To customize push notifications:

Note:  Push notifications are currently available through a pilot program. For information on enabling push notifications
for your organization, contact salesforce.com.

Do your support agents work off of a list or queue? Have multiple agents mistakenly worked on the same case at the same
time? Well, not any more. With Spring ‘12, Service Cloud Console users can see in real-time when a record they’re working
on has been updated by others. Visual indicators on lists and detail pages let console users know when a record or field has
changed. These indicators let users work with the most up-to-date information, and help prevent them from duplicating the
efforts of their teammates.

Administrators choose when push notifications display and which objects and fields trigger push notifications.

• Detail pages automatically refresh with updates or display notifications as dialog boxes when changes occur.

• Lists display notifications as:

1. Yellow when a record changes
2. Blue if it’s the last item you viewed
3. Bold and italic when a field specified by an administrator changes

• Notifications are cleared when you refresh your browser.
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The following objects and their fields are available for push notifications:

• Custom objects

• Cases

• Accounts

• Contacts

• Leads

• Campaigns

• Opportunities

To set up push notifications:

1. Click Your Name > Setup > Create > Apps.
2. Select a Service Cloud console app.
3. Click Edit.
4. In Choose How Lists Refresh, select when push notifications occur:

DescriptionOption

Lists don’t refresh. Push notifications don’t occur.None

The entire list refreshes when there are any changes to it.
Records are added to or removed from the list based on the
list’s criteria.

Refresh List

Rows in the list refresh when there are any changes to fields
specified for push notifications.

Refresh List Rows

5. In Choose How Detail Pages Refresh, select when push notifications occur:

DescriptionOption

Detail pages don’t refresh. Push notifications don’t occur.Do Not Refresh

The detail page automatically refreshes when a record is
changed.

Automatically Refresh

A message appears on the detail page when a record is
changed.

Flag

6. Click Select objects and fields for notifications.
7. Click Edit.
8. Select the objects you want to trigger push notifications. For example, if you want changes to cases and case fields to trigger

push notifications, move Cases from Available Items to Selected Items.
9. Under Fields, click Edit to select the object fields you want to trigger push notifications.
10. Click OK.
11. Click Save.
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Salesforce Knowledge Enhancements
Available in: Enterprise, Unlimited, and Developer Editions

Knowledge is most powerful when it’s shared. With Spring '12, Salesforce Knowledge provides a set of features that let users
collaborate on Knowledge articles and author new articles without leaving the case they’re working on. We’ve made it easier
to publish articles, too: authors can now publish important new information even before it’s validated.

Validation Status Field

User Permissions Needed

“Customize Application”

AND

“Manage Salesforce Knowledge

To create or change validation status picklist values:

A new field has been added to Salesforce Knowledge articles that allows users to select the level of confidence they have in
the accuracy of an article. When you activate the field on the Knowledge Settings page, users can select values to show whether
the content of the article has been validated. Your organization can create a picklist with values that show the state of the
article in the article publication lifecycle. For example, values in the article lifecycle could be Validated, Needs Review,
or Not Validated.

Note: Validation status picklist values aren’t retained when you export articles for translation. Articles with picklist
values can be imported, however, and their values are retained as long as the values exist in your organzation.

To create a Validation Status picklist:

1. Click Your Name > Setup > Customize > Knowledge > Validation Statuses.
2. On the picklist edit page, click New to add new values to the validation status field. You can also edit, delete, reorder, and

replace picklist values. When you replace a picklist value, the system replaces it in all versions of the article, including any
archived versions.

3. Add one or more picklist values (one per line) in the text area.
4. To set the value as the default for the picklist, be sure to select the Default checkbox.
5. Click Save.

Agent-Authored Knowledge
With Spring '12, agents can create articles from more places and get articles approved and published more easily. Improvements
include:

• A streamlined process for submitting articles for approval and publishing with fewer clicks. If users have the “Publish
Articles” permission and an approval process is set up for an article, they'll see both Publish... and Submit for Approval
buttons when they create or edit an article. If a user doesn’t have publishing rights, he or she can still submit articles for
approval.

• A new Salesforce Knowledge setting that allows users to create and update Knowledge articles from more places including
the Articles related list on Case records and the Articles tab.

• A new Salesforce Knowledge setting that lets users create an article from a case using one of two options:
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◊ Create articles using the simple editor only when closing cases.
◊ Create articles using the standard editor any time a user creates an article. Make sure that users have “Manage Articles,”

“Read,“ and “Create” permissions.

For more information, see “Customizing Salesforce Knowledge Settings” and “Managing Articles and Translations” in the
online help.

Knowledge Actions (Pilot)
When knowledge actions are enabled, you can use them to link article types to specific workflow article actions, such as
publishing. For example, if you want to have each FAQ published as a new version each time it completes the approval process,
you can create a knowledge action that links the FAQ article type to the Publish as New action. Then, when you create
an approval process for FAQs, select the new knowledge action. You can also use Knowledge actions to automatically publish
imported articles. For information about enabling Knowledge Actions for your organization, contact salesforce.com.

Article Versioning

User Permissions Needed

“Manage Articles”

AND

“Create,” “Read,” “Edit,” or “Delete” on the article type

To create, edit, or delete articles:

“Manage Articles”

AND

“Create,” “Read,” “Edit,” and “Delete” on the article type

To publish or archive articles:

“Manage Articles”

AND

“Create,” “Read,” and “Edit” on the article type

To submit articles for translation:

Permissions vary depending on the approval process settingsTo submit articles for approval:

Your business is growing quickly, and so are the versions of your articles! Now, you can keep previous article versions and keep
track of which version has been communicated to your customer. Article versions allows you to save an older version of a
published article and then see which version of the article is associated with a case. To save the previous version, select the
Flag as new version checkbox when publishing a new version. The previously published version is saved and the new
version is published with the next sequential version number as an identifier.

When an article is attached to a case and a new version of the article is published, the system identifies the version attached
to the case as being outdated. For example, if Version 2 is attached to a case and a third version is published, the article attached
to the case becomes Version 2 (outdated). This notation ensures that there is a permanent record of which content was
associated with the case.

When you click the version number in the Article View, you’ll see the Version History list. In the version history list you can:

• View the list of versions including draft, master, and archived versions.
• Click a version title to view that version of the article.
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By default, the system stores up to ten versions of an article, plus any versions that are attached to cases. Versions also appear
in custom reports, allowing you to find and read the article version attached to a case.

English-Only Spell Correction for Knowledge Search (Beta)
No more empty search result lists! With search spell correction, mistakes in your search keywords can still bring back results.
When you search for articles, Knowledge search suggests and searches alternate spellings for English search terms on the
Articles and Article Management tabs, in the articles tool in Case Feed, and in the Salesforce Knowledge sidebar in the Service
Cloud console. This setting applies to article searches via the API but not to article searches in global search.
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Article HTML Editor

 You asked for it! The Article HTML editor now addresses the following ideas on the IdeaExchange: add numbered
lists, add hyperlinks, format tables, remove links, add sub-bullets and sub-lists, clear formatting, and edit HTML source.

User Permissions Needed

“Manage Articles”

AND

“Create” and “Read” on the article type

To create articles:

“Manage Articles”

AND

“Read” and “Edit” on the article type

To edit draft articles:

“Manage Articles”

AND

“Create,” “Read,” and “Edit” on the article type

To edit published or archived articles:

The HTML rich text editor has been enhanced to let users create more effective and informative articles by leveraging the
power of HTML. When authoring an article with the HTML editor, users can:

• Add formatted tables
• Clear formatting and remove links from selected text
• View and edit the HTML source of content
• Use anchors to link to another place in the same article
• Specify that a hyperlink opens in a new browser window or a new tab

To enable the HTML rich text editor:

1. Click Your Name > Setup > Customize > Knowledge > Settings.
2. Click Allow users to create an article from a case.
3. Click Use the standard editor any time a user creates an article.
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Improved Navigation
Salesforce Knowledge has new navigation shortcuts from the Article detail page to the draft detail page for use when editing.
These shortcuts appear on the top left corner of pages, allowing users to quickly jump back to the Article management tab
from online/archive details pages and from translation details pages. In addition, link back to the case when searching for
articles from the Articles related list.

Additional Salesforce Knowledge Enhancements
• We’ve added a new icon for articles with draft versions. When an article is being edited a new icon indicates that there is

a draft version being edited.

•

 You asked for it! This enhancement is from an idea on IdeaExchange.
The search fields in the Articles Management tab now remember your search criteria, making it easier to search for
commonly used words or phrases.
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Additional Service Cloud Enhancements
Sharing Service Cloud Console Links

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Read” on the object in the linkTo share links in the Service Cloud console:

The Service Cloud console is designed for users in fast-paced environments who need to find, update, and create records
quickly. With Spring ‘12, working in the console just got faster. That’s because console users can open and share links to
console tabs. They can also add new console tabs in which to display links they’ve copied from within Salesforce. Want to
share a console link to a case and a Knowledge article with a support agent? Want to open a console link to a contact with a
call script and a service contact? Now you can with a few simple clicks.

•
To copy the URL of a tab in your Service Cloud console and send it to another user, click  and select  next to the
tab’s name. In the Link to Share dialog box, choose whether the URL includes only the selected tab or all of the tab’s
primary tabs and subtabs. If you’re sending the URL to a non-console user, choose to create a standard Salesforce URL.
Then, press CTRL+C to copy the URL. When you’re finished, click Close to close the Link to Share dialog box.

•
To add a new tab to your Service Cloud console in which to paste a URL you’ve copied, click . In the text box, press
CTRL+V to paste the URL; then click Go!. You can paste a console URL or a standard Salesforce URL into a new tab.

Custom–Branded Console

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“View Setup and Configuration”To view apps:

“Customize Application”To manage apps:

The Service Cloud console is designed for users in fast-paced environments who need to find, update, and create records
quickly. In Spring '12, you can brand your Service Cloud console apps by adding your logo to the apps’ headings. For example,
here's a Service Cloud console with a Force.com logo:

Before you can add a logo to a Service Cloud console, you must upload it to the document library (Documents tab). Note that:

• The image must be in GIF or JPEG format and less than 20 KB in size.
• If the image is larger than 300 pixels wide by 55 pixels high, then it will be scaled to fit.
• For the best on-screen display, we recommend you use an image with a transparent background.
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• The Externally Available checkbox must be selected on the document's properties so that users can view the image.

To add a logo to a Service Cloud console:

1. Click Your Name > Setup > Create > Apps.
2. Click Edit next to a Service Cloud console app.
3. Click Insert an Image to choose an image file from the document library.
4. Click Save.

For more information, see “Creating a Service Cloud Console App” in the online help.

Visualforce Console Components

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Customize Application”To add custom console components:

“Customize Application”To create Visualforce pages:

Console components let you customize, extend, or integrate the sidebars of the Service Cloud console using Visualforce.
Visualforce uses a tag-based markup language to give developers a more powerful way to build applications and customize the
Salesforce user interface.

For example, you might want to create custom console components that:

• Display custom highlights panels or interaction logs
• Show registered products on accounts or contacts
• Display the location of contacts on Google maps
• List new cases on accounts or contacts
• Display the next milestones on cases
• Show similar cases on each case

With Spring ‘12, you can extend custom console components to primary tabs. This lets you add components to new areas of
the user interface, such as the highlights panel and interaction log, if those items are turned off. It also lets you display
components across all of the subtabs in a primary tab instead of just individual subtabs.

For more information, see “Custom Console Components Overview” and “Adding Custom Console Components” in the
online help.

New Methods for the Service Cloud Console Integration Toolkit

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

The Service Cloud Console Integration Toolkit is an API that uses browsers to display pages as tabs in the console. It provides
advanced administrators and developers with programmatic access to the console so that they can extend it to meet your
business needs. For example, developers can use the toolkit to open and close tabs in the console to streamline a business
process.

With Spring '12, the following new methods are available.
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DescriptionMethod

Returns the object ID of the current primary tab, which
contains a subtab. For example, a case ID or account ID.

getEnclosingPrimaryTabObjectId()

Returns the object ID of the subtab on which the browser is
focused. For example, a case ID or account ID.

getFocusedSubtabObjectId()

Returns the attached data of a call represented by the call
object ID or null if there isn’t an active call. The data is
returned in JSON format.

getCallAttachedData()

Returns any active call object IDs in the order in which they
arrived or null if there aren’t any active calls.

getCallObjectIds()

Registers a function that is called when a call begins (comes
in).

onCallBegin()

Registers a function that is called when a call ends.onCallEnd()

Registers a function to call when the enclosing tab refreshes.onEnclosingTabRefresh()

Registers a function to call when the focus of the browser
changes to a different subtab.

onFocusedSubtab()

Resets a session timeout on a Visualforce page so that users
can continue working without being logged out.

resetSessionTimeOut()

Sends a message to the CTI adapter.sendCTIMessage()

For more information (English only) about the toolkit, see the Service Cloud Console Integration Toolkit Developer's Guide.

Custom API Fields for Answers (Questions and Replies)

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on questionsTo view the Answers tab:

“Create” on questionsTo ask and reply to questions:

“Read” on questionsTo vote for replies:

Answers is a feature of the Community application that enables users to ask questions and have community members post
replies. Community members can then vote on the helpfulness of each reply, and the person who asked the question can mark
one reply as the best answer.

With Spring ‘12, administrators and developers can add custom fields to questions or replies for API integration purposes
only. For example, add a custom text field to questions and use the API to populate that text field with the name of the country
from which each question is posted. Any custom fields you add to questions or replies can’t display in the Salesforce user
interface because questions and replies don’t have page layouts.

For more information, see “Answers Overview,” “Customizing Fields,” and “Which API Should I Use?” in the online help.
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Custom Lookup Fields for Replies

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create or change custom fields:

Answers is a feature of the Community application that enables users to ask questions and have community members post
replies. With Spring ‘12, administrators can add custom lookup fields to replies. Lookup fields let you link replies to other
objects, such as cases.

For more information, see “Answers Overview” and “Creating Custom Fields” in the online help.

Self-Service Portal Not Available to New Organizations
Starting in Spring ‘12, the Self-Service portal isn’t available for new organizations. Existing organizations continue to have
full access to the Self-Service portal.

New Field and New Requirement on Email-to-Case Auto-Response Rule Entries Page
Some Email-to-Case users have experienced an email loop when sending auto-response messages to customers who have
out–of–office notifications enabled. To address this issue, Winter ‘12 includes a new field on the rule entries page for
Email-to-Case auto-response rules. The new field, Reply-to Address, lets administrators specify the email address to
which any replies to your auto-response messages are sent.

In addition, there’s a new requirement for the Email Address field on the rule entries page: to prevent looping, this address,
which appears in the From line of your auto-responder, can no longer match your Email-to-Case routing address.

For more information, see “Creating Auto-Response Rules” in the online help.

Creating Cases Directly from Microsoft® Outlook®

Salesforce for Outlook users can now create cases directly from Outlook. To learn more about this feature and the setup
required, see Creating Cases Directly from Microsoft® Outlook® on page 34.
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Joined Reports—Generally Available
Available in: Enterprise and Unlimited Editions

Important:

Joined reports will be available in sandbox and production environments according to this schedule.

EnvironmentsDate

Preview sandbox: CS0, CS3, CS4, CS5, CS7, CS9, CS11, CS12, CS13February 7

Production: AP0, AP1, NA0, NA1, NA2, NA3, NA4, NA5,  NA6, NA7, NA8,
NA9,  NA10, NA11, NA12, NA14, EU0, EU1

February 12

Sandbox: CS1, CS2, CS6, CS8, CS10

This enhancement addresses an idea on IdeaExchange.

Joined reports let you view different types of information in a single report, so you create one report when, previously, you
would have had to create several. For example, with joined reports you can create a report comparing the number of support
cases that are new, closed, or in-progress by priority. Similarly, you can use joined reports to create a report containing each
of your organization’s deals, and the sales team members and products associated with each deal.

A joined report consists of up to five report blocks, which you add to the report to create multiple views of your data. For each
block, you can add regular and summary fields, create custom summary formulas, apply filters, and sort columns. You apply
groupings across all blocks in the report, and can add up to three groupings to the blocks, the same as for the summary format.

A joined report can contain data from multiple standard or custom report types. You can add report types to a joined report
if they have relationships with the same object or objects. For example, if you have a joined report that contains the Opportunities
report type, you can add the Cases report type as well because both have a relationship with the Accounts object.

When a joined report contains multiple report types, some fields are identified as common fields. A field is a common field if
it’s shared by all report types or if all report types share a lookup relationship to the field. These fields appear in the Common
Fields area in the Fields pane, and can be used to group report blocks. Some common fields have different names or appear

in different sections in different report types. In those fields, click  to see the name of the field in other report types.

ANALYTICS
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Considerations
Report builder is required to create or edit joined reports. Without it, you can only run joined reports. See “Upgrading Report
Builder” in the Salesforce online help for information on enabling report builder for your entire organization.
Joined reports require that the new user interface theme be enabled. Users without the new theme are unable to create, edit,
or run joined reports. See Enable New User Interface Theme in the online help.

Internet Explorer 6 is not supported for joined reports.

Working with Joined Reports

Available in: Enterprise and Unlimited Editions

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

To get started with joined reports, create a new or edit an existing report in report builder, click the Format drop-down, and
choose Joined.

Most of the things you can do with summary or matrix reports you can also do with joined reports. For example, you can find,
add, and remove fields; summarize fields; add custom summary fields; and run and save reports. See Working with Report
Builder.

Additionally, when working with a joined report, you can:

• Add up to 16 report types to the report.

• Add additional blocks to the report. A report can have up to 5 blocks.

• Add custom summary formulas to each block. You can add up to 10 to each block, and up to 50 for each joined report.

• Filter individual blocks using standard and boolean filters.

• Sort columns for each block, and hide or show details across blocks.

• Change the principle report type.

• Click Run Report to run the report. Note that the report is run in the joined report version of the run report page.

Watch a Demo on Building Joined Reports (3:19 minutes)

Currently, you can’t do the following with joined reports:

• Create a chart.
• Add bucketed fields.
• Add cross filters.
• Drag and drop filters from the Fields pane on to the Filter pane.
• Apply conditional highlighting.
• Schedule or export joined reports.
• Change the hierarchy for opportunity or activity reports.
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• Use a joined report as the data source for a dashboard.
• Create analytics snapshots based on joined reports.

Adding Blocks to a Joined Report

Available in: Enterprise and Unlimited Editions

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

Adding blocks to reports lets you create multiple views of the data included in a single report.

1. Select a field from the Fields pane and drag it to the empty area of the Preview pane.

2. Drop the field to create the block.
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When you’ve added the block, notice that standard and field filters for the additional block are added to the Filters pane
(1). Also, the new block appears in the Preview pane (2). Optionally, you can rename the block by clicking the block name
and entering a new name.

Note:  A block is also added to a joined report when you add a new report type to a report. See Adding Additional
Report Types to Joined Reports on page 83.

To remove a block, drag it to the Fields pane.

Adding Additional Report Types to Joined Reports

Available in: Enterprise and Unlimited Editions

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

Adding an additional report type lets you expand the set of data available for analysis in a joined report.

1. Select Joined from the report format menu.
2. Click Add Report Type.

The Choose an Additional Report Type overlay appears and displays the report types that you can add to the existing
report.

3. Select the report type.

The overlay displays a message that identifies the objects that are common to the selected report type and the types already
included in the report.

4. Click OK.

The additional report type is added. Notice that:

• A new block appears in the report.
• The Fields pane updates with a new area that contains fields unique to the report type. Fields common to all report types

are in the Common Fields area.

Running Joined Reports
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Available in: Enterprise and Unlimited Editions

User Permissions Needed

“Run Reports”To run reports:

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

Joined reports run in an updated version of the run reports page.

From the joined reports run page, you can:

• Click Run Report to run the report.

• Click Show Details to view all data or Hide Details to show only summary information.

• Click Customize to open the report in report builder.

• Save or delete the report.

• Click Report Properties to change a report's name, description, or folder.

• View the report generation status.

Joined Report Examples

Available in: Enterprise and Unlimited Editions

User Permissions Needed

“Run Reports”To run reports:

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

This topic provides you with some examples of the types of reporting you can do with joined reports.

Creating a Sales Rep Performance Scorecard
A sales rep scorecard lets your sales management team understand the performance and actions of your organization’s sales
reps. To create it, you need to have three separate custom report types, each of which creates a relationship between User (as
the primary object) and one of the following three objects: Opportunity Owner, Opportunity Creator, and Activity Owner.
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Note that, in this example, we’ve named the custom report types User and Opportunity Owner Custom Report,
User and Opportunity Creator Custom Report, and User and Activity Owner Custom Report.

Start by creating a new custom report based on the User and Opportunity Owner custom report type, and then add the User
and Opportunity Creator and User and Activity owner custom report types as two additional blocks. Then, group by Sales
Rep (opportunity owner) and set the filters as described in the procedure.

To create the report:

1. Create a new report, selecting User and Opportunity Owner Custom Report as the report type.
2. Select Joined from the Format drop-down.
3. Click Add Report Type.
4. Select User and Opportunity Creator Custom Report.
5. Click Add Report Type again, and choose User and Activity Owner Custom Report.
6. Group the blocks by Full Name.
7. Add additional fields and filters to the report as needed. For example, you might want to change the date filters to focus

on rep performance during a particular time frame. Or, to make sure that only sales people are included as opportunity
owners, create a filter on the Role: Name filter limit your results to users with “Sales” in their roles.

8. Optionally, provide names for the blocks.
9. Click Save or Run Report.

Reviewing Support Cases by Status
You can also create a report comparing the number of support cases that are new, closed, or in-progress by priority. The report
contains a single standard report type: Cases. First, create the report, add three blocks to the report, filter each block by the
appropriate status, and then use the Priority field for grouping.

To create the report:

1. Create a new report, selecting Cases as the report type.
2. Select Joined from the Format drop-down.
3. Remove unwanted fields by dragging them to the Fields pane, or click Remove All Columns to start from scratch.
4. Create three blocks, each containing the Case Number and Status and, optionally, Case Owner fields.
5. For each block, filter on all cases. Then, filter each of the blocks by Status as follows:

• Block 1: Status equals Closed

• Block 2: Status equals New

• Block 3: Status not equal to Closed, New, Closed in Portal, Closed — First Call
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6. Group the blocks by Priority.
7. Optionally, rename the blocks.
8. Click Save or Run Report.

Cross Filters—Generally Available
Available in: Enterprise and Unlimited Editions

Important:

Cross filters will be available in sandbox and production environments according to this schedule.

EnvironmentsDate

Preview sandbox: CS0, CS3, CS4, CS5, CS7, CS9, CS11, CS12, CS13February 7

Production: AP0, AP1, NA0, NA1, NA2, NA3, NA4, NA5,  NA6, NA7, NA8,
NA9,  NA10, NA11, NA12, NA14, EU0, EU1

February 12

Sandbox: CS1, CS2, CS6, CS8, CS10
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This enhancement addresses an idea on IdeaExchange.

Use cross filters to filter a report by an object's child objects using WITH or WITHOUT conditions. For example, filter a
report to show just accounts with cases, or contacts without activities. You can apply cross filters by themselves, or in combination
with field filters. Note that filter logic applies only to field filters—not cross filters. You can create up to three cross filters per
report.

Add subfilters to further filter by fields on the child object. For example, if you have a cross filter of Accounts with
Opportunities, click Add Opportunity Filter and create the Opportunity Name equals ACME subfilter to see just
those opportunities. You can create up to five subfilters for each cross filter.

Considerations
• Report builder is required to create or edit cross filters. Without it, you can only run reports with cross filters. See Upgrading

Report Builder for information on enabling report builder for your organization.
• Each report can have up to three cross filters.
• Each cross filter can have up to five subfilters.
• Adding cross filters can potentially slow down your report. To avoid having the report or preview time out, limit the data

returned by setting filters. For example, select My opportunities for Show and Current FQ for Range instead of
viewing all opportunities for all time.

• Since the objects available in cross filters depend on the parent object of the report type you choose, consider the related
child objects before selecting a report type. For example, choose the Accounts report type to filter on Accounts with
Partners because Partner is a child object of Account.

• Cross filters work in conjunction with your report type selection. Cross filters have an AND relationship with the report
type you select. Therefore, choosing a report type of Accounts with Partners and adding a cross filter for Accounts
without Partners will yield no results.

• Not all Opportunity Product fields are available in report filters. For example, the Product Family field is not available
in Opportunity Product report filters because it is related to that object through the Pricebook Entry object. To make the
Product Family field available in Opportunity Product report filters—for cross-sell or upsell reporting—create a custom
formula field to store its contents and use that formula field in your filter. Click Your Name > Customize > Opportunities
> Opportunity Products > Fields and create a custom field of type Formula, making sure to use Text for your formula
return type and TEXT(PricebookEntry.Product2.Family) for your formula.

Creating Cross Filters
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Available in: Enterprise and Unlimited Editions

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

Use cross filters to include or exclude records in your report results based on related objects and their fields. To create a cross
filter for your report:

1. In the Filters pane of report builder, click Add > Cross Filter.
2. Select a parent object from the drop-down list. Your choice determines which related objects you see in the child object

list.
3. Choose with or without.
4. Select a child object from the drop-down or search by its name. This drop-down list contains all eligible child objects of

your selected parent object.
5. Optionally add subfilters:

a. Click Add Your Related Child Object Filter.
b. Select a field. The fields are determined by the child object in the cross filter. For example, if your cross filter is

Accounts with Cases, you can use case fields for your subfilter.
c. Choose a filter operator.
d. Enter a value.

6. Click OK.

Example: Using WITH in Cross Filters
Let's say a recent campaign in California won you a lot of new customers. You want to ensure that their customer cases get
resolved quickly. You can create a report to see which of those accounts currently have cases:

1. Create a new report. For the report type, click Accounts & Contacts, select Accounts, and click Create.
2. In the report builder's Filters pane, set the appropriate standard filters.
3. Create a field filter where Billing State/Province equals CA and click OK.
4. Click Add > Cross Filter and specify Accounts with Cases.

When you click Run Report, the results will include only California accounts with an associated case.
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Example: Using WITHOUT in Cross Filters
Let's say that you've just imported a list of California accounts and you want to find which ones are missing contacts before
you assign owners:

1. Create a new report. For the report type, click Accounts & Contacts, select Accounts, and click Create.
2. In the report builder's Filters pane, set the appropriate standard filters.
3. Create a field filter where Billing State/Province equals CA and click OK.
4. Click Add > Cross Filter and specify Accounts without Contacts.

When you click Run Report, the results will include only California accounts without an associated contact.

Example: Using Multiple Cross Filters
Say you’re a salesperson who wants to see which customer accounts have unresolved problem escalations because you want to
ensure your support team takes care of them.

1. Create a new report. For the report type, click Accounts & Contacts, select Accounts, and click Create.
2. In the report builder's Filters pane, set the appropriate standard filters.
3. To limit your report to customer accounts, click Add > Field Filter and specify Type equals Customer.
4. To see which accounts have no activities, click Add > Cross Filter and specify Accounts without Activities.
5. To see only accounts without completed activities, add a subfilter to your cross filter:
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a. Click Add Activities Filter and specify Status equals Completed.
b. Click OK.

6. To include your accounts that currently have cases, add another cross filter but this time specify Accounts with Cases.
7. To exclude cases that were not escalated, add a subfilter to this cross filter:

a. Click Add Cases Filter and specify Type equals Problem.
b. Click Add Cases Filter again, but this time specify Status equals Escalated.
c. Click OK.

When you run the report, it will include only customer accounts without completed activities with escalated cases.

Data Bucketing—Generally Available
Available in: Enterprise and Unlimited Editions

Important:

Data bucketing will be available in sandbox and production environments according to this schedule.

EnvironmentsDate

Preview sandbox: CS0, CS3, CS4, CS5, CS7, CS9, CS11, CS12, CS13February 7

Production: AP0, AP1, NA0, NA1, NA2, NA3, NA4, NA5,  NA6, NA7, NA8,
NA9,  NA10, NA11, NA12, NA14, EU0, EU1

February 12

Sandbox: CS1, CS2, CS6, CS8, CS10

Bucketing lets you quickly categorize report records without creating a formula or a custom field. When you create a bucket
field, you define multiple categories (buckets) used to group report values. For example, create a bucket field named Size
based on the # Employees field. Then, create buckets that group records into “Large,” “Medium,” or “Small” ranges that
you define. Bucket fields can be used like any other field to sort, filter, and group your report.

Watch a Demo (3 minutes)
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Adding a Bucket Field

Available in: Enterprise and Unlimited Editions

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

You can add up to five bucket fields per report, each with up to 20 buckets.

To add a bucket field:

1. In the Fields pane of the report builder, double-click Add Bucket Field or drag it into the report preview. You can also
click a column menu for a field in the report and select Bucket this Field.

2. Edit the bucket field according to the field type.

• Editing Numeric Bucket Fields
• Editing Picklist Bucket Fields
• Editing Text Bucket Fields

Editing Bucket Fields

Available in: Enterprise and Unlimited Editions

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

1. In the report builder Fields pane under Bucket Fields, hover over a bucket field and click . Or in the Preview pane, click
the bucket field column menu and select Edit Bucket Field.

2. Edit the bucket field according to the field type.

• Editing Numeric Bucket Fields
• Editing Picklist Bucket Fields
• Editing Text Bucket Fields
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Editing Numeric Bucket Fields

Available in: Enterprise and Unlimited Editions

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

In the Edit Bucket Field overlay for a numeric field:

1. For Source Column, select the field you want to bucket.
2. Enter a bucket field name. This appears as the column name in the report.

Since a bucket field is intended to have multiple buckets (known as “ranges” in numeric bucket fields) within it, a good
name for a bucket field describes the scope of the ranges. For example, a bucket field named “Size” could have ranges of
“Small,” “Medium,” and “Large.”

3. Define your ranges by entering a number and a name. The range names appear as values in your new column.

Each range is greater than the lower number up to and including the higher number.

To remove all ranges and start over, click Clear All.

4. To move all empty values to the bucket containing the value zero, enable Treat empty source column values in
the report as zeros.

If this is disabled, unbucketed values appear as a dash (-) in the column.

5. Click OK.

In a report, numeric bucket columns are sorted by range values.

Numeric Bucketing Example: Deal Size

Available in: Enterprise and Unlimited Editions

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

To gain insight into your deals, use bucketing to group by deal size instead of looking at individual deals. This lets you
concentrate on the large deals that affect your quota the most.

1. Create or edit a standard opportunity report.
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2. In the Fields pane of the report builder, double-click Add Bucket Field or drag it into the report.
3. For Source Column, select Amount.
4. For Bucket Field Name, enter Deal Size.
5. Under Define Ranges, enter 1000 in the first row. This represents the maximum for a small deal. Name this range Small.
6. Click Add and enter 25000 in the second row. This represents the maximum for a medium-size deal. Name this range

Medium.
7. By default, the last range is any amount over the previous range. You don’t need to enter a number for this range. Name

this range Large.
8. Click OK.

With numeric bucket fields, each range is greater than the lower number, up to and including the higher number. Once you’ve
set up this bucket field, amounts will be bucketed as follows:

BucketAmounts

Small1000 or less

Medium1001 to 25000

Large25001 or more

Editing Picklist Bucket Fields
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Available in: Enterprise and Unlimited Editions

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

Note:  The following picklist types can’t be bucketed.

• Record types
• Divisions
• Multi-value picklists
• The Type picklist in Activity reports

In the Edit Bucket Field overlay for a picklist field:

1. For Source Column, select the field you want to bucket.
2. Enter a bucket field name. This appears as the column name in the report.

Since a bucket field is intended to have multiple buckets within it, a good name for a bucket field describes the scope of
the buckets. For example, a bucket field named “Priority” could have “High,” “Medium,” and “Low” buckets.

3. To create a bucket, click New Bucket and enter a bucket name. Create multiple buckets to group your report records.
4. To find a particular value in the list of values, type the first few characters of its name in the Quick Find box. As you type,

items that match your search terms appear in the menu.
5. Select values and drag them into a bucket. Alternatively, select values, click Move To, and select a bucket or enter a new

bucket name.

While you’re bucketing values, use these functions as needed:

• To show all the values in the report, click All Values.
• To show the values for a particular bucket, click the bucket name.
• To remove values from a bucket, select the values and drag them to another bucket, or drag them to Unbucketed

Values.

Note:  You can bucket only active picklist values. Inactive picklist values aren’t shown.

6. To move all unbucketed values into a bucket named “Other,” enable Show unbucketed values as “Other.” If this
is disabled, unbucketed values appear in the bucket column with the value name.

7. Click OK.

In a report, picklist bucket columns are sorted by the bucket position as shown in the Edit Bucket Field dialog box, followed
by “Other” if Show unbucketed values as “Other” is enabled, or the unbucketed picklist item names if Show
unbucketed values as “Other” is disabled.

Picklist Bucketing Example: Industry Types
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Available in: Enterprise and Unlimited Editions

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

1. Create or edit a standard accounts report, making sure at least a few records appear in the report.
2. In the Fields pane of the report builder, double-click Add Bucket Field or drag it into the report.
3. For Source Column, select Industry.
4. For Bucket Field Name, enter Industry Types.
5. Click New Bucket and name the bucket IT.
6. Click New Bucket and name the bucket Bio Tech.
7. Click New Bucket and name the bucket Telecom.
8. Select values and drag them into the appropriate buckets.
9. Enable Show unbucketed values as “Other.”

10. Click OK.
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Editing Text Bucket Fields

Available in: Enterprise and Unlimited Editions

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

Note:  The following text types can’t be bucketed.

• Text area
• Text area—long
• text area—rich
• text area—encrypted
• URL
• Date
• Date/Time

In the Edit Bucket Field overlay for a text field:

1. For Source Column, select the field you want to bucket.
2. Enter a bucket field name. This appears as the column name in the report.

Since a bucket field is intended to have multiple buckets within it, a good name for a bucket field describes the scope of
the buckets. For example, a bucket field named “Region” could have “East,” “West,” and “Central” buckets.

3. To create a bucket, click New Bucket and enter a bucket name. Create multiple buckets to group your report records.
4. To find a particular value in the list of values, type all or part of its name in the Search for values... box and click Search,

or leave the box empty and click Search.

The search returns up to 200 values.

5. Select values and drag them into a bucket. Alternatively, select values, click Move To, and select a bucket or enter a new
bucket name.

While you’re bucketing values, use these functions as needed:

• Use Enter Values to enter the exact name of a value you want to bucket, or to bucket values that may appear in your
report later.

• To show the values for a particular bucket, click the bucket name.
• To remove values from a bucket, select the values, select Move To, and select a bucket or enter a new bucket name.

6. To move all unbucketed values into a bucket named “Other,” enable Show unbucketed values as “Other.” If this
is disabled, unbucketed values appear in the bucket column with the value name.

7. Click OK.

In a report, text bucket columns are sorted in alphanumeric order.
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Entering Values for Text Buckets

Available in: Enterprise and Unlimited Editions

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

If you know the exact value you want to bucket, you can use the Enter Values function to quickly bucket it without searching.
This is useful if your report has a large number (such as millions) of values and searching for a value is slow. You can also use
this method to enter and bucket values that may appear in your report later.

In the Edit Bucket Field overlay for a text field:

1. Click Enter Values.
2. Select the bucket where you want to move the values. If you select New Bucket, enter a name for the bucket.
3. Type one or more values in the box. Enter multiple values on separate lines.
4. Click Move.

Text Bucketing Example: Strategic Accounts

Available in: Enterprise and Unlimited Editions

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

1. Create or edit a standard account report, making sure at least a few records appear in the report.
2. In the Fields pane of the report builder, double-click Add Bucket Field or drag it into the report.
3. For Source Column, select Account Name.
4. For Bucket Field Name, enter Strategic.
5. Click New Bucket and name the bucket IBM.
6. Click New Bucket and name the bucket Dell.
7. Click New Bucket and name the bucket HP.
8. To show the available values, leave the Search for values... box empty and click Search.
9. Select values and drag them into the appropriate buckets.
10. Enable Show unbucketed values as “Other.”
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11. Click OK.

Dashboard Enhancements
User Permissions Needed

“Run Reports” AND access to dashboard folderTo view and refresh dashboards:

“Run Reports” AND “Manage Dashboards”To create, edit, and delete dashboards:

In Spring ‘12, we’ve made numerous enhancements to dashboards. Now, you can create up to three filters per dashboard.
Additionally, filters are available for dynamic dashboards and users can post snapshots of filtered dashboards to Chatter and
dashboard feeds. We’ve also added additional fields and operators to dashboard filters. Read through the rest of this section
to learn more about enhancements to filtered dashboards as well as changes to the look and feel and functionality of all
dashboards. You can also watch a dashboards demo (3:20 minutes) that covers some of these features.

More Filters per Dashboard

Available in: Professional, Enterprise, Unlimited, and Developer Editions

You asked for it! This enhancement is from an idea on IdeaExchange.
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By giving you different views of the data contained in a dashboard, dashboard filters let you perform interactive analysis at the
dashboard level. Administrators can now create up to three filters for each dashboard. Previously, only one was available. The
additional dashboard filters give you more views of your data from a single dashboard.

There are some considerations when filtering dashboards.

• You can't add a filter to dashboards that contain Visualforce or s-control components.
• By default, you can add up to 10 options defined by operator and value for each filter. Contact salesforce.com if you want

to increase this limit. Note that a maximum of 50 per filter is supported.
• Scheduling or emailing a filtered dashboard returns unfiltered data.
• You can’t filter on bucket fields.

Filtered Dynamic Dashboards
Administrators can create up to three filters for each dynamic dashboard. Filtering dynamic dashboards gives administrators
additional flexibility in creating dashboards. For example, an administrator can create an organization-wide sales scorecard
that contains sales rep and product filters. This allows individual sales managers to view their reps’ performance collectively
as well as individually. It also lets them view sales by product to understand which products specific reps are or aren’t selling.

Administrators add filters to dynamic dashboards the same way as for standard dashboards and users apply filters to dynamic
dashboards the same as standard ones.

Filtered Dashboard Snapshots
Users can now post snapshots of filtered dashboard components to Chatter or dashboard feeds. When a user clicks the snapshot
title, they’re taken to the filtered view of the dashboard if the filters are still valid. If they aren’t they see the unfiltered dashboard.

Additional Fields and Operators for Filtered Dashboards
With Spring ‘12, you can filter on date, date/time, and currency fields in addition to picklist, lookup, and text fields.
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We’ve also added support for additional filter operators. Specifically, we’re introducing:

• Not equal to
• Less than
• Greater than
• Less or equal
• Greater or equal
• Contains
• Does not contain
• Start with
• Includes
• Excludes

With the additional operators, dashboard filters now support the same set of operators as report filters.

We’ve also introduced a new filter: “between.” Use the between operator to get results that are greater than or equal to a
minimum value and less than a maximum value. For example, if you enter “Number of Employees between 100 and 500,”
your results include accounts with 100 employees up to those with 499 employees. Accounts with 500 employees aren’t included
in the results. The between operator is available for dashboard filters only.

General Dashboard Enhancements

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Run Reports” AND access to dashboard folderTo view and refresh dashboards:

“Run Reports” AND “Manage Dashboards”To create, edit, and delete dashboards:

In Spring ‘12, we’ve made several enhancements to the look and feel and functionality of dashboards.

We’ve made these changes to the dashboard view page:
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• Dashboard filter drop-downs now appear beneath the dashboard finder. Previously, the filter drop down appeared beneath
the running user information. Additionally, you can have up to three filters per dashboard.

• When you refresh a dashboard, spinners now appear in the upper right corner on each component, and display until the
component is refreshed fully. Previously, during a refresh, we simply displayed the message “Refreshing dashboard” beneath
the running user information.

• The date and time that the dashboard last refreshed displays next to the Refresh button. Previously, it appeared above the
running user information.

• The running user label has been simplified: it now says “Viewing As: (running user).” Previously, the label was “Viewing
dashboard as: (running user).”

We’ve made these changes to the dashboard finder:

• We’ve added the “Recently Viewed” category to the finder results. “Recently Viewed” contains the dashboards that you’ve
viewed most recently and match the search criteria. The category contains up to five dashboards.

• Previously, dashboard finder was disabled for users with access to more than 20,000 dashboards. This limitation has been
removed.

• Previously, the dashboard finder was disabled for Internet Explorer 6 users with access to more than 1000 dashboards.
This limitation has also been removed.

• The ghost text has been simplified: it now says “Find a dashboard...” instead of “Type here to search for a dashboard...”

We’ve made one change to the dashboard edit page: we’ve replaced the Add Filter link with an Add Filter button.

Additionally, auto-follow has been enabled for dashboards so that now, when you create a new dashboard, you automatically
follow it in Chatter.

Dashboard Component Snapshot Enhancements

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

In Spring ‘12, we’ve enhanced the display of dashboard components that are posted to dashboard, user, and group feeds. Now,
each snapshot has a “Viewing As” label that identifies the user whose data you’re viewing. For example, if you share a component
from a dashboard generated by your co-worker, you’ll see her name in the View As: label.

Additional Analytics Enhancements
Also to note in Spring ‘12 are these additional analytics improvements:

• All Items Search in the Reports Tab

• Custom View in the Reports Tab

• Deleting Report Filters with Filter Logic
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• Increased Report Filter Limits

• Drag-and-Drop Report Filters

• Mobile Dashboards App for the iPad Widely Available

All Items Search in the Reports Tab

You asked for it! This enhancement is from an idea on IdeaExchange.

Available in: All Editions except Database.com

User Permissions Needed

“Run Reports”To view the Reports tab:

We’ve expanded the scope for search on the Reports tab. Now, search finds reports and dashboards across all folders in the
folder tree. When you type in the search box or select a folder, the list view filters change to all items and types.

Custom View in the Reports Tab

Available in: All Editions except Database.com

User Permissions Needed

“Run Reports”To view the Reports tab:

Personalize your view of dashboards and reports in the Reports tab. Resize, reorder, sort, or choose the columns in your view.

To resize a column, click and drag its right margin to the preferred size. Hide a column by clicking  > Columns and
deselecting the column you don’t want displayed. Action and Name can’t be deselected from view but can be reordered. You
can reorder a column by dragging it to where you’d like it to appear.
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Deleting Report Filters with Filter Logic

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

When you remove a filter, it’s crossed out in the filter list, and you must remove the filter’s number and operator from the
filter logic. For example, let’s say you have a list of filters with the filter logic “1 AND 2 AND (3 OR 4) AND 5”. If you
remove the fourth filter, you’ll see it crossed out in the list, and you must remove “OR 4” in the filter logic.

Once you click OK, the filter logic and list of filters automatically adjust sequentially.

Increased Report Filter Limits

You asked for it! This enhancement is from an idea on IdeaExchange.

Available in: All Editions except Database.com

We’ve increased the limit for the number of field filters across all editions on a report. In Spring ‘12, a report can have up to
20 field filters.

This increase may affect your reports and dashboards in a couple of ways:

• The report wizard has a limit of 10 field filters for all editions. If you use the wizard to edit a report with more than 10
filters, additional filters are dropped and any filter logic displays an error.

• Dashboard filters count against the report filter limit. For example, if a dashboard uses source reports that have 20 filters,
those components show errors when a filter is applied on the dashboard. To avoid this, reduce the number of filters in
those source reports.
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Drag-and-Drop Report Filters

You asked for it! This enhancement is from an idea on IdeaExchange.

Available in: All Editions except Database.com

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

Starting in Spring ‘12, you can add field filters to a report by drag-and-drop. In report builder, simply drag a field from the
Fields pane to the Filters pane.

Mobile Dashboards App for the iPad Widely Available

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

Salesforce Mobile Dashboards, a free download from the Apple App Store and AppExchange, is now available in most editions.

Aside from editions noted, the app is available to organizations enabled with REST API.
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Chatter for Android Tablets Generally Available
Available in: All Editions except Database.com

Now you can collaborate in Chatter from your Android tablet! Chatter for Android Tablets keeps you connected to the people
and records that matter most, whether you’re in the office or on the road. Use it to:

• View updates about the people, groups, and records you follow

• Create posts (with photos) and add comments

• View documents and links shared by others

• Find and follow people in your organization

• Find and join groups in your organization

• View coworkers' profiles, and email, call, or text them directly

Chatter for Android Tablets FAQ

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

• How do I get started using Chatter for Android Tablets?

• How do I connect Chatter for Android Tablets to different instances of Chatter or Salesforce?

• What OS versions does Chatter for Android Tablets support?

• How do I post and comment in Chatter for Android Tablets?

• Can I send private Chatter messages from Chatter for Android Tablets?

• Can customer users use Chatter for Android Tablets?

• How do I filter Chatter updates to see only those that mention me in Chatter for Android Tablets?

• How do I refresh a feed in Chatter for Android Tablets?

• How do I search for people and groups in Chatter for Android Tablets?

• Does Chatter for Android Tablets have status bar notifications?

• Does Chatter for Android Tablets have a widget?

How do I get started using Chatter for Android Tablets?

Download the Chatter Android tablet app directly to your tablet from the Android Market. Before users can log into the
Chatter Android tablet app, an administrator must:

MOBILE
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1. Log into Salesforce or Chatter through a Web browser.
2. Click Your Name > Setup > Mobile Administration > Chatter Mobile > Settings.
3. Enable Chatter for your organization.
4. Select Android under Authorized Devices.
5. Click Save.
6. If your organization restricts login IP ranges, click Your Name > Setup > Mobile Administration > Chatter Mobile >

IP Restricted Users and specify the users and groups that need to access the Chatter Android tablet app outside of your
organization's login IP range.

Restart the Chatter Android tablet app if configuration changes in Salesforce do not appear on your tablet.

How do I connect Chatter for Android Tablets to different instances of Chatter or Salesforce?

To connect to another instance of Chatter or Salesforce:

1. If you're logged in to Chatter Android tablet app, log out and relaunch it. The Login screen appears.

2. Tap , then Change Server.
3. Tap Add Connection.
4. Enter a name for the connection, such as Sandbox.
5. Enter the URL you use to log in to that instance.

Important:  The URL you enter must start with https://.

6. Tap Apply. The login screen appears.
7. Enter your user name and password, and follow the prompts.

What OS versions does Chatter for Android Tablets support?

The Chatter Android tablet app runs on Android tablets with OS version 3.0 and higher. If you install the Chatter Android
tablet app on a tablet with OS version 2.2, the tablet launches the Android Chatter phone app instead.

How do I post and comment in Chatter for Android Tablets?

To post to a feed, navigate to the feed and tap . To comment on a post, navigate to the post and tap .

When posting, tap  to select from the photos on your device, or  to take a picture to attach to the post.

Can I send private Chatter messages from Chatter for Android Tablets?

The Chatter app for Android tablets doesn't currently support private Chatter messages.

Can customer users use Chatter for Android Tablets?
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Yes, customer users can use the Chatter Android tablet, but they can’t access all of its functionality.

How do I filter Chatter updates to see only those that mention me in Chatter for Android Tablets?

Tap  to display both posts others make to your Chatter profile and updates that mention you.

How do I refresh a feed in Chatter for Android Tablets?

The Chatter Android tablet app refreshes automatically every few minutes when you’re online. You can also manually refresh

feeds by tapping .

How do I search for people and groups in Chatter for Android Tablets?

To search for people, tap , then .

To search for groups, tap , then .

Does Chatter for Android Tablets have status bar notifications?

The current version of the Chatter Android tablet app does not have status bar notifications, but future releases will.

Does Chatter for Android Tablets have a widget?

Yes, the Chatter Android tablet app has a widget that you can add to your tablet home screen the same way you add widgets
for other apps.

Salesforce Mobile for Android Phones—Generally Available
Available in: All Editions except Database.com

Salesforce Mobile is now generally available for Android phones! Use it to access your Salesforce data, tasks, and calendar
from your Android phone, even when you’re not connected to a Wi-Fi network. Salesforce Mobile for Android phones also
integrates with native Android features, allowing you to make calls, send email, and map addresses by tapping fields on
Salesforce records. Salesforce Mobile for Android phones also supports dashboards and Salesforce CRM Content.

See Salesforce Mobile for Android Phones FAQ for more information.

108

Mobile Salesforce Mobile for Android Phones—Generally Available

http://www.salesforce.com/docs/en/mobile/crm/android/1_0_0/index.html


Chatter for iPad v2.0 Generally Available
Available in: All Editions except Database.com

Chatter for iPad v2.0 is now generally available! The entire Chatter experience for the iPad has been redesigned to create a
sleek, intelligent way of keeping you connected to the people and records that matter most, whether you’re in the office or on
the road. With Chatter installed on your iPad, you can:

• View updates for the people, groups, and records you follow.

• Update your status.

• Create posts and add comments.

• Attach photos and files to Chatter posts.

• Mention people in posts and comments.

• View documents and links shared by others.

• Find and join groups in your organization.

• Find and follow people in your organization.

• View your coworkers' profiles to see their contact information, bio, the files they own, who they're following, and who's
following them.

• Initiate FaceTime calls and send emails and text messages to your coworkers.

Chatter for iPad is available for download in the Apple App Store. To use the Chatter app on your iPad, your device must be
running iOS 5.0 or higher, and it must be connected to a WiFi or cellular network. For more information about using Chatter
on your device, open the Chatter app on your iPad, then tap Settings > Help.

Note: Chatter for iPad v2.0 is a brand new app – not an upgrade of Chatter for iPad v1.5 – so current users of the
Chatter mobile app won’t see a pending update on their iPad. Current Chatter users should download the new Chatter
app from the App Store.

Chatter for BlackBerry Enhancements
Available in: All Editions except Database.com

Spring ‘12 includes several enhancements to the Chatter mobile app for BlackBerry devices. To use the new Chatter features
on your BlackBerry device, download the updated Chatter mobile app by visiting the BlackBerry App World.

BlackBerry Contacts Integration
Spring ‘12 provides seamless integration between Chatter and your BlackBerry contacts. As you use the Chatter mobile app,
your BlackBerry links contacts in the address book with people in Chatter if their email address and phone numbers match.
If you’re viewing a contact in the Contacts app and you see the Chatter menu option, the contact is linked to a Chatter user
record.

• To open a person’s Chatter profile from the Contacts app, select Chatter > View Chatter Profile.
• To post to someone’s Chatter profile feed from the Contacts app, select Chatter > Post to Chatter Profile.
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Enhanced Navigation
As of October 2011, Chatter has an improved user interface that makes navigating the BlackBerry app even easier. The tabs
along the top of the screen were moved to a navigation menu. The navigation menu lets you access common Chatter features,
like your Chatter feed, messages, lists, the @ Me filter, and search. Select the Chatter icon in the upper left corner of the app
to open the new navigation menu.

As with most BlackBerry apps, you can press the physical menu button on your device while using Chatter to open a menu
containing context-sensitive options related to the current screen.

Chatter Private Messages
As of October 2011, you can have secure conversations directly in Chatter. They're a fast, convenient way to communicate
privately with a few select people when the discussion isn't relevant to everyone you work with.

Private messages are available in the Chatter mobile app for BlackBerry. To access messages in the BlackBerry app, select
Chatter > Messages. From the Messages page, you can:

• See the most recent message in each of your conversations. The most recent message displays at the top of the list.
• See if you have unread messages. Conversations with unread messages are highlighted in blue.
• Select any message to view the full history of messages exchanged in that conversation. After selecting a message, you can

reply to it, delete it, or view the profile of the person who sent it by using the options on the main menu.
• Send a new message.

To send a new message:

1. Select Chatter > Messages.
2. Press the menu key and choose New Message.
3. Search for a person and select their name in the People list.
4. To add additional recipients, select the To field.
5. Write your message.
6. Select Send.

Tip:  You can also select  on someone’s profile to send them a message.

Note: Chatter Messages aren't currently available in the Chatter mobile apps for Android, iPad, iPhone, or iPod
Touch.

Support for BlackBerry OS 7.0
As of October 2011, the Chatter mobile app for BlackBerry is compatible with BlackBerry devices running OS 7.0.

BlackBerry Messenger Integration
As of October 2011, the mobile app is integrated with BlackBerry Messenger (BBM), the instant messenger application
included on BlackBerry devices. With the Chatter mobile app connected to BlackBerry Messenger (BBM), users can easily
share information in Chatter with their BBM contacts who also use Chatter. The Chatter mobile app can also update users’
BBM profiles with their latest activities in Chatter.

1. Visit the BlackBerry App World from your device and upgrade to the latest version of BlackBerry Messenger. The minimum
requirement is BlackBerry Messenger 6.0.
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If you’ve never used BlackBerry Messenger, complete the BBM setup process on your device before attempting to connect
Chatter to BBM.

2. Visit the BlackBerry App World from your device and upgrade to the latest version of Chatter. The minimum requirement
is Chatter 3.0.

3. Go to the BlackBerry Settings screen for Chatter, select the Connect Chatter to BBM option, then save your changes.
4. Open the Chatter mobile app.
5. When prompted to connect Chatter to BlackBerry Messenger, select Connect, then select Edit Settings.

The prompt only displays if you’re using BlackBerry Messenger 6.0 or higher.

6. In the Connect to BBM drop-down list, select Connected.
7. Optionally, select the Post recent activities to my profile checkbox to let Chatter update your BBM status

with recent app activities.
8. Optionally, select the Ignore invitations to become a BBM contact checkbox to prevent other Chatter users

in your company from sending you BBM contact invites.
9. Press the menu key and select Close.
10. Select Save, then select OK.

To share information in Chatter with BBM contacts, navigate to the user profile, group profile, record, or file, press the menu
key, and select Share via BBM.

Chatter Push Notifications

 You asked for it! This enhancement is from an idea on IdeaExchange.

As of August 2011, Chatter for BlackBerry users can take advantage of push notifications to stay aware of important Chatter
activity. Push notifications are alerts that Chatter sends to the BlackBerry home screen when users aren’t using the app. The
Chatter for BlackBerry app uses push notifications to notify a user when someone posts on the user's profile, mentions the
user in a post, comments on the user's post, sends the user a message, and more.

To enable push notifications on a BlackBerry device:

1. Navigate to the BlackBerry Settings screen for third party applications and choose Chatter.
2. Select the Enable Chatter push notifications chekcbox.
3. Select Save from the menu.

Tip:  If you’re using BlackBerry OS 6.0 or higher, the push notifications on your home screen are links that open the
related item in Chatter.

You can also set up Chatter so that push notifications are delivered to your BlackBerry inbox. To enable push notifications in
the Messages app:

1. Navigate to the BlackBerry Settings screen for third party applications and choose Chatter.
2. Select the Send push notifications to my BlackBerry inbox checkbox.
3. Select Save from the menu.

To change the sound alert for push notifications on a BlackBerry device:

1. Navigate to the BlackBerry Settings screen for third party applications and choose Sounds and Ringtones,
2. Select Sounds for Selected Profile, then select Other Applications — Notifiers.
3. Choose Chatter.
4. Adjust the sound alert settings, then select Save from the menu.
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Note:

• Users can’t enable push notifications on the device if they were disabled by the administrator. To access your
organization's push notification settings, click Your Name > Setup > Mobile Administration > Chatter Mobile
> Settings.

• Chatter push notifications aren't currently available in the Chatter mobile apps for Android, iPad, iPhone, or iPod
Touch.

Salesforce Mobile SDK
The Salesforce Mobile SDK is an open source suite of developer technologies that simplify the development of mobile
applications.

The Mobile SDK provides the following:

• Native OAuth implementations for Android and iOS that work out-of-the-box

• OAuth access token management, including persistence and refresh capabilities

• App containers for building hybrid applications

Using the Salesforce Mobile SDK, you can create three types of mobile applications:

• Native — Native apps are coded using a mobile platform's native capabilities. Typically, these apps are more difficult to
develop, but they also offer the best performance. In this workbook, we show how to construct native applications for iOS
and Android.

• HTML5 — HTML5 apps are built using HTML5, CSS and JavaScript. These lightweight server-side pages typically
offer the most portability, but don't have access to native platform features. HTML5 apps aren't OS-specific, so the same
app will run on an iOS, Android, Windows Mobile, or other device.

• Hybrid — Hybrid apps use a JavaScript bridge in a native container to merge the portability of HTML5 with native device
capabilities, such as the camera or address book.

Because the Mobile SDK is new technology, with many rapid changes expected over the coming year, the most recent release
notes can be found at http://wiki.developerforce.com/MobileSDK.

Additional Mobile Enhancements
Windows Mobile CRM No Longer Available
Starting in Spring ‘12, the Windows Mobile CRM app is no longer available for organizations that don’t currently have active
Windows Mobile users.

112

Mobile Salesforce Mobile SDK

http://wiki.developerforce.com/MobileSDK


Data.com Overview
Available in: Contact Manager, Developer, Enterprise, Group, Professional, and Unlimited Editions

Watch a Demo (3:19 minutes)

Data.com is a leading provider of business information and data, combining 30 million crowd-sourced business contacts with
the Dun & Bradstreet database to deliver the best data source inside of Salesforce. Data.com Corporate is an upgrade product
that provides additional Dun & Bradstreet fields, including D-U-N-S Number, NAICS Code, NAICS Description, and
more. Starting December 16, 2011, all organizations purchasing Data.com will get the Data.com Corporate product.
Organizations using versions purchased prior to that date will have a limited set of fields.

Note:  Prior to the Winter '12 release of Salesforce, Data.com was known as Jigsaw or Jigsaw.com.

Salesforce’s Data.com product includes prospecting features and clean features. This topic introduces them.

Within Salesforce, you can search for Data.com accounts and contacts, and if you have a Data.com license, you can add them
to Salesforce. You can add your contact search results as either contacts or leads. It's remarkably easy to find the accounts and
contacts you need, and using Data.com is a great way to plan your sales territories, segment campaigns, find new accounts to
engage, and get new contacts to quickly expand your sales network.

Go to the Data.com tab to search for accounts. Generate a broad list based on criteria like company name, industry, and
location. Then use filters to narrow your results based on number of employees, revenue, and more.

Need contacts in Salesforce? You can get them for a specific account, starting from the account record. Your search automatically
includes the company's website, but you can add criteria like name or email, location, and more on the Data.com tab. You can
also start from the Data.com tab, and select an account when you add contacts. Filters like Department and Title make it
easy to narrow your results and get a list you can work. Use phone or email to make connections right away, or add the records
to Salesforce as contacts or leads.

Want to analyze the impact of Data.com data on your business? Use theData.com Reports AppExchange package. It offers
eight preconfigured Data.com reports and a corresponding impact dashboard. Use these tools to find out how many records
are sourced from Data.com, who has added them and when, and how they contribute to your sales forecast and revenue.

Data.com Clean is an important part of Salesforce’s Data.com offering. You can use Data.com Clean to make sure your CRM
records are always up to date. Clean works for all the account, contact, and lead records you have access to in Salesforce—not
just those you previously added from Data.com.

Note: Data.com Clean is in beta for the Spring ’12 release.

DATA.COM
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Considerations for Using Jigsaw for Salesforce for Prospecting and Cleaning
If you’ve previously installed the Jigsaw for Salesforce AppExchange package (JFS), you can continue to use that product for
both prospecting and cleaning records. There are a number of limitations, however.

• JFS does not provide access to Dun & Bradstreet data, so if you want access to that data, you need to migrate to the
Data.com prospecting product built in to Salesforce.

• If you choose to use the clean features from JFS, as explained below, you should not participate in the beta program for
the Data.com Clean product built in to Salesforce for Spring ’12.

You can also use Data.com in Salesforce for prospecting and use JFS features to clean your records. Your approach depends on
whether you already use JFS or you’re installing it for the first time.

• If you already use JFS, you may need to reconfigure it for use with Data.com in Salesforce.
• If you don’t use JFS (but you do use the Data.com prospecting features built in to Salesforce) download and install the

Jigsaw for Salesforce AppExchange package and configure Salesforce to use its clean features.

Jigsaw for Salesforce is available in Developer, Enterprise, Professional, and Unlimited editions.

Data.com Prospecting
With the Spring '12 release, Data.com Prospecting offers a number of exciting enhancements.

• Thanks to a strategic new relationship, Data.com now includes data from Dun & Bradstreet (D&B). Starting on December
16, 2011, over 2.5 million of the company records you get from Data.com will include fields with key data sourced from
D&B. This major enhancement to the Data.com product means that a number of the fields on account and lead records
will get D&B values when the records are added to Salesforce.

You also have access to additional D&B fields with Data.com Corporate. This product provides additional fields, including
D-U-N-S Number, NAICS Code, Tradestyle, and more. Users will see them on account and lead records and the
account card, and if you use Data.com Clean (in beta release for Spring ‘12), you can clean the Data.com Corporate fields,
as well. (For more information on Data.com Clean, see Data.com Clean—Beta.)

• If you want to purchase additional Data.com licenses, now you can—right from the Data.com Licenses & Limits page.

• In addition to the exclusive D&B fields available from Data.com Corporate, we’ve also enabled several other fields on
account, contact, and lead records to accept Data.com data.

• Users can now assign an account when they add contacts to Salesforce from the Data.com tab. And if they need to create
an account at the same time, they can do that, too.

• The account card now has tabs that make it easier to use and provide additional information. The Data.com Contacts tab
lists contacts at the account by level and department. The Overview tab provides a detailed company description from Dun
& Bradstreet (when available). The Additional D&B Data tab shows the additional Dun & Bradstreet fields that come
with the Data.com Corporate product.

• We’ve also made other enhancements and updates. It’s easier to search for contacts now that we’ve separated the Title,
Name, or Email field into two fields: Title and Name or Email. Contacts and accounts both have a single, easier
to use Industry field that includes subindustry options. And when you convert leads, the value in the Lead Source
field updates the corresponding fields on the newly created contact and account records. We’ve also added a new Account
Source field on account records.
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Implementing Data.com

Available in: Contact Manager, Developer, Enterprise, Group, Professional, and Unlimited Editions

User Permissions Needed

“Customize Application”To implement Data.com:

“Manage Users”To enable Data.com users:

Implementing Data.com is easy. Here's what you need to know.

The free version of Data.com provides Data.com data to all users. Users can find the Data.com tab on the All Tabs page, or
you can add it for them.

With the free version, users can search for unlimited Data.com accounts and contacts. Free version users can't see phone and
email information for contacts, and they can't add records to Salesforce. To take full advantage of Data.com’s data, your
organization needs to purchase Data.com licenses and set up the feature.
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Data.com Clean is an important part of Salesforce’s Data.com offering. You can use Data.com Clean to make sure your CRM
records are always up to date. Clean works for all the account, contact, and lead records you have access to in Salesforce—not
just those you previously added from Data.com. Data.com Clean is in beta for the Spring ’12 release.

Organizations that purchase Data.com Corporate get additional account fields from Dun & Bradstreet, including D-U-N-S
Number, NAICS Code, NAICS Description, and more.

To implement Data.com, you need to:

• Understand Data.com licenses, limits, and products.

• Enable users for Data.com, assign type for each user, and assign record addition limits.

• Add the Data.com tab to user profiles.

• Add the Get Contacts button to your account page layouts.

• (Optional) Purchase additional Data.com licenses or record additions.

• If your organization uses Data.com Clean (beta for Spring ’12), add the Clean button and the Clean Status field to
your account, contact, and lead page layouts. You can also implement clean features from the Jigsaw for Salesforce
AppExchange package.

• If your organization uses Data.com Corporate, you’ll need to do a few additional customizations.

• Install the Data.com Reports AppExchange package.

Implementation Tips and Best Practices
• If a user adds more than 200 leads to Salesforce at one time, any lead assignment rules your organization uses won't run.

To make sure your lead assignment rules run, instruct your users to limit their additions to fewer than 200 leads at any
time.

• If your organization uses validation rules on fields that are mapped to Data.com, either deactivate the rules or make sure
they match Data.com field names to avoid errors when you add records. For example, if you have a validation rule for the
contact object's Home Phone field, you should create a custom field called Phone on the contact object and use that field
with your validation rule because the Data.com field is Phone.

• If your organization uses Data.com Corporate, and you create validation rules for the fields that Data.com Corporate
provides, those rules will still attempt to run even if you stop using Data.com Corporate, so disable any validation rules
using those fields if you stop using Data.com Corporate.

Setting Up Data.com Users

Available in: Contact Manager, Developer, Enterprise, Group, Professional, and Unlimited Editions

User Permissions Needed

“Customize Application”To implement Data.com:

“Manage Users”To enable Data.com users:

The All Data.com Users page shows all users, grouped by user type: Data.com User and Data.com List User.
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• Data.com Users get a limited number of records to add per month, and their unused additions expire at the end of each
month. For each Data.com User, you can see the monthly limit and number of records added to Salesforce or exported
during the month.

• Data.com List users share account, contact, and lead record additions from a pool. You can see the organization's limit,
and the number of records each Data.com List User has added to Salesforce or exported.

Enable each Data.com user on his or her User Edit page.

1. Click Your Name > Setup > Manage Users > Users, then click Edit next to the name of the user you want to enable.
2. In the Data.com User Type drop-down, select the user type.
3. For Data.com users, in the Monthly Contact and Lead Limit drop-down, select the number of contact and lead

records the user can add each month. You can select up to the organization limit for any user or all users, but once the
organization's monthly limit is reached, users won't be able to add more records.
For example, if your organization's monthly addition limit is 3000 records, you might assign one user a monthly addition
limit of 500 records, another user a limit of 1,000 records, and another user the organization limit (in this case 3,000
records). If the second user adds all 1,000 of his records right away, the third user will only be able to add up to 2,000
records, and depending on how many the third user adds, the first user may not be able to add any records.

Tip:  You can find your organization's monthly organization addition limit on the Data.com Licenses & Limits
page. Click Your Name > Setup > Data.com Administration > Data.com > Licenses & Limits.

4. Click Save to save the current record, or Save and New if you want to enable other users for Data.com.

Tip:  You can also enable Data.com users from the Apex Data Loader. To do so, you export your user records to
a .csv file, change the Data.com user permission for each user you want to enable, and then import the .csv file
into Salesforce. The fields to export from the User object are LastName, FirstName, and
UserPermissionsJigsawProspectingUser. Contact salesforce.com support if you need help.

The number of Data.com users you can enable—within Salesforce or via the Data Loader—depends on the number
of Data.com licenses you have purchased. Make sure you stay within that limit when enabling users via the Data
Loader.

Purchasing Additional Data.com Licenses

Available in: Contact Manager, Developer, Enterprise, Group, Professional, and Unlimited Editions

User Permissions Needed

“Customize Application”To implement Data.com:

“Manage Users”To enable Data.com users:

“Manage Billing”To use Checkout:

If you need to purchase additional licenses for Data.com Users, you can do so using Checkout, right from the Data.com
Licenses & Limits page. Just make sure you’re enabled to use Checkout. When your purchase is complete, you can assign
licenses to users if you need to.
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1. Click Your Name > Setup > Data.com Administration > Data.com > Licenses & Limits.
2. Click Purchase More and follow the steps.
3. (Optional) Assign the new licenses to users.

For detailed instructions on using Checkout, see the Checkout User Guide.

Additional Account Fields Now Enabled for Data.com Data
With the Spring ’12 release, we’ve enabled additional fields on account records to accept Data.com data.

Note: The Data.com Corporate product provides additional fields exclusive to Dun & Bradstreet that you can access
on account and lead records. Starting December 16, 2011, all organizations purchasing Data.com will get the Data.com
Corporate product. Organizations using versions purchased prior to that date will have a limited set of fields.

For complete details on all account fields, look up “Account Fields” in the Salesforce help.

DefinitionField

Information about the account’s location, such as single
location, Headquarters, or London. Up to 80
characters are allowed in this field.

Account Site

Description of account. Up to 32 KB of data are allowed in
this field. Only the first 255 characters display in reports.

Description

Fax number. Up to 40 characters are allowed in this field.Fax

Ownership of company, for example, public or private. Entry
is selected from a picklist of available values, which are set by

Ownership

an administrator. Each picklist value can have up to 40
characters.

Standard Industrial Classification code of the account’s main
business categorization. For example: 57340 for Electronics.
Up to 10 characters are allowed in this field.

SIC Code

Listing of company’s exchange and stock symbol, for example,
NASDAQ: ACME. Up to 20 characters are allowed in this
field.

Ticker Symbol

URL of account’s website, for example, www.acme.com. Up
to 255 characters are allowed in this field; only the first 50 are
displayed.

Website

Understanding Data.com Corporate
Users with Data.com licenses can search Data.com for account and contact records, and add them, as well as leads, to Salesforce,
then clean those records to keep them up to date.
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Now, thanks to a strategic relationship with Dun & Bradstreet, when a user adds a Data.com CRM record to Salesforce, or
cleans the record with Data.com data, the values in many of the record’s fields display Dun & Bradstreet data.

Note: Data.com Clean is in beta release for Salesforce Spring ’12.

Your organization can use Data.com Corporate, which provides additional Dun & Bradstreet account and lead data beyond
the basics, including D-U-N-S Number, NAICS Code, Tradestyle, and more. Starting December 16, 2011, all organizations
purchasing Data.com will get the Data.com Corporate product. Organizations using versions purchased prior to that date will
have a limited set of fields.

Tip: To find out whether your organization has Data.com Corporate, just click Your Name > Setup > Data.com
Administration > Data.com > Licenses & Limits. On the Licenses & Limits page, check the Data.com Licenses
section. If it says “Data.com Licenses - Corporate” you have the product.

Data.com Corporate Account Fields

DefinitionField

Data Universal Numbering System (D-U-N-S) number is a
unique, nine-digit number assigned to every business location

D-U-N-S Number

in the Dun & Bradstreet database that has a unique, separate,
and distinct operation. D-U-N-S numbers are used by
industries and organizations around the world as a global
standard for business identification and tracking. This field is
only available to organizations that use Data.com Corporate.

The six-digit North American Industry Classification System
(NAICS) code is the standard used by business and

NAICS Code

government to classify business establishments into 20
industries, according to their economic activity for the purpose
of collecting, analyzing, and publishing statistical data related
to the U.S. business economy. This field is only available to
organizations that use Data.com Corporate.

A brief description of an organization’s line of business, based
on its NAICS code. This field is only available to organizations
that use Data.com Corporate.

NAICS Description

A brief description of an organization’s line of business, based
on its SIC code. This field is only available to organizations
that use Data.com Corporate.

SIC Description

A name, different from its legal name, that an organization
may use for conducting business. Similar to “Doing business

Tradestyle

as” or “DBA”. This field is only available to organizations that
use Data.com Corporate.

The date when an organization was legally established.This
field is only available to organizations that use Data.com
Corporate.

Year Started
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Data.com Corporate Lead Fields

DefinitionField

Data Universal Numbering System (D-U-N-S) number is a
unique, nine-digit number assigned to every business location

Company D-U-N-S Number

in the Dun & Bradstreet database that has a unique, separate,
and distinct operation. D-U-N-S numbers are used by
industries and organizations around the world as a global
standard for business identification and tracking. This field is
only available to organizations that use Data.com Corporate.

Implementing Data.com Corporate
Data.com Corporate provides additional Dun & Bradstreet account and lead data beyond the basics, including D-U-N-S
Number, NAICS Code, Tradestyle, and more. Starting December 16, 2011, all organizations purchasing Data.com will
get the Data.com Corporate product. Organizations using versions purchased prior to that date will have a limited set of fields.

Tip: To find out whether your organization has Data.com Corporate, just click Your Name > Setup > Data.com
Administration > Data.com > Licenses & Limits. On the Licenses & Limits page, check the Data.com Licenses
section. If it says “Data.com Licenses - Corporate” you have the product.

Here’s how to implement this product.

• Make sure you’ve implemented Data.com.

• Identify the account fields provided by Data.com Corporate and add them to your account page layouts. For instructions
on adding fields, look up “Customizing Page Layouts” in the Salesforce help.

• Make sure that for all account fields provided by Data.com Corporate, field-level security is set to Visible. For instructions
on field-level security, look up “Setting Field Permissions in Permission Sets and Profiles” in the Salesforce help.

• Identify the lead fields provided by Data.com Corporate and add them to your lead page layouts. For instructions on adding
fields, look up “Customizing Page Layouts” in the Salesforce help.

• Make sure that for all lead fields provided by Data.com Corporate, field-level security is set to Visible. For instructions
on field-level security, look up “Setting Field Permissions in Permission Sets and Profiles” in the Salesforce help.

Finding and Adding Data.com Contacts from the Data.com Tab
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Available in: Contact Manager, Developer, Enterprise, Group, Professional, and Unlimited Editions

User Permissions Needed

No permissions requiredTo search Data.com for contacts:

“Create” on contactsTo add Data.com contacts:

“Create” on accountsTo create an account when adding contacts:

Want to search for contacts across multiple companies, locations, or industries? Start from the Data.com tab. If you add records
as contacts, you'll be prompted to associate them with a single account, so keep that in mind when you define your search.

Note:  You can also add Data.com contacts directly from an account. Just start your search from that account's detail
page.

1. Click the Data.com tab.
2. Click Find Contacts.
3. Enter or select your search criteria.
4. Click Search Data.com.

Your search results appear. They're sorted alphanumerically. If you've already added a contact (as a contact or a lead) to
Salesforce, you'll see an icon that tells you so: . You can't re-add that record.

Tip:

• Click the contact's name to see the “contact card”—a handy summary of contact information.
• To show records that have been flagged as inactive, under Options, select the Show Inactive Records

checkbox. Inactive records are marked with an icon: .

5. If the results list is long, you can:

• Sort the results by any table heading
• Jump to a page by entering a number in the Page field
• Click the arrows to move from page to page

Sorting and page navigation only work for lists of fewer than 100,000 records.

6. If you don't see what you're looking for, use filters to narrow your results. Expand filter categories as needed, and select
the checkbox next to each filter you want to apply.
The list is updated automatically

Tip:  If you want to start a new search, just click Reset Search to clear all of your search criteria and filters.

7. Sort the list if you need to.
8. Add all contacts or a selection to Salesforce.

• To add all contacts, click Add to Salesforce and select All.
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• To add selected contacts, first select the ones you want, then click Add to Salesforce and choose Selected.

You'll get a confirmation message showing the number of records you're adding.
9. Select Contacts.

Enter or select the account you want to associate the contacts with. You can associate only one account. If you need to
create the account to associate, use the lookup.

10. Click Continue.
11. Click Go to Account to go to the Accounts tab, where you can open the account record.

Exploring Data.com Accounts from the Account Card

Available in: Contact Manager, Developer, Enterprise, Group, Professional, and Unlimited Editions

User Permissions Needed

No permissions requiredTo search Data.com for accounts:

From a list of Data.com account search results, just click the name of any account and its account card appears. Use the account
card to research the company, get an overview of its business, or view a breakdown of its contacts. Key Dun & Bradstreet data
is available if you use Data.com Corporate.

Tip:  You can view the account card for any of your Salesforce accounts that exist in Data.com. Just do a quick search
for the account on the Data.com tab.

Here are your options.
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1. Get address and phone information plus a link to the account’s website.
2. View the account’s demographic and financial data.
3. Click an icon to research the account by searching Google, Yahoo Finance, or LinkedIn. If the account’s data comes from

Jigsaw, you’ll see an icon for Data.com and can search there.
4. Identify the source of the account information (Dun & Bradstreet or Jigsaw), and find out when the source’s information

was last updated.
5. Click the Data.com Contacts tab to see the account’s Data.com contact breakdown by level and department. Click a number

to find the account’s contacts at that level on the Salesforce Data.com tab.
6. Click the Overview tab to get a detailed company description from Dun & Bradstreet (if available).
7. If your organization uses Data.com Corporate, click the Additional D&B Data tab to view the additional Dun & Bradstreet

fields available with that product, including D-U-N-S Number and NAICS Code.

Note: You can’t see the entire D-U-N-S Number value for an account (on the comparison page or the account
card) until the account has been added to Salesforce from Data.com or (for existing records) cleaned with Data.com.
Until you add or clean the record, the number’s first five digits are masked with asterisks (*).

Additional Data.com Prospecting Enhancements

Separated Title, Name, or Email Field on Find Contacts Tab
On the Data.com tab’s Find Contacts tab, we’ve separated the Title, Name, or Email field into two fields: Title and
Name or Email. This change makes it easier to use search modifiers to get exactly the results you want.

Combined Industry Field on Find Contacts Tab
We’ve also combined the formerly separate Industry and Sub-industry fields on the Find Contacts tab. It has a single
Industry field that includes sub-industry options.

Combined Industry Field on Find Accounts Tab
We’ve combined the formerly separate Industry and Sub-industry fields on the Find Accounts tab. It now has a single
Industry field that includes sub-industry options.

Lead Conversion
When you convert a lead, the value from its Lead Source field affects the source fields on the contact and account records
that are generated from the conversion process. The contact’s Lead Source field will say Jigsaw and the account’s Account
Source field will be blank.

Account Source Field
Newly added to the account object, the Account Source field identifies the source of the account’s data. If the data comes
from Data.com, the field value will be Data.com. Make sure you add this field to your account page layouts. For instructions
on adding fields, look up “Customizing Page Layouts” in the Salesforce help.

Using Data.com Search Modifiers
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Available in: Contact Manager, Developer, Enterprise, Group, Professional, and Unlimited Editions

User Permissions Needed

No permissions requiredTo search Data.com for accounts:

No permissions requiredTo search Data.com for contacts:

When searching for Data.com accounts and contacts, you can use modifiers to target and narrow your search results. Here's
how modifiers work, field by field.

Company or Website
• To search for or exclude multiple companies, separate them with commas: ,. For example, salesforce.com,Apple

returns results for both salesforce.com and Apple (for example, Apple Computer, Inc. and Apple Inc.), or either one,
depending on Data.com data.

• To search for the exact name of a company, type the name within quotation marks: “ ”. For example, "Apple, Inc."
returns only results with the exact company name Apple, Inc.

• To exclude a company from your results, before the company name, type a minus sign: –. For example, –Oracle returns
a list of results that excludes Oracle. For company names with more than one word, after the minus sign, type the first part
of the name. For example, –Adobe returns a list of results that excludes Adobe Systems.

• You can also use mixed search modifiers. For example, salesforce, –Microsoft, “GE Healthcare” returns
all results including salesforce (for example, salesforce and salesforce.com, inc.); it excludes all results containing Microsoft;
and it finds GE Healthcare but not GE Health Care.

Title
• To exclude a title, before the title, type a minus sign: –. For example: –buyer.
• .
• To search for exact titles, type them within quotation marks: “ ”. For example: “Managing Director”.
• To search for multiple titles, separate them with commas: ,. For example: CEO,–Dr,“managing director”.

Name or Email
• To search for results for an individual element in this field—just Name or just Email—type that element followed by a

colon (:) and a space, then type the name, or email you're looking for. For example, Name: Marc Benioff returns
results with only the name Marc Benioff. Email: marcbenioff@salesforce.com returns results with only the
email address marcbenioff@salesforce.com. Modifiers will not work if you don't include “name: ” or “email: ”., and you
can't mix and match these modifiers (for example, using “name: ” and “email: ” in the same search).

• To search for multiple titles, names, or emails, separate them with commas: ,.
• To search for exact titles, names, or emails, type them within quotation marks: “ ”.
• To exclude a title, name, or email from your results, before the element, type a minus sign: –.

Location | ZIP Code
• To search for multiple ZIP codes, separate them with commas: ,. For example, 94105,94122 returns results for both

94105 and 94122, or either one, depending on Data.com data.
• To exclude a ZIP code from your results, before the ZIP code, type a minus sign: –. For example, –94122 returns a list

of results that excludes 94122.
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Location | Area Code
• To search for multiple area codes, separate them with commas: ,. For example, 312,708 returns results for both 312 and

708, or either one, depending on Data.com data.
• To exclude an area code from your results, before the area code , type a minus sign: –. For example, –708 returns a list of

results that excludes 708.
• To find area codes outside the United States and Canada, you need to add the country calling code as a prefix. For example,

the United Kingdom's country calling code is 44, and London's area code is 20, so to find accounts or contacts in London
by area code, you would enter 4420 in the Area Code field. Here's a list of country codes you might need to use.

◊ Australia: 61
◊ Brazil: 55
◊ India: 91
◊ Ireland: 353
◊ New Zealand: 64
◊ Singapore: 65
◊ South Africa: 27
◊ United Kingdom: 44

Data.com Clean—Beta
Data.com Clean is in beta for the Spring ’12 release.

Data.com Clean is an important part of Salesforce’s Data.com offering. You can use Data.com Clean to make sure your CRM
records are always up to date. Clean works for all the account, contact, and lead records you have access to in Salesforce—not
just those you previously added from Data.com.

Note: You can also use clean features available from the Jigsaw for Salesforce AppExchange package. For more
information, see Data.com Overview on page 113.
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Beta Limitations

In the Spring ’12 release, Data.com Clean does not allow system administrators to create and schedule automated jobs that
link individual Salesforce records to individual Data.com records and provide clean status information on account, contact,
and lead records. This means that a record’s Clean Status field may not be accurate unless the user manually cleans the
record.

Implementation Tips
For guidelines on implementing Data.com Clean, see:

• Data.com Overview on page 113

• Implementing Data.com on page 115

Cleaning Records with Data.com Clean
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Available in: Contact Manager, Developer, Enterprise, Group, Professional, and Unlimited Editions

User Permissions Needed

“Edit” on accountsTo clean account records:

“Edit” on contactsTo clean contact records:

“Edit” on leadsTo clean lead records:

Note: Data.com Clean is in beta for the Spring ’12 release.

Use Data.com Clean to make sure your CRM records are always up to date.

Clean works for all the account, contact, and lead records you have access to in Salesforce—not just those you previously added
from Data.com. Start from the record’s Clean Status field.

1. Check the record’s Clean Status field.
2. If the status is not In Sync, or if it’s been a while since an In Sync record was compared, click Clean to compare the

Salesforce record with Data.com’s.

Tip:  You can also get additional status information, and clean a record directly from the Clean Status field.
Just click the status icon and the popup will guide you.

3. Compare the two records side by side. You’ll see a check mark next to any Data.com field value that matches the
corresponding value in your Salesforce record.

4. Select the check box next to any Data.com value you want to accept.
5. Click Save when you’re satisfied that the record is accurate, even if you don’t accept any data from Data.com.

The Clean Status field reflects the record’s current status. If you click Cancel, the record’s status will not change. The
Clean Status field’s time stamp will be updated to reflect your activity.

Comparing Salesforce and Data.com Data at a Glance

Available in: Contact Manager, Developer, Enterprise, Group, Professional, and Unlimited Editions

Note: Data.com Clean is in beta for the Spring ’12 release.

When you clean a Salesforce account, contact, or lead record, you compare the data in your Salesforce record with data from
Data.com. Cleaning records is easier if you understand how to read and use the comparison page. Here’s what you’ll find there.

127

Data.com Data.com Overview



1. The columns present Salesforce and Data.com records side by side, so you can easily compare the data from each source.
2. Field names appear on the left. If a field is blank, that means the source (Salesforce or Data.com) has no data for that field.

Note:  Some account and lead fields are available only to organizations that purchase Data.com Corporate.

3. If your Salesforce data matches Data.com’s you’ll see a green checkmark ( ) for that field in the Data.com column.
4. If Data.com has data for a field that’s blank or different in Salesforce, you’ll see a checkbox. Select it to accept Data.com’s

data.
5. The Select All and Clear All links do just what they say.
6. Click Save when you’re satisfied that you have the data you want, even if you don’t make any changes. The Salesforce

record’s clean status will be updated to Reviewed or In Sync. Click Cancel if you decide not to compare the two
records. In that case, the Salesforce record’s clean status won’t change.

Note: You can’t see the entire D-U-N-S Number value for an account (on the comparison page or the account card)
until the account has been added to Salesforce from Data.com or (for existing records) cleaned with Data.com. Until
you add or clean the record, the number’s first five digits are masked with asterisks (*).

Understanding Data.com Clean Status

Available in: Contact Manager, Developer, Enterprise, Group, Professional, and Unlimited Editions

Note: Data.com Clean is in beta for the Spring ’12 release.

If you use Data.com, the Salesforce CRM records you have access to show a status message in the Clean Status field.
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To clean a record is to bring it up to date with the values you want—either accepting some or all of the latest values from
Data.com, or keeping all of the values in the Salesforce record. If a user has compared two records and opted to keep one or
more values from the Salesforce record, the record’s status is Reviewed. If the Data.com and Salesforce records are identical,
either before or after they’ve been compared by a user, the Salesforce record’s clean status is In Sync. Both Reviewed and
In Sync records are considered clean.

This table explains each clean status message and tells you how to clean records in other states (such as Not Compared and
Different).

How to Clean the Salesforce RecordDefinitionClean Status

Click Clean and compare the records
side by side.

If you want to keep all of the values in
the Salesforce record, click Save. The

Either the Salesforce record has never
been compared with any Data.com
record or the Salesforce record has been
edited and not compared again.

Not Compared

Salesforce record’s clean status changes
to Reviewed.

If you want to accept any or all of the
Data.com values, select the checkboxes
as appropriate, then click Save.

The Salesforce record’s clean status
changes to Reviewed and until:

• The two records are identical (In
Sync status)

• The record is updated in Salesforce
or Data.com (Different status)

• The record becomes inactive in
Data.com (Inactive status)

Click the icon in the Clean Status
field and check the time stamp to see

When your Salesforce record was last
compared with the Data.com record, the
two were identical. Records in In Sync

In Sync

when the record was last compared. If
status are considered to be clean, but you
can repeat the clean process.

it’s been a while, click Clean and see if
anything has changed. Clean the record
if you need to.

Click Clean and compare the records
side by side.

When your Salesforce record was last
compared with the Data.com record, the
user who compared them accepted one

Reviewed

Accept or skip Data.com values as
appropriate.

The Salesforce record will remain in
Reviewed status until:

or more field values from the Data.com
record and kept one or more values from
the Salesforce record. Records in
Reviewed status are considered to be
clean, but you can repeat the clean
process. • The two records are identical (In

Sync status)
• The record is updated in Salesforce

or Data.com (Different status)
• The record becomes inactive in

Data.com (Inactive status)
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How to Clean the Salesforce RecordDefinitionClean Status

Click Clean and compare the records
side by side. Accept or skip Data.com
values as appropriate.

The Salesforce record will remain in
Different status until:

The Salesforce record has different data
from the corresponding Data.com record.

Different

• The two records are identical (In
Sync status)

• A user reviews the two records and
keeps one or more values from the
Salesforce record (Reviewed status).

• The record becomes inactive in
Data.com (Inactive status)

The record can't be cleaned in Salesforce
because no Data.com record could be
associated with it.

The Salesforce record has no similar
records in Data.com record.

Not Found

You currently can’t clean records whose
status is Inactive.

The Data.com record corresponding to
the Salesforce record has been marked
inactive.

Inactive

Working with a Record's Data.com Clean Status

Available in: Contact Manager, Developer, Enterprise, Group, Professional, and Unlimited Editions

Note: Data.com Clean is in beta for the Spring ’12 release.

The Clean Status field on account, contact, and lead records shows you the record’s Data.com Clean status at a glance,
including when the status was last updated. But if you click the icon next to the status, you’ll get more status details, plus
options for refreshing the status. Depending on the status, you can also clean some records right from the Clean Status
field. Here’s an example that shows some of your options.

1. This record’s status is Different because when it was last compared, one week before, the records in Salesforce and
Data.com had different values for some or all of their fields. The user who compared the records previously may have
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accepted some values from Data.com or elected to keep all of the Salesforce data. Click the icon to view the popup, which
provides additional information and Clean options.

2. This line tells you about the Salesforce record’s most recent comparison activity.

In this case, a user compared the Salesforce account record with Data.com’s version one week ago.

3. This section provides more details about the comparison. In this case, Data.com had different Email, Phone, and Mailing
Address values for the contact. The user who compared the records previously may have accepted other values from
Data.com when he or she compared the records, or elected to keep all of the Salesforce data.

4. You can click the Clean... link to compare the Salesforce and Data.com records yourself. If you don’t accept any data from
Data.com, the record’s status will continue to be Different.
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APPFORCE

Force.com System Overview
Available in: All Editions except Personal Edition

User Permissions Needed

“Customize Application”To view the system overview page:

Note:  The system overview page shows only the items enabled for your organization. For example, your system
overview page shows workflow rules only if workflow is enabled for your organization.

Starting in Spring ’12, the system overview page shows usage data and limits for your organization, and displays messages
when you reach 95% of your limit (75% of portal roles). Click statistics to get more details about your usage. If it’s available,
use Checkout to increase usage limits for your organization. For example, if your organization reaches the limit for licenses,
the system overview page shows a notification. Click the link to clean up any unused licenses, or visit Checkout to increase
your limit for licenses.

The system overview page displays usage for:

• Schema
• API usage
• Business logic
• User interface
• Most used licenses
• Portal roles

Configuring Force.com System Overview Messages

FORCE.COM
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Available in: All Editions except Personal and Database.com

User Permissions Needed

“Customize Application”To configure Force.com messages:

Note:  The system overview page shows only the items enabled for your organization. For example, your system
overview page shows workflow rules only if workflow is enabled for your organization.

Add system overview usage messages to the Force.com home page to remind you when your organization approaches its limits.
You can expand, collapse, and dismiss the system overview messages that appear on the Force.com home page. The system
overview home page messages are not enabled by default.

To enable the system overview messages on the Force.com home page:

1. Click Your Name > Setup > System Overview.
2. Click Configure Force.com Messages.
3. Select the types of system overview messages to show on the Force.com home page.
4. Click OK.

Important:  System overview messages only appear on the Force.com home page when your organization approaches
its limits.

When you enable or dismiss system overview messages on the Force.com home page, it only impacts your individual view of
the system overview messages.

Visual Workflow Enhancements
Available in: Enterprise, Unlimited, and Developer Editions

Visual Workflow To Be Enabled for All Enterprise and Unlimited Editions
Starting with Spring ‘12, all new and existing Enterprise or Unlimited Edition organizations will have Visual Workflow
enabled automatically.

Cloud Flow Designer—Generally Available
With Spring ‘12, the Cloud Flow Designer is now generally available. The Cloud Flow Designer is native to Salesforce. With
it, you can create new flows and manage their content directly from the flow list and detail pages.

Flows in the Metadata API
You can now use the Metadata API to create, access, and edit cloud-based flows. For all the details, see the new Flow metadata
type in the Force.com Metadata API Developer's Guide.
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Flows in Change Sets and Packages
Flows created in the Cloud Flow Designer can now be included in change sets and in both managed and unmanaged packages.
For more information, see “Flows in Change Sets and Packages” in the online help.

Flow Version Limit Increased
We’ve increased the number of versions allowed for each flow to 50.

Flow Administrator Permission Change
Flow administrators no longer need the Force.com Flow User field enabled on their user detail page in order to run flows.
All you need is the “Manage Force.com Flow” permission.

Record Delete Element
Starting in Spring ’12, use a Record Delete element in the Cloud Flow Designer to delete one or many records, depending
on how you set your filter criteria.

Important:  Things to note when using a Record Delete element:

• Be careful when testing flows that contain Record Delete elements. Even if the flow is inactive, running it will
trigger the delete operation.

• To prevent deleting records by mistake, be as specific in your filter criteria as possible.
• Records are deleted from your organization the moment the flow executes the Record Delete element.
• Deleted records are sent to the Recycle Bin and remain there for 15 days before they are permanently deleted.

For more information, see “Adding and Configuring a Record Delete Element” in the online help.

Decision Element No Longer Boolean
The Decision element in the Cloud Flow Designer has been enhanced to handle multiple outcomes. You can now create many
outcomes and define discrete conditions for each. When you draw a connector from the Decision element to other elements,
you may then choose which outcome to assign to that connector.

Note: When you open a flow from Winter ‘12 that contains a Boolean decision, the old Decision element is converted
to the Spring ‘12 multi-outcome format. The Boolean outcomes from the old decision become a set of True and False
outcomes in the new Decision element.

For example, let’s say you have a Boolean decision from Winter ‘12 with the name “My Decision” and unique name
of “my_decision”. After the conversion, the new decision retains the name “My Decision” but the unique name is
appended with ”_switch”, becoming “my_decision_switch”. The new decision has two pre-configured outcomes: a
default outcome labeled “False”, and another outcome labeled “True” with the unique name “my_decision” and a set
of conditions migrated from the True outcome of the old decision.

Label Fields Now Rich Text
In the Cloud Flow Designer, anywhere you can create a label for a field, you can now customize the label using a rich text
editor.

Choices as Flow Resources
In Spring ‘12, choices and dynamic choices have become standalone resources. As a result, any choice option you create, either
directly within the Screen element or from the Resources tab, can be referenced and reused elsewhere in your flow.
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Global Constants
In any value or resource drop-down list in the Cloud Flow Designer, you may see a section called GLOBAL CONSTANT.
Global constants are system values that, depending on the context of the drop-down list, let you assign EmptyString, True,
or False as the value for that field.

For example, when creating a variable of type Boolean, if you click on the arrow button to the right of the Default Value
field and expand the GLOBAL CONSTANT section, you’ll see $GlobalConstant.True and $GlobalConstant.False.
However, when creating a variable of type Currency, the GLOBAL CONSTANT section isn’t available. Visibility of this
section depends on the data type of the resource you’re working with.

Cross-Object Workflow
Available in: Enterprise, Unlimited, and Developer Editions

 You asked for it! This enhancement is from an idea on IdeaExchange.

With Spring ‘12, cross-object field updates in workflow rules and approval processes now support standard objects. Both
custom-to-standard and limited standard-to-standard relationships are supported.

Custom Object to Standard Object
You can use cross-object field updates for custom objects that are children of certain standard objects in a master-detail
relationship. The standard objects which support cross-object field updates are:

• Account
• Asset
• Campaign
• Case
• Contact
• Contract
• Contract Line Item
• Entitlement
• Opportunity
• Order
• Question
• Quote
• Service Contract
• Solution
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Standard Object to Standard Object
You can now use cross-object field updates for standard objects that are children of standard objects in a master-detail
relationship. However, only a few standard-to-standard relationships are supported.

Case Comments updating Case and Email updating Case were supported previously. The new relationships that we’ve opened
up are:

• Opportunity Product updating Opportunity

Note:  Cross-object field updates to a parent opportunity's Amount and Quantity fields only work if the opportunity
has no opportunity products associated with it.

• Opportunity updating Account—Supported for both business accounts and person accounts.

Global Search Enhancements
Available in: All Editions except Database.com

Improved Search Results Relevancy
Continuing in Spring ‘12, Salesforce is improving relevancy in search results. The order of your search results might change
as a result of moving more popular matches higher in your list. These relevancy improvements also affect SOSL search results.

Smart Search

 You asked for it! Spring '12 addresses this idea on IdeaExchange.

With Spring ‘12, global search keeps track of which objects you use and how often you use them, and arranges the search
results accordingly. Search results for the objects you use most frequently appear at the top of the list. You can also pin important
objects to the top of your search results.

You might notice these changes in your search results:

• Search results are no longer listed alphabetically. Objects are ordered by how frequently you use them. You can change the
result order by pinning objects to the top of your results.

• Options... moved from under the header search box to next to the search box in the results page. Use these options to
restrict your search to items you own, if available; to exact phrase searches; and to divisions, if your organization uses them.

• If you previously clicked Options... to select the objects you want to search, you might see results for different objects. If
you’re missing an object, click Search All and pin any missing objects to the top of your search results.

• If you previously searched all objects, you might now have a search scope based on which objects you use most frequently.
Click Search All to expand your search, and pin objects to the top of your search results to keep them in your scope.

• If global search doesn’t have enough information about which objects you use, you see results for your previous saved scope
or for all objects until it has more information.

For more information, see Global Search Results.

Global Search Results
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Available in: All Editions except Database.com

Watch a Demo on Smart Search (2:12 minutes)

Your search results include items and tags that you have permission to view. Global search keeps track of which objects you
use and how often you use them, and arranges the search results accordingly. Search results for the objects you use most
frequently appear at the top of the list. If global search doesn’t have enough information about which objects you use, you see
results for your previous saved scope or for all objects until it has more information.

From this page you can:

1. Click Search Chatter Updates at the top left of the page to see Chatter posts and comments that include your search
terms.

On the Chatter updates results page, save a topic or search result to your favorites on the Chatter page by clicking Add to
Chatter Favorites.

2. Quickly see which items (ordered by most frequent use) were searched.

• Click any item to see only that item's results.
• Hover over and pin important items to the top of your results to manually change the order. You can always unpin

them later.

3. Click Search All at the bottom of the left side or under the related lists to do a one-time search across all items using your
current search terms.

After clicking Search All, you can pin items that don’t appear in your scope to the top of your search results. You can
always unpin them later.
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4. Use the search box in the page to search within your current view. For example, if you drill down to view Chatter Updates
and then decide to search Chatter for something different, enter your new search terms and click Search Chatter Updates
to search across all Chatter posts and comments.

5. Click Options... to restrict your search to records you own, if available, to exact phrase searches, and to divisions, if your
organization uses them.

6. Take a guided tour of the search results.
7. See up to five results for each item you searched.

• Click a result to open it or click Edit, if available.
• Click Show Filters, if available, to filter your search results.
• Click Show More to drill down to the full list of that item's results.

8. Drill down to a specific item's results, and then:

• Click Show Filters, if available, to filter your search results.
• Click My Columns to customize columns in your search results.
• (Administrators only) Click Customize... to customize filters and specify search results columns and column order for

all users' search results.

Visualforce Enhancements
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

Custom controllers and standard controller extensions are not supported in Group or Professional Editions.

Spring ’12 introduces several new features that enhance the capabilities of previous versions of Visualforce. For detailed
information on these new features, see the Visualforce Developer's Guide.

Visualforce Components for Chatter Answers

Spring ’12 introduces Chatter Answers, which integrates Cases, Answers, Force.com Sites, Customer Portal, and
Salesforce Knowledge to provide you with a Web community for your customers. When administrators enable Chatter
Answers, seven Visualforce components are automatically added to your organization so that you can set up and customize
communities. See Visualforce Pages for Chatter Answers in the Salesforce online help.
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Visualforce Components for Live Agent

Spring ’12 introduces Live Agent, which lets support agents chat with customers in a customized console within Salesforce.
Enabling Live Agent automatically adds eight Visualforce components to your organization so you can create and
customize chat windows. See Setting Up Live Agent in the Salesforce online help.

Visualforce Component for Chatter

Starting in Spring ’12, Salesforce provides the <chatter:newsfeed/>Visualforce component. The component displays
the feed updates on the Chatter tab of the user viewing the Apex page that contains the embedded
<chatter:newsfeed/> component.

The <chatter:newsfeed/> component offers different functionality than the <chatter:feed/> component. The
<chatter:feed/> component displays only the Chatter updates on a user’s profile page or a record’s detail page.

Visualforce Component for Social Accounts and Contacts

New in Spring ‘12, the Social Accounts and Contacts feature includes Visualforce for Social Accounts and Contacts.
This new <social:profileViewer/> component allows you to easily add the Social Accounts and Contacts viewer
to your custom account, contact, and lead detail pages. The viewer displays the record name, a profile picture for the
account, contact, or lead, the social network icons that allow users to sign in to their accounts from Salesforce, and the
popup that displays social data directly in Salesforce. See Social Accounts, Contacts, and Leads Overview in the Salesforce
online help.

Here are a few notes to help with implementing this component.

• It’s only available for custom account, contact, and lead detail pages and can only be used once on a page.

• It isn’t available for Visualforce pages on Force.com sites.

• Social Accounts and Contacts must be enabled to use it.

Dynamic Visualforce Components—Generally Available

Dynamic Visualforce is generally available in Spring ’12, with dynamic components now supported in production code
and managed packages.

Dynamic Visualforce components offer a way to create Visualforce pages that vary the content or arrangement of the
component tree according to a variety of states, such as a user’s permissions or actions, user or organization preferences,
the data being displayed, and so on. Rather than using standard markup, dynamic Visualforce components are designed
in Apex.

A dynamic Visualforce component is defined in Apex like this:

Component.Component_namespace.Component_name

For example, <apex:dataTable> becomes Component.Apex.DataTable.

Note:  The Standard Component Reference contains the dynamic representation for all valid Visualforce
components.

Visualforce components that are dynamically represented in Apex behave like regular classes. Every attribute that exists
on a standard Visualforce component is available as a property in the corresponding Apex representation with get and
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set methods. For example, you could manipulate the value attribute on an <apex:outputText> component as
follows:

Component.Apex.OutputText outText = new Component.Apex.OutputText();
outText.value = 'Some dynamic output text.';

Dynamic Visualforce is a powerful feature for advanced developers, and you’ll want to read about it in depth before using
it. See Dynamic Visualforce Components in the Visualforce Developer’s Guide.

Dynamic References to Global Variables—Generally Available

Visualforce dynamic bindings adds support for dynamic references for global variables such as $ObjectType, $Resource,
and $Action.

A simple example of using this is to allow dynamic references to static resources:

<apex:page controller="logoController">

<h1>Logo Test</h1>
This is a dynamic reference to a static resource:
<apex:image value="{!$Resource[customLogo]}"/>

</apex:page>

customLogo refers to a method in the page controller:

public class logoController {

public string getCustomLogo() {
return('MyLogo');

}

}

This controller method returns a string, which is used to dynamically reference a graphic stored in a static resource, using
the global $Resource variable. You can dynamically return a graphic customized for the user’s role, the data being
displayed, the value of a custom setting, and so on. Use $Action to dynamically change links based on the data being
displayed, and use $ObjectType to work with a wide variety of object metadata.

To learn more about this powerful new feature, see Dynamic Visualforce Bindings in the Visualforce Developer’s Guide.

Single View State

The Spring ’12 release has a new performance enhancement, Single View State. This is an optimization to how the view
state is encoded and sent for Visualforce forms. This optimization can reduce the amount of data transmitted between
Salesforce servers and browser clients, and reduce processing time on the server, as well as in the browser. This can
improve the responsiveness of complex Visualforce pages. View state optimization is performed automatically and
transparently for new and existing Visualforce pages. You don’t have to do anything to take full advantage of this
improvement.

Although this optimization will have minimal-to-zero impact, it is a change from past behavior in Visualforce, and we
expect that customers will want to proceed cautiously. Single View State will initially only be enabled for customers who
request it. The enhancement will be generally available and rolled out to all customers at a later date. Contact salesforce.com
to have Single View State enabled for your organization.
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To assist customers with their validation processes, here are some technical details regarding Single View State. The
specific enhancement is to only include one copy of the view state per Visualforce page, no matter how many forms are
on that page. Previously every form on a page had a redundant copy of the view state, embedded in the form using a
hidden input field. If there were many forms on a page, this added up, increasing the amount of data that needed to be
transferred every time a page was loaded.

With Single View State enabled, Visualforce will only include one copy of the encoded view state, in a hidden input
field at the beginning of the page content. When a form is submitted the view state is dynamically attached to the form
via JavaScript and then submitted normally.

The enhancement makes a long-standing “best practice” obsolete. While we still recommend that you don’t overload
Visualforce pages with too much functionality all on one page, you no longer need to worry about using multiple forms
on a page. Using multiple forms will no longer “bloat” your page with extra copies of the view state.

PDF Optimizations and Limits

In Spring ’12, PDF generation of Visualforce pages that include images has been optimized. The time to generate pages
using renderAs="PDF" should be reduced and the resulting PDF files are smaller. The optimization is most significant
for pages with repeating images.

Also, two new limits have been added. They ensure the PDF optimizations are effective and evenly applied to all
customers:

• Maximum PDF file size: 60 MB

• Maximum total size of all images included in a PDF: 30 MB

These limits are intended to prevent unintentional runaway PDF file generation. Customers with Visualforce pages that
generate large PDF files that exceed these limits can contact salesforce.com to arrange for short-term increased limits.

More Strict Validation for Input Components value Attribute

When you save a page, the value attribute of all input components—<apex:inputField>, <apex:inputText>,
and so on—is validated to ensure it’s a single expression, with no literal text or white space, and is a valid reference to a
single controller method or object property. Beginning with pages saved using API version 24.0, this error checking is
more strict for two specific cases:

• An empty expression “{!}” is treated as an error instead of silently doing nothing.

• An incomplete expression, such as “{!someProp”, which is missing the trailing “}”, is treated as an error instead of
displaying as literal text.

Pages saved using API version 23.0 or earlier are subject to the previous validation behavior for input components. If
you want less strict validation, keep your pages saved in API version 23.0 or earlier.

Referential Integrity Validation Improvements

With additional referential integrity checking it is now more difficult to unintentionally break a Visualforce page by
making a change to an Apex class, or changes to objects, custom settings, labels, or fields sets in the Salesforce application.

Visualforce JavaScript Remoting Response Compression

JavaScript Remoting responses are now compressed, significantly reducing payload size. This optimization is transparent,
and results in improved response times.
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Other Optimizations

Spring ’12 also brings a larger-than-usual collection of internal optimizations to improve the performance and robustness
of Visualforce. You won’t see them, but we think you’ll feel them.

Additional Appforce Enhancements
Tab Bar Organizer

Available in: Personal, Contact Manager, Group, Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To modify user interface settings:

In Spring ‘12, we’re pleased to introduce the Tab Bar Organizer. The Tab Bar Organizer automatically arranges tabs in the
main tab bar to prevent horizontal scrolling of the page. It dynamically determines how many tabs can display based on the
width of the browser window and puts tabs that extend beyond the browser's viewable area into a drop-down list.

Note the following considerations:

• The Tab Bar Organizer isn’t available with the partner portal or Customer Portal.
• The Tab Bar Organizer is only available with the new user interface theme. Organizations using the old user interface

theme can enable the feature, but it won't be available for users until the new theme is also enabled.
• The Tab Bar Organizer isn’t available on Internet Explorer 6.

The Tab Bar Organizer is enabled by default. To disable it:

1. Click Your Name > Setup > Customize > User Interface
2. Deselect the Enable Tab Bar Organizer checkbox.
3. Click Save.

Field Updates for Encrypted Custom Fields
With Spring '12, we've expanded the reach of workflow field updates to include encrypted custom fields. Note, however, that
if you try to use a formula to set an encrypted custom field's new value, the encrypted custom field isn't available in the formula
editor as a resource.

Workflow Field Updates Can Retrigger Workflow Rules
We added a new checkbox option to workflow field updates that allows you to select whether you want a field update to trigger
a re-evaluation of all workflow rules on the object.

Here’s how it works:
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• If the field update changes the field’s value, all workflow rules on the associated object are re-evaluated. Any workflow
rules whose criteria are met as a result of the field update will be triggered.

• If any of the triggered workflow rules result in another field update that’s also enabled for workflow rule re-evaluation, a
domino effect occurs, and more workflow rules can be re-evaluated as a result of the newly-triggered field update. This
cascade of workflow rule re-evaluation and triggering can happen up to five times after the initial field update that started
it.

• In a batch update, workflow is only retriggered on the entities where there is a change.
• Only workflow rules on the same object as the initial field update will be re-evaluated and triggered.
• Only workflow rules that didn’t fire before will be retriggered.
• Cross-object workflow rules and time-based workflow rules aren’t candidates for re-evaluation.
• Cross-object field updates that cause a field value to change don’t trigger workflow rule re-evaluation on the associated

object.

Force.com Quick Access Menu Enhancements
In Spring ‘12, you can use your keyboard to scroll down the options of the menu. Press ALT+; to open the menu, and press
TAB to scroll down the menu. Press ENTER to select an option on the menu.

Custom Tab Detail
With Spring ‘12, you can view the custom tab details of your app from the App Detail page. To view custom tab details from
the App Detail page, click on a custom tab in the Included Tabs list to view details.

App Quick Start Enhancements
Starting in Spring ’12, users will need to have “Customize Application” and “Manage Users” enabled to create an app with
App Quick Start.

The App Quick Start now:

• Generates a permission set that grants access to the new custom object.
• Assigns the permission set to the user who creates the app.

With Spring '12, you can add new fields to your app with the App Quick Start. After you click Create in the App Quick Start,
click add more fields here to add new fields to your new app.

SITEFORCE

Siteforce Enhancements
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

For publishers, Spring '12 introduces Siteforce dynamic data services, which combine many new features that let you connect
to Salesforce objects. Retrieve data from your organization’s objects and dynamically display it on your site pages, or alternatively,
gather and submit data from your customers using web-to-object forms.
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The following examples illustrate a few ways to use Siteforce data services:

• Publish a catalog of products—List your company's products and include information, such as model numbers and prices,
pulled dynamically from your organization.

• Post company press releases—Publish your company’s press releases and sort by publication date.

• Create a realtor website—Display current listings filtered by city or price.

• Create a recruiting website—Post job openings to a public site and allow visitors to submit applications and resumes.

For publishers, Spring ‘12 also introduces selective publishing, which lets you publish selected items only, and folder management
features for organizing your site content, along with URL redirects, custom HTML attributes, and new HTML5 additions.

Plus, we’ve revamped the Overview tab in Siteforce Studio for both publishers and contributors, and reorganized the way site
components are displayed.

Repeaters and Repeater Elements—Generally Available
With the Spring ‘12 release, repeater and repeater elements are now generally available to publishers. Together, these two
page elements let you connect to standard and custom objects, retrieve data, and dynamically display it on your site’s pages.
And when you update data in an object, the changes are reflected automatically on the live site—no site updates required!

A repeater:

• Connects to a standard or custom object and returns a data set based on the filter criteria that you specify.

• Contains repeater elements that are directly related to individual fields in the Salesforce object.

• Can contain custom code that can access the object’s fields. It can also contain other page elements that can’t access the
object’s fields, such as panels for layout.

• Can be controlled with a custom button that lets users page through the data for easy viewing.

A repeater element, which must be contained in a repeater, binds to a field in the Salesforce object. Each repeater element
acts as a placeholder that displays the content of a specified field for the current record.

Together, the repeater and repeater elements result in a "repeating template" that displays one or more records on the page.
You can access these two page elements from the Page Elements pane in Siteforce Studio when a page is open. You can also
style the repeater and its elements as you would any other page element.

See “Using a Repeater to Retrieve Data” and “Displaying Data in a Repeater Using Repeater Elements” in the online help.

Data Tables
In addition to repeaters and repeater elements, we’ve introduced data tables as another way for publishers to connect to standard
or custom objects, filter and retrieve data, and display the records on the page. The records are automatically displayed in a
table which you can quickly customize using themes. To add a data table to your page, drag it from the Page Elements pane
in Siteforce Studio onto the page canvas. See “Using a Data Table to Retrieve Data” in the online help.

Data Functions
Spring ‘12 enhances data services features with the introduction of data functions. Publishers can use this page element to
connect to standard or custom objects, perform calculations on the returned results, and display the calculation on the page.
For example, for a particular field in an object, you can use a data function to calculate the total value or the average amount
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of all returned records. Combine it with other data services features like forms to collect comments from your customers and
display the number of comments received. Add a data function to a page by simply dragging it from the Page Elements pane
in Siteforce Studio onto the page canvas. See “Using Data Functions” in the online help.

Repeater and Data Table Pagination (Pilot)
When working with repeaters and data tables, publishers can let users page through the displayed data by adding one of three
new pagination events. These events—Previous Page, Next Page, and Go To Page—are available in the Events pane in
Siteforce Studio when the page is open. This feature is particularly useful when working with large amounts of data. See
“Adding Pagination to Repeaters and Data Tables” in the online help.

Note:  The pagination feature is currently available through a pilot program. For information on enabling it for your
organization, contact salesforce.com

Web-to-Object Forms
Forms complete the Siteforce data services feature set by letting you submit data to your organization’s standard or custom
objects. Create web-to-object forms that capture customer details, or gather feedback on your products or services. As with
the other data page elements, publishers can add a form to a page via the Page Elements pane in Siteforce Studio. See “Adding
a Form to the Page” in the online help.

Data Access Permissions
Sites built with Siteforce are publicly available, so visitors access the site via the Guest User license that’s associated with the
site. By default, site visitors have access to information made available in an active public site, such as the site’s pages and
assets. To allow guest users to view data from standard or custom objects on a site page, however, you must edit the site’s guest
user profile. Each site has a separate Guest User license, so you can control data access on a per-site basis.

Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Siteforce Publisher User field enabled on the user
detail page

To build and publish Siteforce sites:

“Manage Users”

AND

“Customize Application”

To edit the guest user profile:

To edit the guest user profile:
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1. On the Overview tab of Siteforce Studio, click Site Configuration and click Site Name Profile. Alternatively, if you’re
adding a repeater, data table, data function, or form to the page, click go to the guest user profile in the item’s dialog box.

2. In the site’s guest user profile, enable the “Read” permission on the standard or custom objects you want to retrieve data
from using repeaters, data tables, or data functions. Enable the “Edit” permission on the objects you want to submit data
to using forms. All permissions that aren't set by default must be set manually. See “User Profiles Overview” in the online
help.

3. If required, modify the field-level security of an object. See “Setting Field Permissions in Permission Sets and Profiles” in
the online help.

Selective Publishing
When you update your site, instead of publishing the entire site, you can publish only the items you want. This can speed up
publishing considerably, especially if you have a large site. When you click Publish Changes..., you see a list of all changes
that were made since the last time the site was published. Items are listed by type and include all changed pages, templates,
style sheets, and assets, which you can select or deselect. If an item has dependencies, they will be selected along with the main
item. For example, if you select a page, but you actually changed both the page and the style sheet it relies on, the style sheet
is also automatically selected. Click View to see the list of dependencies. You can deselect a dependency as long as it’s not a
critical dependency. Critical dependencies are noted with a red dot.

See “Publishing Parts of Your Site” in the online help.

Folder Manager
As a publisher, you can manage folders and items using the All Site Content view on the Overview tab in Siteforce Studio.
From All Site Content, you can:

• Create and manage folders and files

• Import assets

• Create site pages

• Create page templates

• Create style sheets

This flexibility lets you organize your site in a way that makes sense to you. You can also manage your assets from the All Site
Content view without switching to the individual views for pages, style sheets, and assets.

URL Redirects
If you move or reorganize pages in your site, search engines may have trouble finding the new page locations. To avoid this,
publishers can set up URL redirects to inform users and search engines that site content has moved.

You can use URL redirects to:

• Maintain search engine ranking. For example, if you change a page’s name from “Gadgets” to “Widgets,” creating a redirect
rule from /Gadgets to /Widgets lets you restructure the site without affecting your page ranking.

• Make URLs more readable and memorable. For example, site visitors will find long or numeric page names, such as
/widget65AD890004ab9923, difficult to remember. Instead, you can provide them with a short, friendly URL, such
as /widget, and create an alias that redirects to the correct page when the user uses the short URL alias.
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• Assist with migration from another system to Siteforce if you’re still using the same domain. For example, if your old site
ran on PHP, you can create a redirection rule from an old page, such as /index.php, to a new page in Siteforce, such as
/myNewPage.

To add redirects to your site, click Site Configuration > URL Redirects on the Overview tab in Siteforce Studio. See “Creating
URL Redirects in Siteforce” in the online help.

Custom HTML Attributes
Publishers can add custom HTML attributes to pages and page elements, which are rendered on the HTML tag of the page
element. For example, this is useful when working with third-party frameworks that render page elements differently based
on certain attributes. See “Adding Custom HTML Attributes” in the online help.

HTML5
As a publisher, you can now set a page’s doctype property to HTML5, and take advantage of several semantic HTML5
elements that describe the content they contain. See “Changing a Page’s Doctype Property” and “Changing a Panel’s Render
Tag Property” in the online help.

Import, Export, and Duplicate Sites
The import, export, and duplicate site features are especially helpful if you don’t want to start from scratch to build a new site.
Available from the Siteforce tab in the Siteforce app, these features save time and money, because you can reuse all or parts
of existing sites. For example, let’s say you have several ideas for home page layouts. Using the duplicate feature, you can create
one initial site, duplicate it, and then make the other prototypes. The export and import features allow you to export an entire
site to your hard drive, and then import it into another org. Only users with the “Manage Users” and “Customize Application”
permissions, and the Siteforce Publisher User field enabled on their user detail page can duplicate, import, and export
sites.

See “Duplicating a Siteforce Site,” “Exporting a Siteforce Site,” and “Importing a Siteforce Site” in the online help.

Reorganized Overview Tab
We’re reorganized the Overview tab in Siteforce Studio for both publishers and contributors. This is the tab you first see when
you open a site in Siteforce Studio.

For publishers, who use the Overview tab to access and manage the site’s components, and configure the site’s properties:

• Site content is now grouped by type into several views.

• The Site Properties button has been moved and renamed. You can now set your site properties in the Site Configuration
view.

• The Manage Domains button has also been moved. Now you can access Manage Domains under the Site Configuration
view.
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• Select a view (1) on the Overview tab to view its contents (2).

◊ Site Pages—Create site pages, open and edit pages, access page options, and organize the site map. You can also switch

between the default site map view ( ) and the list view ( ).
◊ Page Templates—Create page templates to base your site pages on, open and edit existing templates, and access template

options.
◊ Style Sheets—Edit the site’s style sheet or create new style sheets.

◊ Assets—Import and manage assets, such as images and files.

◊ All Site Content—Create folders to organize your site content. In this view, you can also create pages, templates, and
style sheets, and import assets.

◊ Recent Changes—View information about the most recently modified files.

◊ Site Configuration—Configure site properties such as the site name, create URL redirects, and manage domain
information.

• Use the toolbar (3) to:

◊ Import assets, such as images and files.

◊ Preview your site or generate an anonymous preview link to send to other users.

◊ Publish your recent changes.

• Use the site's pull-down menu (4) to:

◊ Open recently accessed sites.

◊ Exit Siteforce Studio and return to Salesforce.

◊ Create and open a new site. Only users with the “Manage Users” and “Customize Application” permissions and the
Siteforce Publisher User field enabled on their user detail page can create and import sites.

◊ Duplicate the site. Only users with the “Manage Users” and “Customize Application” permissions and the Siteforce
Publisher User field enabled on their user detail page can duplicate sites.
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For contributors, who access and edit the site’s pages, site content is now grouped by type into several views.

• Select a view (1) on the Overview tab to view its contents (2).

◊ Site Pages—View and edit pages, or create site pages, if available.

◊ Assets—Import assets, such as images and files.

◊ All Site Content—View all of the site’s pages, images, and files.

◊ Recent Changes—View information about the most recently modified files.

• Use the toolbar (3) to:

◊ Import assets, such as images and files.

◊ Preview the site in a browser window.

• Use the site's pull-down menu (4) to:

◊ Open recently accessed sites.

◊ Exit Siteforce Studio and return to Salesforce.

New Navigation Name Property
Previously, the name of an item in a navigation menu was controlled by the page’s name. However, page names can’t include
spaces or special characters. Now, pages have a new Navigation Name property, which can include spaces and special
characters, that controls the name of the page when it’s included in a navigation menu. To change the name of an item in a
navigation menu, open the associated page and update its Navigation Name field in the Properties pane. Your changes are
reflected immediately in the menu.

Sites Tab Renamed
The Sites tab in the Siteforce app, which is where you access your sites, is now called Siteforce.
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ISVFORCE

Enhanced Trialforce Branding—Generally Available
Spring '12 has significant enhancements for Trialforce branding. App developers using Trialforce to create new trials of their
product can optionally set up a branded login site and system emails. By branding these areas with your company's look and
feel, users of your application will be immersed in your brand from sign-up to login.

A Trialforce Branding page allows you to specify your login domain and login site.

• Login domains end with .cloudforce.com, so that if your company name is “mycompany,” then your login domain
will be mycompany.cloudforce.com.

• Your custom login site includes your text and company logo, and mobile-friendly versions of your login site as well.

Branded emails allow you to specify fields in system-generated emails so that your company name, address, and other pertinent
details are used in email correspondence. You can create multiple branded email sets for different campaigns, customer bases,
etc.

Note:  To configure branding, you must be logged into a Trialforce Management Organization. To get your Trialforce
Management Organization, log a case in the Salesforce Partner Portal.

Creating a Branded Login Page

Available in: Developer Edition

User Permissions Needed

“Package Branding”To define package branding:

To create a branded login page:

1. Click Your Name > Setup > Trialforce > Branding > Login Site.
2. Click Set Up Login Site.
3. Select a subdomain for your login site by providing a name in the field provided. Usually this is the name of your company.

Note: Login domains end with .cloudforce.com, so that if your company name is “mycompany,” then your
login domain will be mycompany.cloudforce.com.

4. Check the availability of the domain and then accept the terms of use.
5. Click Save and Launch Editor.

150

ISVforce Enhanced Trialforce Branding—Generally Available

http://sites.force.com/partners/PP2HomePage?p=P_Home


6. Use the Login Brand Editor to change how your login page looks. For additional help using the editor, click Help for this
Page.

Creating Branded Emails

Available in: Developer Edition

User Permissions Needed

“Package Branding”To define package branding:

To create a branded email set:

1. Click Your Name > Setup > Trialforce > Branding > Email Sets.
2. Click New Email Set or Edit next to an existing email set.
3. Fill in the fields with your company info.
4. In the Preview Emails area, click through the different types of generated emails and make sure they read correctly.
5. Click Save.
6. If you're ready to make these emails available to your Trialforce master organizations, click Publish. Otherwise your changes

are saved and you can publish later.

Creating a Trialforce Master Organization

Available in: Developer Edition

User Permissions Needed

“Package Branding”To define package branding:

Using a Trialforce Management Organization, you can create a master organization to act as the basis for your trial. You can
customize and brand a master organization so it serves as the basis for new organizations. A master organization can include
installed packages.

To create a new master organization:

1. Click Your Name > Setup > Trialforce > Master Organizations.
2. Click New.
3. Enter a new username and email address for the administrator account.
4. Enter the master organization name and select the branding.
5. Click Create.

151

ISVforce Enhanced Trialforce Branding—Generally Available



You can create multiple master organizations from a Trialforce Management Organization. This enables you to set up trials
for different products, each with its own configuration and branding.

Creating a Trialforce Template

Available in: Developer Edition

User Permissions Needed

“Package Branding”To define package branding:

Once you have configured a master organization, you create an organization template inside it, which can be used to create
new trials. You can create many templates from the same master organization.

To create a template from a Trialforce master organization:

1. In the master organization, click Your Name > Setup > Trialforce.
2. Click New Organization Template.
3. Specify a description of the template and whether to include data in the dialog that appears.
4. Click Save.

You will receive an email with the organization ID of the new template. You can use the ID to sign up trial organizations.

Note:  You can only create a template if the master organization is less than 256 MB in size.

Each template has a status with one of the following values.

In Progress

When a template is first created, it always has this status. It then automatically moves to either Success or Error status.

Success

The template can be used to create new trial organizations.

Error

The template cannot be used as something has gone wrong and additional debugging is required.

Deleted

The template is longer available for use. Deleted templates are automatically removed during system updates.

Subscriber Support Console—Generally Available
Spring '12 has several enhancements for subscriber support. Using the Subscriber Support Console, you can easily access
information about all your subscribers, such as which Salesforce Edition they are using and if they are over their limits.
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Subscribers can also grant you login access to troubleshoot issues directly within the app. The Subscriber Support Console
can be accessed in the License Management App (LMA) under the Subscribers tab.

Note:  This feature is available to eligible salesforce.com partners. For more information on the Partner Program,
including eligibility requirements, please visit us at www.salesforce.com/partners

Viewing Subscriber Details
The Subscriber Overview page, accessed by clicking the organization’s name from the Subscribers tab of the LMA, provides
detailed information about each subscriber organization. This can give you insight into how a customer is using your app and
help you in troubleshooting problems.

Under Organization Details:

• The name and contact information is from the Setup > Company Profile > Company Information page in the subscriber’s
organization. This may differ from the information shown in your LMA lead, account, or contact records.

• Organization ID is a unique ID that identifies this customer’s Salesforce organization.

• Instance determines which salesforce.com data center this customer’s organization resides in. It also determines when the
customer will get upgraded with a new version of Salesforce. See trust.salesforce.com during the release period to understand
which version of Salesforce the customer is using.

The page also includes these related lists.

Limits

Information on the file space, data space, and number of API requests associated with this customer, as a percentage.

Login Access Granted

A list of users who have granted login access and the date when access will expire.

Packages and Licensing

A list of all packages installed in this organization and associated with this LMA. The list includes non-Aloha enabled
packages. For each package, it shows the version of the app a customer is currently using, the total number of licenses
provisioned to the subscriber and the number they’ve used. This information should match the license record for the
subscriber in your LMA.

Requesting Login Access
Ask the user to go to Setup > My Personal Information > Grant Login Access to grant access. If the publisher is not listed
on this page, it is for one of the following reasons:

• A system administrator disabled the ability for non-administrators to grant access.

• The user does not have a license for the package.

• The package is not Aloha enabled.

• The package is licensed to the entire organization. Only administrators with the “Manage Users” permission enabled on
their profile can grant access.

153

ISVforce Subscriber Support Console—Generally Available

http://www.salesforce.com/partners


Note:  Access can only be granted for a limited amount of time, and the subscriber can revoke access at any time. Any
changes you make while logged in as a subscriber are logged in the audit trail.

Logging in to Subscriber Organizations

User Permissions Needed

“Log in to Subscriber Organization”To log in to subscriber organizations:

To log in, once a user has granted you access:

1. In the License Management App (LMA), click the Subscribers tab.
2. To find a subscriber organization quickly, enter a subscriber name or organization ID in the search box and click Search.
3. Click the name of the subscriber organization.
4. On the Organization Details page, click Login next to a user's name. Note that you have the same permissions as the user

you logged in as.
5. When you’re finished troubleshooting, click Your Name > Logout to return to your organization.

Note:  Only subscribers who have installed at least one managed package that is Aloha enabled and linked to your
LMA will appear in this list. If none of your packages are Aloha enabled, then no subscribers will be listed.

Best Practices

• When you access a subscriber organization, you are logged out of your LMO (License Management Organization). You
can set up a my domain so that you are not automatically logged out of your LMO when you log into a subscriber
organization. To set up a my domain, click Your Name > Setup > Company Profile > My Domain.

• Be careful to allow only trusted support and engineering personnel to log into a subscriber’s organization. Since this feature
may include full read/write access to customer data and configurations, it’s vital to your reputation to preserve their security.

• Control who has access by giving the “Log in to Subscriber Organization” user permission to specific support personnel,
via a profile or permission set.

Troubleshooting in Subscriber Organizations
When logged in as a user in a subscriber’s organization, you can generate Apex debug logs that contain the output from your
managed packages.  This includes logging that would normally not be exposed to the subscriber.  Using this log information,
you can troubleshoot issues that are specific to that subscriber organization. 

1. Launch the Developer Console from Your Name > Developer Console.
2. Perform the operation and view the debug log with your output. If the user has access, setup up a Debug Log from Setup

> Monitoring > Debug Log.
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Note that subscribers will be unable to see the logs you set up or generate since they contain your Apex code unobfuscated.
In addition, you can also view and edit data contained in protected custom settings from your managed packages when logged
in as a user.  

Package Installation Improvements
Spring '12 has the following enhancements for installing packages.

Running Tests on Package Installation
Starting with Spring '12, tests won't automatically run when a customer installs a package, regardless of when the package
was created. If you want to run tests upon package installation, you must add the @isTest(OnInstall=true) annotation
to all test classes or test methods that you want executed, and subsequently, package and release a new version of your app.
Tests annotated to run during package installation must pass in order for the package installation to succeed. It is no longer
possible to bypass a failing test during package installation. For more information, see IsTest(OnInstall=true) Annotation
in the Force.com Apex Code Developer's Guide.

Enhanced Error Messages
If a package installation fails, the user installing the package will see a meaningful error message explaining the reason for the
failure. For example, if the installation would cause the number of custom objects, tabs, or applications to exceed the allowed
limit, the error message will specify the limit in question and provide information on how to increase it.

Modifying Custom Fields after a Package is Released
Available in: Developer Edition

User Permissions Needed

“Create AppExchange Packages”To create packages:

Starting with Spring ‘12, you can make changes to some properties of custom fields, such as the length of text fields or the
precision of numeric fields, after a package is released. This feature enables greater flexibility in upgrading packages. However,
it must be used with caution as some types of changes can lead to data loss or cause existing API or Apex requests to break.

The following changes are allowed to custom fields in a package, after it is released.

• The length of a text field can be increased or decreased. Reducing the length brings up a dialog warning of potential data
loss.

• The number of digits to the left or right of the decimal point in a number field can be increased or decreased. Reducing
the precision brings up a dialog warning of potential data loss.
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• A required field can be made non-required and vice-versa. If a default value was required for a field, that restriction can
be removed and vice-versa. Making a field required brings up a warning that existing API or Apex requests that do not
supply a value for the field can result in an error.

New Apex Methods and Class for Package Versions
As a package developer, you can now obtain the version of a managed package simply by calling the System.requestVersion
method without having to resort to the special dot-notation syntax used in Package.Version.Request. Also, you can use
the new System.Version class methods to compare versions. The following are the new methods and classes that have been
added:

• System.requestVersion method: Returns a two-part version that contains the major and minor version numbers of
a package. Using this method, you can determine the version of an installed instance of your package from which the calling
code is referencing your package. Based on the version that the calling code has, you can customize the behavior of your
package code.

• System.runAs(System.Version) method: Changes the current package version to the package version specified in
the argument.

• System.Version class: Contains methods to get the version of a managed package of a subscriber and to compare package
versions.

Running a Post-Installation Apex Script—Pilot
Note:  This feature is currently available through a pilot program. For information on enabling it for your organization,
contact salesforce.com.

When creating a package, you can specify an Apex script to run automatically after the package is installed. This makes it
possible to customize the package installation, based on details of the subscriber’s organization. The script is invoked after
tests have been run and licensing has been verified. Using a post-installation script is recommended only for making minor
changes, for example, setting configuration values. It is possible for the script to schedule batch execution, but this would be
insecure and is discouraged.

The post-installation script is invoked with default governor limits. It will run in the same transaction as the installation itself
and is rolled back if the installation fails. Script failure will cause the installation to fail. Any errors in the script are reported
directly to the user with a message guiding them to resolve the issue with the package publisher.

For simplicity, only one post-installation script is allowed. The script must be selected from a list of Apex classes that are
members of the package. The contents of the script can be changed in a patch organization, but not the class. The class selection
is available via the Metadata API.
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DATABASE.COM

Schema Builder Enhancements—Beta

 You asked for it! This enhancement is from an idea on the IdeaExchange.

Available in: All Editions

Note:  This release contains a beta version of schema builder that is production-quality but has known limitations.
Schema builder is not supported on Microsoft® Internet Explorer® version 6 or earlier.

New in Spring ‘12, you can now create new custom objects, custom fields, and relationships with schema builder. This eliminates
the need to click from page to page to find the details of a master-detail relationship or to add a new custom field to an object
in your schema. For example, if you’re using schema builder to view the details of your schema, you can add a new custom
object without leaving schema builder. The drag-and-drop interface lets you easily add a custom object or new field, and saves
the layout of your schema any time you move an object.

Schema builder is enabled by default and lets you add the following to your schema:

• Custom Objects

• Lookup Relationships

• Master-Detail Relationships

• Fields of the following types:

◊ Checkbox

◊ Currency

◊ Date

◊ Date/Time

◊ Email

◊ Number

◊ Percent

◊ Phone

◊ Text

◊ Text Area

◊ Long Text Area

◊ Rich Text Area

◊ URL
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Working with Schema Builder

Available in: All Editions

User Permissions Needed

"Customize Application"To view objects in schema builder:

Note:  This release contains a beta version of schema builder that is production-quality but has known limitations.
Schema builder is not supported on Microsoft® Internet Explorer® version 6 or earlier.

You can access schema builder in three ways:

• Click Your Name > Setup > Schema Builder.
• Click Your Name > Setup > Create > Objects. Then in the custom objects page, click Schema Builder.
• Click Your Name > Setup. In the Quick Links box on the Force.com home page, click Schema Builder.

When working with schema builder:

• Click on an object and move it to any space on the canvas. Schema builder saves the layout of your schema any time you
move an object.

• Click Auto-Layout to automatically sort the layout of the objects in your schema.

Important:  Once you click Auto-Layout, you can't undo it.

• Click View Options to:

◊ Display Element Names if you prefer system names, or Display Element Labels if you prefer text values.

◊ Show/Hide Relationships
◊ Show/Hide Legend

• The Elements tab lets you drag and drop new custom objects and fields onto the canvas.

◊ To create a new custom object, see Creating Objects with Schema Builder.

◊ To create a new custom field, see Creating Fields with Schema Builder.

• The Objects tab lets you select objects to display on the canvas.

◊ Click the drop-down list in the sidebar to filter your list of objects:

- All Objects

- Selected Objects

- Standard Objects

- Custom Objects

- System Objects
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Note:  Objects created outside of schema builder, such as through an app or the API, don’t automatically
display on the canvas. Select the checkbox for the object created outside schema builder to display it on the
canvas.

◊ To search for an object, type its name in the Quick Find... box.

◊ Hover over an object in your list of objects and click  to find it on the canvas.

• Hover over relationship lines to show relationship details such as lookup and master-detail relationships. Click the name
of the object to find it on the canvas. You may want to hide relationships if your schema is taking too long to load.

• To view the details of a field in a new window, click the element name or label.

• Click  to:

◊ Hide Object on Canvas
◊ View Object detail in a new window

◊ View Page Layouts detail in a new window

• Click Show More Fields to display all the fields of an object.

•
To zoom in, click . To zoom out, click .

Note:  You can't save the level of zoom when closing schema builder.

•
To collapse the sidebar, click . To expand it, click .

• The map in the lower right corner shows the overall layout of your objects on the canvas. Click on the map to navigate the
layout of your objects.

• To close the schema builder and save the layout of your objects, click Close.

Important:  If your schema contains many objects and fields, it may cause long loading times. Click Hide Relationships
to improve schema builder performance.

Creating Objects with Schema Builder

Available in: All Editions

User Permissions Needed

"Customize Application"To create new custom objects in schema builder:

Note:  This release contains a beta version of schema builder that is production-quality but has known limitations.
Schema builder is not supported on Microsoft® Internet Explorer® version 6 or earlier.
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To create a new custom object with schema builder:

1. Click the Elements tab.
2. Click Object and drag it onto the canvas.
3. Enter information to define your object. See “Schema Builder Custom Object Definition” in the online help for a list of

object definitions.
4. Click Save.

Creating Fields with Schema Builder

Available in: All Editions

User Permissions Needed

"Customize Application"To create new fields in schema builder:

Note:  This release contains a beta version of schema builder that is production-quality but has known limitations.
Schema builder is not supported on Microsoft® Internet Explorer® version 6 or earlier.

To create a new custom field with schema builder:

1. Click the Elements tab.
2. Click a field and drag it onto an object on the canvas. See “Schema Builder Custom Field Definition” in the online help

for a list of available fields.
3. Enter a Field Label.

The Field Name is automatically populated based on the field label you enter. This name can contain only underscores
and alphanumeric characters, and must be unique in your organization. It must begin with a letter, not include spaces, not
end with an underscore, and not contain two consecutive underscores.

Ensure that both the custom field name and label are not identical to the name and label of any existing standard or custom
field for that object. Identical values may result in unexpected behavior when you reference that name in a merge field.

• If a standard field and custom field have matching names or labels, the merge field displays the value of the custom
field.

• If two custom fields have matching names or labels, the merge field may not display the value of the field you expect.

For example, if you create a field label called Email, the field name automatically populates as Email__c. If you also
have a standard field with the label Email, the merge field may not be able to distinguish between the standard and custom
field names. Make both the custom field name and label unique by adding a character to each, such as Email2 and
Email2__c, respectively.

4. Enter a Namespace Prefix.
5. Enter a Description of the custom field.
6. Enter Help Text to detail the purpose and function of a custom field.
7. Enter a Default Value to automatically insert a value of a custom field when a new record is created.
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8. Depending on the custom field type you choose, enter any remaining field attributes.
9. Click Save.

Platform Development Tools
Developer Console—Generally Available

Available in: Unlimited, Developer, Enterprise, and Database.com Editions

The Developer Console has a few changes and improvements in Spring ’12. Most importantly, it is now opened by clicking
Your Name > Developer Console. (Previously the menu item was System Log.)

Additional enhancements to the Developer Console in Spring ’12 include:

Raw Debug Log Viewer
You can now directly view a “raw” log from the Logs tab of the Developer Console. Select a debug log and click Open
Raw Log.

Previously if you wanted to view the raw unformatted version of a debug log in the Developer Console you had to switch
back to the Old System Log. With this change, all features of the Old System Log are available in the Developer Console,
and the Old System Log interface has been removed.

Visualforce Pages and Components
The Repository tab now allows you to browse and open Visualforce pages and components. Visualforce sources open
in a Source Code view similar to that used for Apex classes and triggers, and can be edited and saved in the same way.

Visualforce Syntax Highlighting and Auto-Complete
Visualforce page and component source views have full syntax highlighting and support for auto-complete suggestions.
Auto-complete works similarly to auto-complete in the Visualforce development mode footer: as you type a Visualforce
component tag, a list of suggested completions appear.

Keep typing to filter the suggestions, press ENTER to select the top completion, or use the arrow keys or mouse to
select a different completion. Auto-complete supports both Visualforce tags and tag attributes.

Packages Support
The Repository tab now allows you to browse and open the contents of packages you have created in your organization.
You can see the complete contents of packages, and open the Apex classes and triggers, Visualforce pages and components,
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and custom objects contained in a package. Other package items, such as custom fields, validation rules, and so on, can
be seen in the list, but not viewed in detail.

Heap Search
You can now search the contents of the heap in the new Search tab of the Heap Dump Inspector. Enter a value or heap
address to search for and find all occurrences throughout the heap. Search matches partial symbol values, but addresses
must be exact.

You can quickly search for a value in the heap by clicking the search icon ( ) that appears to the right of the value when
you hover over it in the State panel.

General Development Improvements
We’ve made a few changes that should improve your workflow while developing using the Developer Console. Most
significantly, when validating your modified source views, all modified sources are validated together instead of individually.
Changes that may be inconsistent with code on the server, but are consistent when taken together—such as what occurs
during refactoring, and other common development tasks—will no longer report errors.

Also, if you save these changes using Save All they will be saved in one request, so you can save a collection of changes
that would otherwise be blocked because separately they would be invalid.

To reflect this change in how validation is performed, the Problems panel is now globally available, allowing you to see
compilation errors and other problems for all open source views.

The Developer Console will notice if a source view has been changed by another user since you opened it. If you haven’t
made any changes to it, the source view will be updated automatically. If you’ve made modifications, you’ll see an alert
that lets you know another user has made changes, with the option to update the source view to the latest version.

Caution:  When you update to the latest version your changes will be overwritten. Copy your version out of the
source view to preserve it. You can’t save a modified source view if it has also been modified on the server. Instead,
update to the latest version and integrate your modifications into the new version.

Finally, some simple workspace improvements:

• The Developer Console will now remember the open and collapsed state of various panels in the workspace, such as
the Stack Trace, Source, and Execution Overview panels. This should make it easier and more worthwhile for you
to configure a workspace that feels comfortable.

• The Developer Console will remember the line number you were on in source views, and remember your last executed
code snippet in the Execute Anonymous box.

Security Enhancements
Available in: All Editions

Spring ’12 introduces several new features that enhance security.

Single Sign-On Changes

Now when you save the Single Sign-On Settings page in a sandbox organization, if the Salesforce Login URL value
was for a single instance, the value is reformatted. The reformatting will only happen once, but it will occur even if you
made no changes to the page. Be sure to review the Salesforce Login URL value after you’ve saved the Single Sign-On
Settings page.

162

Database.com Security Enhancements



New Password Complexity Option

The new Must mix alpha, numeric, and special characters password complexity option requires that
the user must include at least one alphabetic character, one number, and one of the following characters ! # $ % -
_ = + < > in their password. Set the option from Your Name > Setup > Security Controls > Password Policies.

Increased Maximum Timeout Value

The maximum session timeout value has increased from 8 to 12 hours. This value is the amount of time that passes
before a user is logged out due to inactivity.

Requiring a Secure Connection (HTTPS) Is Permanent

You can no longer disable HTTPS access to an organization. If you currently have the Require secure connections
(HTTPS) setting disabled, and then enable it, you can only switch back to HTTP by contacting your salesforce.com
representative. This option is set from Your Name > Setup > Security Controls > Session Settings.

Increased Service Provider Selection Availability

You can now set Service Providers from the Identity Provider page for any profile, including Force.com One App and
Chatter Free profiles. Service Providers are set from Your Name > Setup > Security Controls > Identity Provider.

Encrypted Fields Available in Full-Copy Sandbox

Starting in Spring ’12, a full-copy sandbox can include the encryption keys for encrypted fields. This means that if there
are encrypted fields in your production organization, those fields are also available for viewing and use in a full-copy
sandbox. Contact your salesforce.com representative to enable this feature.

Important:  With this feature enabled, all users having a profile with “View Encrypted Data” in the full-copy
sandbox can see the actual value of any encrypted field.

Social Sign-On

You can now enable users to log into your Salesforce organization, portal, or site using their login credentials from an
external authentication service provider. Facebook, Janrain, and Salesforce are supported. Authentication providers for
Social Sign-On are set from Your Name > Setup > Identity > Auth. Providers.

Network Access Column Changes

The obsolete ISP, Organization, and Geography columns have been removed from the page at Your Name > Setup >
Security Controls > Network Access.

Sharing Enhancements
Criteria-Based Sharing Rules Enabled for Leads and Campaigns

Available in: Professional, Enterprise, Unlimited, Developer, and Database.com Editions

Leads and Campaigns are not available in Database.com Editions

You asked for it! This enhancement is from an idea on the IdeaExchange.
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Starting in Spring ‘12, you can apply criteria-based sharing rules to leads and campaigns. You can create up to 50 criteria-based
sharing rules per object.

Name Fields for Groups, Queues, Roles, and Territories

Groups, Queues, and Roles are available in: Professional, Enterprise, Unlimited, Developer, and Database.com

Territories available in: Enterprise, Unlimited, and Developer Editions

When you create a group, queue, role, or territory, you’ll add a label and entity name to support enhanced API access to the
object. The label is the entity label as it appears on the user interface. The entity name is a unique name used to support API
access to the object. You can customize the label and entity name from the UI or the Web Services API.

Name Fields for Sharing Rules

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Manage Users”To create sharing rules:

You asked for it! This enhancement is from an idea on the IdeaExchange.

When you create a sharing rule, you’ll add a label and rule name. The label is the sharing rule label as it appears on the user
interface. The rule name is a unique name used to support API access to the object. For existing sharing rules, default values
are set for both fields. To create or edit a sharing rule: Click Your Name > Setup > Security Controls > Sharing Settings.
In the Sharing Rules section, click New or Edit next to the sharing rule you want to edit. Enter or change the sharing rule
label and name.

Partner Super User Access

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To create, edit, disable, or deactivate users:

“Create” on contactsTo create contacts:

“Read” on contactsTo view contacts:

Partner users can be assigned Partner Super User Access, which enables access to data owned by other partner users and partner
super users of the same role or those below them in the portal account hierarchy. To enable super user access, on the contact
detail page of a partner account, click Work with Portal and select Enable Partner Super Access.
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Sharing Rule Components for Change Sets

Available in: Enterprise, Unlimited, Free, and Database.com Editions

Sharing rules can now be included as components in change sets, enabling you to send and receive sharing rule customizations
between organizations. These components are:

• Account criteria based sharing rule
• Account owner sharing rule
• Account territory sharing rule
• Campaign criteria based sharing rule
• Campaign owner sharing rule
• Case criteria based sharing rule
• Case owner sharing rule
• Contact criteria based sharing rule
• Contact owner sharing rule
• Custom object criteria based sharing rule
• Custom object owner sharing rule
• Lead criteria based sharing rule
• Lead owner sharing rule
• Opportunity criteria based sharing rule
• Opportunity owner sharing rule

Apex Code Enhancements
Available in: Unlimited, Developer, Enterprise, and Database.com Editions

Apex includes the following enhancements in Spring '12. Refer to the Force.com Apex Code Developer's Guide for complete
information about Apex.

The following enhancements are generally available:

Apex REST API
You can use Apex REST API to implement custom Web services in Apex and expose them through the REST API architecture.

The following changes have been made to Apex REST API:

• Apex REST automatically provides the REST request and response in your Apex REST methods via a static RestContext
object. You no longer need to declare a RestRequest or RestResponse parameter in your method.

• User-defined types are now allowed as Apex REST parameter types.
• Apex REST methods are now supported in managed and unmanaged packages.
• Order of elements in the JSON or XML response data no longer has to match the Apex REST method parameter order.

See the Force.com Apex Code Developer's Guide for more details about the Apex REST API.
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Higher Limit for Concurrently Scheduled Apex Classes

You asked for it! The limit increase for concurrently scheduled classes is from an idea on the IdeaExchange.

The limit for the total number of Apex classes that can be scheduled concurrently increased from 10 to 25. With this higher
limit, you can now schedule more Apex jobs for execution.

Apex Triggers Enabled on the ContentDocument Object
You can now associate Apex triggers with the ContentDocument object. You can create Apex triggers for the ContentDocument
object only through the Metadata API. Alternatively, you can create the triggers using the Force.com IDE or the Force.com
Migration Tool, which make use of the Metadata API. For more information, see the:

• Metadata API Developer's Guide
• Using the Force.com IDE to Deploy Apex topic in the Force.com Apex Code Developer's Guide
• Force.com Migration Tool Guide

Isolation of Test Data in Unit Tests
Starting with Salesforce API version 24.0, test methods don’t have access to pre-existing data in the organization, such as
standard objects, custom objects, and custom settings data. They can only access data that they create. This lets you to write
more robust unit tests by preventing any dependencies of tests on any existing data in the organization. By having every test
create and access its own data, no test will fail because the data it depends on doesn’t exist in the organization when the package
is being deployed.

Objects that are used to manage your organization or metadata objects can still be accessed in your tests, such as:

• User
• Profile
• Organization
• RecordType
• ApexClass
• ApexTrigger
• ApexComponent
• ApexPage

This access restriction to test data applies to all code running in test context. For example, if a test method causes a trigger to
execute and the test can’t access organization data, the trigger won’t be able to either.

Test code saved against Salesforce API version 23.0 or earlier continues to have access to all data in the organization and its
data access is unchanged.

You can choose to open up access of a test class or a test method to enable access to all data in the organization by using the
IsTest(SeeAllData=true) annotation. See New IsTest(SeeAllData=true) Annotation.

New IsTest(SeeAllData=true) Annotation
For Apex code saved using Salesforce API version 24.0 and later, use the isTest(SeeAllData=true) annotation to grant
test classes and individual test methods access to all data in the organization, including pre-existing data that the test didn’t
create. Starting with Apex code saved using Salesforce API version 24.0, test methods don’t have access by default to pre-existing
data in the organization. However, test code saved against Salesforce API version 23.0 or earlier continues to have access to
all data in the organization and its data access is unchanged. See Isolation of Test Data in Unit Tests.
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If a test class is defined with the isTest(SeeAllData=true) annotation, this annotation applies to all its test methods
whether the test methods are defined with the @isTest annotation or the testmethod keyword.

This example shows how to define a test class with the isTest(SeeAllData=true) annotation. All the test methods in
this class have access to all data in the organization.

// All test methods in this class can access all data.
@isTest(SeeAllData=true)
public class TestDataAccessClass {

// This test accesses an existing account.
// It also creates and accesses a new test account.
static testmethod void myTestMethod1() {

// Query an existing account in the organization.
Account a = [SELECT Id, Name FROM Account WHERE Name='Acme' LIMIT 1];
System.assert(a != null);

// Create a test account based on the queried account.
Account testAccount = a.clone();
testAccount.Name = 'Acme Test';
insert testAccount;

// Query the test account that was inserted.
Account testAccount2 = [SELECT Id, Name FROM Account

WHERE Name='Acme Test' LIMIT 1];
System.assert(testAccount2 != null);

}

// Like the previous method, this test method can also access all data
// because the containing class is annotated with @isTest(SeeAllData=true).
@isTest static void myTestMethod2() {

// Can access all data in the organization.
}

}

This second example shows how to apply the isTest(SeeAllData=true) annotation on a test method. Because the class
that the test method is contained in isn’t defined with this annotation, you have to apply this annotation on the test method
to enable access to all data for that test method. The second test method doesn’t have this annotation, so it can access only
the data it creates in addition to objects that are used to manage your organization, such as users.

// This class contains test methods with different data access levels.
@isTest
private class ClassWithDifferentDataAccess {

// Test method that has access to all data.
@isTest(SeeAllData=true)
static void testWithAllDataAccess() {

// Can query all data in the organization.
}

// Test method that has access to only the data it creates
// and organization setup and metadata objects.
@isTest static void testWithOwnDataAccess() {

// This method can still access the User object.
// This query returns the first user object.
User u = [SELECT UserName,Email FROM User LIMIT 1];
System.debug('UserName: ' + u.UserName);
System.debug('Email: ' + u.Email);

// Can access the test account that is created here.
Account a = new Account(Name='Test Account');
insert a;
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// Access the account that was just created.
Account insertedAcct = [SELECT Id,Name FROM Account

WHERE Name='Test Account'];
System.assert(insertedAcct != null);

}
}

Running Tests on Package Installation
Starting with Spring '12, tests won't automatically run when a customer installs a package, regardless of when the package
was created. If you want to run tests upon package installation, you must add the @isTest(OnInstall=true) annotation
to all test classes or test methods that you want executed, and subsequently, package and release a new version of your app.
Tests annotated to run during package installation must pass in order for the package installation to succeed. It is no longer
possible to bypass a failing test during package installation. For more information, see IsTest(OnInstall=true) Annotation
in the Force.com Apex Code Developer's Guide.

New Package Version Methods and Class
As a package developer, you can now obtain the version of a managed package simply by calling the System.requestVersion
method without having to resort to the special dot-notation syntax used in Package.Version.Request. Also, you can use
the new System.Version class methods to compare versions. The following are the new methods and classes that have been
added:

• System.requestVersion method: Returns a two-part version that contains the major and minor version numbers of
a package. Using this method, you can determine the version of an installed instance of your package from which the calling
code is referencing your package. Based on the version that the calling code has, you can customize the behavior of your
package code.

• System.runAs(System.Version) method: Changes the current package version to the package version specified in
the argument.

• System.Version class: Contains methods to get the version of a managed package of a subscriber and to compare package
versions.

New isPermissionable Method for the Describe Field Result
In Schema.DescribeFieldResult, the isPermissionable method has been added. This method indicates whether
field permissions can be specified for the field (true), or not (false).

Single Sign-On when Using Authentication Providers
Salesforce provides the ability to use an authentication provider, such as Facebook© or Janrain©, for single sign-on into
Salesforce. To set up single sign-on, you must create a class that implements Auth.RegistrationHandler. Classes
implementing the Auth.RegistrationHandler interface are specified as the Registration Handler in authorization
provider definitions, and enable single sign-on into Salesforce portals and organizations from third-party services such as
Facebook. Using information from the authentication providers, your class must perform the logic of creating and updating
user data as appropriate, including any associated account and contact records.

DescriptionReturn
Type

ArgumentsName

Returns a User object using the specified portal ID and user
information from the third party, such as the username and email
address.

The portalID value may be null or an empty key if there is no
portal configured with this provider.

UserID portalId

Auth.UserData userData

createUser
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DescriptionReturn
Type

ArgumentsName

Updates the specified user’s information. This method is called if
the user has logged in before with the authorization provider and

VoidID userId

ID portalId

updateUser

then logs in again, or if the user has gone through the link flow to
link accounts.

The portalID value may be null or an empty key if there is no
portal configured with this provider.

Auth.UserData userData

The constructor for Auth.UserData has the following syntax:

Auth.UserData(String identifier,
String firstName,
String lastName,
String fullName,
String email,
String link,
String userName,
String locale,
String provider,
String siteLoginUrl,
Map<String, String> attributeMap)

After a user is authenticated using an authentication provider, the access token associated with that provider for this user can
be obtained in Apex using the Auth.AuthTokenApex class. Auth.AuthToken provides a single method, getAccessToken,
to obtain this access token. For more information about authentication providers, see “About External Authentication Providers”
in the Salesforce online help.

DescriptionReturn
Type

ArgumentsName

Returns an access token for the current user using the specified
18-character identifier of an Auth. Provider object in your

StringString authProviderId

String providerName

getAccessToken

organization and the name of the provider, such as Salesforce
or Facebook.

API Enhancements
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

Spring '12 (API version 24.0) improvements:

Changes across the API layer:

• New and Changed Objects

◊ Chatter API Objects

• SOQL Enhancements
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Changes to individual APIs:

• SOAP Web Services API Enhancements

• REST API Enhancements

• Streaming API Enhancements

• Metadata API Enhancements

New and Changed Objects

Generally Available Enhancements

For information about new and changed Chatter objects, see Chatter API Objects on page 174.

New Objects
These objects have been added in API version 24.0.

• The UserRecordAccess object has been added to check users’ access to a set of records.
• These objects provide access to additional permissions in permission sets.

DescriptionObject

Represents the enabled field permissions for the parent
PermissionSet.

FieldPermissions

Represents the enabled object permissions for the parent
PermissionSet.

ObjectPermissions

• These objects let you track items related to Chatter Answers:

DescriptionObject

Represents a user-reported abuse on a Question in a
Chatter Answers community.

QuestionReportAbuse

Represents a subscription for a user following a Question.QuestionSubscription

Represents a user-reported abuse on a Reply in a Chatter
Answers community.

ReplyReportAbuse

• These objects let you customize Live Agent.

DescriptionObject

Represents a button that allows visitors to request chats
with Live Agent users.

LiveChatButton

Represents the general settings for deploying Live Agent
on a website.

LiveChatDeployment
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DescriptionObject

This object is automatically created for each Live Agent
chat session and stores information about the session.

LiveChatTranscript

Captures specific events that occur over the lifetime of a
chat.

LiveChatTranscriptEvent

Represents changes to field values on a
LiveChatTranscript object.

LiveChatTranscriptHistory

Represents a sharing entry on a LiveChatTranscript
object.

LiveChatTranscriptShare

Represents a setting that controls the console settings for
Live Agent users.

LiveChatUserConfig

Represents a join between LiveChatUserConfig and
Profile.

LiveChatUserConfigProfile

Represents a join between LiveChatUserConfig and User.LiveChatUserConfigUser

Represents a website visitor who has started or tried to
start a chat session.

LiveChatVisitor

This object stores a snippet of text that allows an agent
to send a quick response to a customer in the Live Agent
console.

QuickText

Represents changes to field values on a QuickText object.QuickTextHistory

Represents a rule for sharing a QuickText object with
users other than the owner.

QuickTextOwnerSharingRule

Represents a sharing entry on a QuickText object.QuickTextShare

Represents a category or group that Live Agent users can
be assigned to.

Skill

Represents a join between Skill and Profile.SkillProfile

Represents a join between Skill and User.SkillUser

Changed Objects
The following objects have been changed in API version 24.0.

• The Account object now includes these fields.

◊ AccountSource: The source of the account record. For example, Advertisement, Data.com, or Trade
Show. The source is selected from a picklist of available values, which are set by an administrator. Each picklist
value can have up to 40 characters.

◊ DataDotComCleanStatus: Indicates the record’s clean status as compared with Data.com. Values are: Not
Compared, In Sync, Reviewed, Different, Not Found, or Inactive.

◊ DunsNumber: The Data Universal Numbering System (D-U-N-S) number is a unique, nine-digit number
assigned to every business location in the Dun & Bradstreet database that has a unique, separate, and distinct
operation. D-U-N-S numbers are used by industries and organizations around the world as a global standard for
business identification and tracking. Maximum size is 9 characters.
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◊ NaicsCode: The six-digit North American Industry Classification System (NAICS) code is the standard used
by business and government to classify business establishments into industries, according to their economic activity
for the purpose of collecting, analyzing, and publishing statistical data related to the U.S. business economy.
Maximum size is 8 characters.

◊ NaicsDesc: A brief description of an organization’s line of business, based on its NAICS code. Maximum size
is 120 characters.

◊ SicDesc: A brief description of an organization’s line of business, based on its SIC code. Maximum length is
80 characters.

◊ Tradestyle: A name, different from its legal name, that an organization may use for conducting business.
Similar to “Doing business as” or “DBA”. Maximum length is 255 characters.

◊ YearStarted: The date when an organization was legally established. Maximum length is 4 characters.

• The Case object now includes the CommunityId field, which lists the Community (Chatter Answers) associated
with a case.

• The Community object now supports these calls:

◊ create()

◊ delete()

◊ describeLayout()

◊ getDeleted()

◊ getUpdated()

◊ search()

◊ undelete()

◊ update()

◊ upsert()

• The ContentDocument object is updateable in Spring ‘12 and includes a new ParentId field which can be used to
query and update a document’s managing library. The ParentId field is set automatically when a ContentVersion
is inserted via the API for the first time.

• The IsArchived field on the ContentDocument object is updateable in Spring ‘12 and can be used to archive or
unarchive a document.

◊ When IsArchived is set to true, the document is archived. Starting in Spring ‘12, archived documents are
returned by the queryAll() call.

◊ When IsArchived is set to false, the document is not archived.

• The Lead object now includes these fields.

◊ CompanyDunsNumber: The Data Universal Numbering System (D-U-N-S) number is a unique, nine-digit
number assigned to every business location in the Dun&Bradstreet database that has a unique, separate, and
distinct operation. D-U-N-S numbers are used by industries and organizations around the world as a global
standard for business identification and tracking. Maximum size is 9 characters..

◊ DataDotcomCleanStatus: Indicates the record’s clean status as compared with Data.com. Values are: Not
Compared, In Sync, Reviewed, Different, Not Found, or Inactive.

• The Question object now includes the following fields:

◊ BestReplySelectedById, which displays the ID of the user who selected the best answer to the question.
◊ MostReportAbusesOnReply, which displays the most number of user-reported abuses on a reply associated

with the question.
◊ NumReportAbuses, which displays the number of user-reported abuses on the question.
◊ NumSubscriptions, which displays the number of users following the question.
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◊ Origin, which displays the source of the question, such as Chatter Answers.

• The Reply object now includes the NumReportAbuses field, which displays the number of user-reported abuses
on the reply.

• The User object now includes the following fields to support Chatter:

◊ UserPermissionsChatterAnswersUser, which indicates if a portal user has the Chatter Answers User
feature license and is enabled to use Chatter Answers.

◊ UserPreferencesDisableAllFeedsEmail

◊ UserPreferencesDisableBookmarkEmail

◊ UserPreferencesDisableChangeCommentEmail

◊ UserPreferencesDisableFollowersEmail

◊ UserPreferencesDisableLaterCommentEmail

◊ UserPreferencesDisableLikeEmail

◊ UserPreferencesDisableMentionsPostEmail

◊ UserPreferencesDisableProfilePostEmail

◊ UserPreferencesDisableSharePostEmail

◊ UserPreferencesDisCommentAfterLikeEmail

◊ UserPreferencesDisMentionsCommentEmail

◊ UserPreferencesDisableMessageEmail

◊ UserPreferencesDisProfPostCommentEmail

• The User object now includes the IsPrmSuperUser field for turning on super user access for a partner user. Contact
salesforce.com to enable this field.

• These objects now include the DeveloperName and Name fields.

◊ Group
◊ Territory
◊ UserRole
◊ Queue

• These sharing rule objects now include the DeveloperName and Name fields.

◊ AccountOwnerSharingRule
◊ AccountTerritorySharingRule
◊ CampaignOwnerSharingRule
◊ CaseOwnerSharingRule
◊ ContactOwnerSharingRule
◊ LeadOwnerSharingRule
◊ ServiceContractOwnerSharingRule
◊ OpportunityOwnerSharingRule
◊ [CustomObject]__OwnerSharingRule (where [CustomObject] represents the name of the custom object)

• The KnowledgeArticleVersion object now includes the following fields:

◊ ValidationStatus, which shows whether the content of the article has been validated.
◊ VersionNumber, which defines the number assigned to a version of an article.

• The CaseArticle object now includes the following fields:

◊ ArticleVersionNumber, which is the number assigned to a version of an article.
◊ IsSharedByEmail, which indicates that the article has been shared with the customer through an email.
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Chatter API Objects

New Chatter Objects

These new objects have been added in API version 24.0.

DescriptionObject

Represents a subscription for a user following a Question.QuestionSubscription

Changed Chatter Objects

These objects have been changed in API version 24.0.

• The ChatterActivity object, which represents Chatter activity statistics:

◊ Now includes the number of likes received on comments in addition to likes received on posts.
◊ No longer includes the Nillable property for the fields CommentCount, CommentReceivedCount,

LikeReceivedCount, and PostCount.

• The ChatterMessage object now supports the delete() call and can be used to delete any user’s Chatter messages; for
example, for compliance purposes. After your organization is upgraded to Winter ‘12, ChatterMessage will support
delete() in API version 23.0 as well as in version 24.0.

• Two new fields have been added to the FeedComment object so you can attach files to comments via the API:

◊ CommentType is the type of comment. File attachments are of type ContentComment.
◊ RelatedRecordId is the ID of the ContentVersion object associated with a ContentComment.

Note: Prior to API version 24.0, a text entry was required on a comment. As of version 24.0, a text entry is optional
if the CommentType is ContentComment—an uploaded file on a comment. If you have any Apex triggers
associated with the FeedComment object, keep in mind that this change may affect the behavior of existing triggers.

• The CollaborationGroupMember object:

◊ Supports the update() call.
◊ Includes the Nillable property for the NotificationFrequency field.
◊ Includes the CollaborationRole field, which represents the role of a member in a group. Group owners and

managers can assign group members of their groups to Member or Manager roles.

SOQL Enhancements
Use the Salesforce Object Query Language (SOQL) to construct query strings used in Salesforce APIs. For a full description
of the SOQL query syntax, see Salesforce Object Query Language (SOQL) in the Web Services API Developer's Guide.

Paging Using the OFFSET Clause — Developer Preview

Note: OFFSET is currently available as a Developer Preview. For more information on enabling OFFSET for your
organization, contact Salesforce.com.
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Use OFFSET to specify the starting row offset into the result set returned by your query. Using OFFSET is helpful for paging
into large result sets, in scenarios where you need to quickly jump to a particular subset of the entire results. For example, the
following SOQL query returns a result set that skips the first 100 rows of the full query results:

SELECT Name
FROM Merchandise__c
WHERE Price__c > 5.0
ORDER BY Name
LIMIT 50
OFFSET 100

SOAP Web Services API Enhancements

New and Changed Calls

Changed Calls
These calls have been changed in API version 24.0.

DescriptionChangeFieldArgument or Result
Object

Call

Indicates whether
FieldPermissions can

permissionable
property added

FieldDescribeSObjectResultdescribeSObjects()

be specified for the
field (true) or not
(false).

Previous Versions

For links to documentation for previous versions of the API, see the What’s New section of the relevant API or object reference
document.

REST API Enhancements
The Force.com REST API leverages the simplified approach of REST to allow developers to more easily interact with other
Web 2.0 applications such as Amazon.com AWS, Microsoft Azure, Google, Facebook, Twitter, and others:

• Interact with the application in a simplified way

• Integrate with third-party cloud systems and services

• Support mashup and Web 2.0 projects

If you need to move large amounts of data, use the Bulk API, which is built on RESTful principles, but is asynchronous and
optimized for large data-loading tasks.
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User Password Management

You can now securely access and manage user passwords using the new User Password methods in the Force.com REST API.
For more information see the Force.com REST API Developer’s Guide.

Streaming API Enhancements

Streaming API—Generally Available

Streaming API is now generally available. Use Streaming API to receive notifications for changes to data that match a SOQL
query you define, in a secure and scalable way.

Notification Enhancements

PushTopic records have been enhanced to provide more flexibility when specifying which events and data changes generate
notifications. Two new PushTopic fields provide the flexibility:

• NotifyForOperations specifies which record events generate a notification. Valid field values are:

◊ All (default)
◊ Create

◊ Update

• NotifyForFields specifies how a new or updated record is evaluated against the PushTopic query. Valid field values
are:

◊ All

◊ Referenced (default)
◊ Select

◊ Where

For existing PushTopics, the NotifyForOperations will default to All and the NotifyForFields will default to
Referenced. For more information see, Event Notification Rules in the Force.com Streaming API Developer’s Guide.

Existing Streaming API PushTopics may behave quite differently in this release. In previous versions, Streaming API generated
notifications when a record was created or updated as long as the record matched the PushTopic query. If the query had a
WHERE clause, then a notification was generated when a record was created or updated, the record matched the PushTopic
query, and one of the fields referenced in the WHERE clause was modified. Now record events that trigger a notification are
specified by the NotifyForOperations field.

In previous versions, Streaming API only evaluated the fields referenced in the WHERE clause. However, now the API
evaluates fields in the SELECT clause, the WHERE clause, or both depending on what you set the NotifyForFields
field to.

Server Polling Frequency

Streaming API polls the server for activity and issues the resulting notifications to the channel. The polling frequency has
decreased from five to three seconds. The actual time may fluctuate depending on the overall server load.

Maximum Request Size

The maximum size of the HTTP request post body that the server can accept from the client is 32,768 bytes, for example,
when you call the CometD subscribe or connect methods. If the request message exceeds this size, the following error
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is returned in the response: 413 Maximum Request Size Exceeded. To keep requests within the size limit, avoid sending
multiple messages in a single request.

Metadata API Enhancements

New Metadata Types

These metadata types are new in Metadata API version 24.0.

DescriptionMetadata Type

Represents a valid definition of a flow.Flow

Represents a public group, which can have users, roles, and other groups.Group

Represents a holding area for items before they are processed.Queue

Represents a user role.Role

Represents a set of sharing rules that’s used to share records with a set of users, based on rules
that specify the access level to the role or group. You can’t create a SharingRules component
directly.

Use the types that extend it: AccountSharingRules, CampaignSharingRules, CaseSharingRules,
ContactSharingRules, LeadSharingRules, OpportunitySharingRules,
AccountTerritorySharingRules, CustomObjectSharingRules

SharingRules

Represents a node in the Territory hierarchy.Territory

Updated Metadata

These metadata fields have been added or changed in Metadata API version 24.0.

DescriptionChangeField or Field TypeMetadata Type or
Related Object

Renamed to reflect that dashboards can now have
multiple filters.

In API version 23.0, this field’s name is
DashboardFilter.

UpdatedDashboardFiltersDashboard

Renamed to reflect that dashboards can now have
multiple filters.

In API version 23.0, this field’s name is
DashboardFilterColumn.

UpdatedDashboardFilterColumnsDashboard

Renamed to reflect that dashboard filters can have
multiple options.

In API version 23.0, this field’s name is
DashboardFilterOption.

UpdatedDashboardFilterOptionsDashboard

Defines the filter options available for dashboards.NewDashboardFilterOperationDashboard
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DescriptionChangeField or Field TypeMetadata Type or
Related Object

The operator field represents a filter option for a
dashboard filter item. Values for operator are now

UpdatedoperatorDashboard

defined by DashboardFilterOperation. Previously,
operator was defined by FilterOperation.
FilterOperation is now used for view and report filters
only.

A new field on DashboardFilterOperation. Required.
Used to define one or more values in the Filter

NewvaluesDashboard

Options area of the Add Filter dialog.
Introduced to support a new operator (“between”),
which takes two operands.

A group containing all customer portal users.NewallCustomerPortalUsersListView (SharedTo)

A group containing all internal users.NewallInternalUsersListView (SharedTo)

A group containing all partner portal users.NewallPartnerUsersListView (SharedTo)

A list of groups with sharing access containing all
users in a portal role.

NewportalRoleListView (SharedTo)

A list of groups with sharing access containing all
users in a portal role or those under that role.

NewportalRoleAndSubordinatesListView (SharedTo)

A list of queues with sharing access. Applies only to
lead, case, and CustomObject sharing rules.

NewqueueListView (SharedTo)

Represents each block in a joined report where every
block can be of a different report type.

NewblockReport

Defines attributes for each block in a joined report.NewblockInfoReport

Defines a bucket field to be used in the report.NewReportBucketFieldReport

Defines a cross filter's object, related object, and
condition (WITH or WITHOUT). Available in
Metadata API version 22.0 and higher.

NewReportCrossFilterReport

Required for joined reports. Specifies the
reportType of the blocks to which the aggregate
can be added.

NewreportType (in
ReportAggregate)

Report

A new field on WorkflowFieldUpdate. When set to
true, if the field update changes the field’s value, all

NewreevaluateOnChangeWorkflow

workflow rules on the associated object are
re-evaluated. Any workflow rules whose criteria are
met as a result of the field value change will be
triggered.
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Additional Database.com Enhancements
Field Updates for Encrypted Custom Fields
With Spring '12, we've expanded the reach of workflow field updates to include encrypted custom fields. Note, however, that
if you try to use a formula to set an encrypted custom field's new value, the encrypted custom field isn't available in the formula
editor as a resource.

Workflow Field Updates Can Retrigger Workflow Rules
We added a new checkbox option to workflow field updates that allows you to select whether you want a field update to trigger
a re-evaluation of all workflow rules on the object.

Here’s how it works:

• If the field update changes the field’s value, all workflow rules on the associated object are re-evaluated. Any workflow
rules whose criteria are met as a result of the field update will be triggered.

• If any of the triggered workflow rules result in another field update that’s also enabled for workflow rule re-evaluation, a
domino effect occurs, and more workflow rules can be re-evaluated as a result of the newly-triggered field update. This
cascade of workflow rule re-evaluation and triggering can happen up to five times after the initial field update that started
it.

• In a batch update, workflow is only retriggered on the entities where there is a change.
• Only workflow rules on the same object as the initial field update will be re-evaluated and triggered.
• Only workflow rules that didn’t fire before will be retriggered.
• Cross-object workflow rules and time-based workflow rules aren’t candidates for re-evaluation.
• Cross-object field updates that cause a field value to change don’t trigger workflow rule re-evaluation on the associated

object.

Sandbox Retention Policy
In Spring ‘12, we’ve updated our sandbox retention policy to optimize our server capacity and support growth of our sandbox
infrastructure. Capacity can affect the performance, backup, and replication of your sandbox instances.  These policies help
ensure that sandboxes use capacity more efficiently.

Unactivated Sandboxes
New sandboxes that aren’t activated within 30 days will be deleted. You’ll get at least three notifications prior to scheduling
the sandbox for deletion.

Locked Sandboxes
Sandboxes that have been locked for 30 days will be deleted. You’ll get at least three notifications prior to scheduling
the sandbox for deletion. Sandboxes become locked when all the licenses for that type of sandbox expire.

Note:  Deletion of a sandbox doesn’t terminate or change any of your sandbox subscriptions. If you have a sandbox
subscription and your sandbox is deleted, your subscription remains in effect and you can create a new sandbox.
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Help and Training Enhancements
Videos
Like to learn by watching? In Spring '12 we offer some great product demos for new and updated features:

• Introducing Joined Reports for Salesforce (3:19 minutes)
• Getting Started with Buckets (3 minutes)
• Overview of Dashboards (3:20 minutes)
• Using Smart Search (2:12 minutes)
• Sending Mass Email (4:31 minutes)

Tip Sheets and Implementation Guides
The following new or updated documents are now available:

• Two appendices have been added to the ISVforce Guide: one of which compares two ISVforce user licenses and the second
of which compares three OEM user licenses.

• Using Dashboard Filters
• Using Cross Filters in Reports
• What are Joined Reports?
• Using Bucket Fields
• Chatter Answers Implementation Guide

Workbooks
The following new or updated workbooks are now available:

• Cloud Flow Designer Workbook—Introduces you to the creation of flows through a series of tutorials using the
native-to-Salesforce, Cloud Flow Designer. By the end of this book, you'll have built three separate flows using increasingly
complex elements, such as Record Lookup and Record Create, and used Apex to create a plug-in for a flow.

Developer Guides
The following new or updated developer documents are now available:
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